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1Product Overview

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

Customer documentation updates
You can get the latest customer documentation updates for your product by going to 
www.xerox.com. Be sure to periodically check this website for the latest information for your 
product.

User Interface (UI)
The User Interface (UI) consists of the Control Panel and Touch Screen. The following describes 
the names and functions of components on the control panel.

Customizing the Control Panel

You can customize the Custom buttons and items on the All Services screen.

Assigning a feature to Custom buttons

By assigning a feature to Custom buttons (Copy, Custom 2, and Custom 3), you can switch to 
that feature without returning to the All Services screen.

The factory default settings for these buttons are, “Copy” for the 1st button, and none for the 
2nd and 3rd buttons. Each button feature can be changed to appear in the menu screen by 
selecting the Screen Defaults feature from System Administration> System 
Settings>Common Settings.

Note
For more information, refer to Screen/Button Settings on page 9-16.

Attach the labels included in this product when you have changed the assignment. If you have 
used a feature for which no label is provided, use a blank label and write down the feature using 
a permanent marker and attach it to the appropriate Custom button.

http://www.xerox.com
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Customizing the All Services screen

You can customize the types of features and the location of buttons on the All Services 
screen. The following shows the factory default settings:

Notes
• For more information, refer to Screen/Button Settings on page 9-16.
• When the feature is not available the button will not be displayed. Also, if the feature is 

unavailable due to hardware problems, the button will be dimmed.

Changing feature screen

You can customize the setting screen for the following features on the All Services screen:

• Copy
• E-mail
• Scan to Folder
• Scan to FTP/SMB

Note
For information about how to change settings, refer to Print Service Settings on page 9-131 and 
Scan Service Settings on page 9-138.
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Services and features
The following facilities are provided in a network environment:

• Print
• CentreWare Internet Services
• Scan
• E-mail

Print

This machine can be used as a local printer by directly connecting to a computer, or as a 
network printer by connecting to a network.

Enable the necessary port using the Control Panel.

Using the printer as a network printer

When used as a network printer, the machine can be connected by the following methods:

LPD:

Allows communication with the machine directly by using the TCP/IP protocol

NetWare:

Allows the machine to be managed by using a NetWare server

SMB:

Allows printing to the machine by using Microsoft Networks

IPP:

Allows printing to the machine via an Internet
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Port 9100:

Allows printing by using Port 9100

EtherTalk:

Allows printing from Macintosh machines

Supported operating systems

*1: Use our TCP/IP direct print utility for Windows 95/98 and Windows ME.

*2: UNIX filter is required when printing PostScript data. 

*3: Supports MacOS 10.3 or later. 

Note
For details about network environments, refer to the manual in the “CentreWare Utilities” CD-
ROM.

Connection 
method Network connection

Port LPD NetWare SMB IPP Port
9100

Ether
Talk

Protocol TCP/
IP TCP/IP IPX/

SPX
Net

BEUI
TCP/

IP
TCP/

IP TCP/IP Apple
Talk

OS Windows
2000

Windows
XP

Vista

Windows
Server 
2003

UNIX *2

Macintosh *3 u
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CentreWare Internet Services

The CentreWare Internet Services provides services such as displaying the status of this 
machine and jobs and altering configurations using a Web browser in a TCP/IP environment.

For setting a printer, the CentreWare Internet Services properties screen allows the user to 
configure system and port settings for each network.

Note
Normally these settings are done on the machine’s touch screen UI; however with CentreWare 
Internet Services, these settings can be completed from an internet browser.

The following are functions offered under each tab within the CentreWare Internet Services 
when the machine is enabled with Internet Services.

Scan

There are the following scan services.

Scanner (mail transmission)

Documents can be scanned and transmitted via e-mail.

Scanner (save to a folder)

Documents can be scanned and saved into a folder.

When the machine is connected to a TCP/IP network, scanned documents in a folder can be 
retrieved from a networked computer.

Tab name Main function

Service Printing files from client computers.

Job Displays a list of jobs, job history, and used to delete jobs.

Status Displays the machine status.
Displays status of the paper trays, output trays and consumables, such as toners.

Property Displays and allows setting of the following items:
Machine information, structure information such as memory and printing 
language, configuring the counter, paper trays and papers, energy saving mode, 
editing address table and folders mail notice, Internet Services and port 
activation.
Port settings.
Protocol Settings
Emulation settings.
Memory settings.

Maintenance Displays error history information.

Support Displays support information.



Product Overview

1-6  System Administration Guide
Xerox 4112/4127 Copier/Printer

Job template

The job template is a configuration file for defining scanning conditions. Specify a job template 
for the document to be scanned in as data. Scanned document will be stored onto a hard disk 
on this machine, then transmitted automatically to a networked computer (server).

Note
You can create a maximum of 500 Job Templates.

Scanner (save to a computer)

When the machine is connected to a network which can use either the FTP or SMB protocol, the 
scanned document can be saved on a networked computer.

Job flow scan

Scanning is performed according to a job flow.

E-mail

There are the following e-mail types.

Scanner (mail transmission)

Scanned documents can be converted into an electronic format and transmitted via e-mail.

Mail print

E-mail with attachments in either TIFF or PDF format can be sent to the machine from 
computers. Received e-mail will automatically be printed.

Mail notice

When the machine is configured with the rejected IP addresses notice or rejected mail domains 
notice, a mail notice can be sent to a specified recipient.

Job completion notice

When a computer has submitted a job to the machine, notification of the completion of the job 
can be done by e-mail.



Product Overview

Xerox 4112/4127 Copier/Printer 1-7
System Administration Guide

Tools
The following tools are provided with this machine. Configurable items vary by the tools being 
used.

User Interface

The User Interface (UI) consists of the Touch Screen and the Control Panel.

The Touch Screen is located at the center of the UI. Messages required for operation and 
feature buttons are displayed on this display. You can directly touch the buttons and tabs 
displayed on the touch screen to set features or to instruct operations in screens.

CentreWare Internet Services

The CentreWare Internet Services provides services such as displaying the status of this 
machine as a printer and its print data, altering configurations, and operating on folders using a 
Web browser in a TCP/IP environment.

For setting as a printer, the properties screen of the services allow the users to configure the 
system settings and port settings for each network that are otherwise set using the touch 
screen on the machine.

CentreWare Utilities

CentreWare Utilities is included on the “CentreWare Utilities” 
CD-ROM. It is a tool to enable operations on devices and various applications within one 
window. It reduces the inconvenience of using various tools and the effort needed to maintain 
several print driver configurations.

Print output can be performed by drag-and-drop of the document files. Also, this tool enables 
the remote operation of folder registration and scan configuration.

When a print job is submitted from a computer, the machine status, such as out of paper, toner 
low, paper jam, starting and completing the job, will be displayed. It also allows the users to 
confirm the print data processing status, and to pause, restart, and stop the print jobs.
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The relation of the tools and their configurable items follows. Note that the description in this 
manual is focused on the configuration from the Control Panel.

: Configurable : Partly configurable : Not configurable

Power on/off
Switch the power on before operating the machine. The machine will take about 5 minutes to 
warm up before you can start making copies after the power is switched on.
Turn the machine off at the end of the day or when it is not in use for a long period of time. Use 
the Power Saving feature when the machine is not in use for a while to reduce power 
consumption.

Notes
• Refer to the Power Saver Mode section on the next page for more information.
• If the power is off, all functions of the machine will stop.

Item Control Panel CentreWare 
Internet Services

CentreWare
Utilities

Enabling the port  (LPD only)

Setting an IP address

Configuring the 
E-mail environment

Registering a Folder

Address Book

Confirming the printer status

Confirming the print data 
(jobs) status

Authentication information

Setting personal 
authentication information
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Powering on
1. Open the cover and press the power switch to the [|] position to turn the power on.

Note
The “Please wait...” message indicates that the machine is warming up. The machine cannot be 
used while it is warming up.

Powering off
Tip
Switching the machine power off may cause loss of data being processed.

1. Before turning the power off, make sure that all copy or print jobs have completely finished. 
Also, make sure that the Online indicator is not lit.

Tip
Never turn the power off in the following instances:

• While data is being received
• While data is being sent (FTP/SMB/e-mail)
• While jobs are being printed.
• While jobs are being copied
• While a scan is being executed
• While data is being imported from computer

2. Press the power switch to the [ ] side.

Tip
Power off processing is performed internally on the machine for a while after the power switch is 
turned off. Therefore, do not unplug the power cord from the power outlet immediately after 
turning the power switch off.

Note
Before you turn the power back on after turning it off, first make sure that the display has gone 
out.
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System Administrator mode

Entering the System Administrator mode
1. Press the Log In/Out button. 

2. Enter the System Administrator ID with the numeric keypad, and select Enter. 

Note
The default User ID value is 11111. When using the Authentication feature, a password is 
required. The default password is x-admin.

3. Press the Machine Status button on the Control Panel.
4. Press the Tools tab.
5. Select the appropriate Mode, Group, and Feature. 

Log In/Out 
button
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Exiting the System Administrator mode
1. Press the Log In/Out button. 

2. When the Logout screen appears, Press Yes.

Setting the IP address
In an environment with DHCP or BOOTP, configure the way to obtain the address. If the 
address cannot be obtained automatically or manual configuration is preferred, configure the 
IP address, subnet mask, and gateway address.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10) if necessary.

2. Select System Settings and then select Connectivity & Network Setup.
3. Select Protocol Settings.
4. Select IPv4 - Address Resolution and select Change Settings.
5. Select one from DHCP, BOOTP, RARP, DHCP/Autonet or Static. If you select anything 

other than Static, proceed to step 10.

Note
When using a DHCP server, also configure the WINS (Windows Internet Name Service) 
server.

6. Select IPv4 - Get IP Address and select Change Settings.
7. Enter the IP address using the numeric keypad.

Notes
• Enter addresses in the format “xxx.xxx.xxx.xxx” where xxx should be a numeric value in 

the range from 0 to 255. However, 224 or 225.xxx.xxx.xxx and 127.xxx.xxx.xxx cannot 
be used. 

• When you make an entry mistake, press the C (Clear) button and enter again.
• When you would like to move to the next value without entering all 3 digits, select 

Next. 
8. Select Save.
9. Configure IPv4 - Subnet Mask and IPv4 - Gateway Address as shown above.

Log In/Out 
button
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Notes
• Enter addresses in the format “xxx.xxx.xxx.xxx” where xxx should be a numeric value in 

the range from 0 to 255. However, 224 or 225.xxx.xxx.xxx and 127.xxx.xxx.xxx cannot 
be used. 

• Specify the subnet mask by a combination of the numbers 0, 128, 192, 224, 248, 252, 
and 255. However, you cannot use 0 between non-zero values. 

• If you do not wish to set the gateway address, enter “0.0.0.0.”
10. Select Close repeatedly until the System Settings screen is displayed

Power Saver Mode
The machine is installed with a Power Saver feature that will automatically cut off the electricity 
to the machine if no copy or print data is received for a certain duration.

The Power Saver feature has two modes, a Low Power mode and Sleep mode. The machine 
enters the Low Power mode after the preset time has elapsed if the machine is left unused for a 
fixed period of time.
The machine then enters the Sleep mode if a further preset time elapses.

Low Power Mode

In this mode, the power to the UI and fuser unit is lowered to save power. The display goes out, 
and the Power Saver button on the Control Panel lights. To use the machine, press the Power 
Saver button. The Power Saver button goes out to indicate that the Power Saver feature is 
canceled.

Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes out, 
and the Power Saver button on the Control Panel lights. To use the machine, press the Power 
Saver button. The Power Saver button goes out to indicate that the Power Saver feature is 
canceled.
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Changing the Power Saver Mode time interval

To activate the Power Saver feature, set the Sleep Mode button to Enabled, and set the Low 
Power Mode and the Sleep Mode time intervals as follows:

Note
The amount of time that passes before the machine enters Low Power Mode and Sleep Mode 
can be specified in 1 minute increments, from 1 to 240 minutes for each mode.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Select System Settings and then select Common Settings. 

3. Select Machine Clock /Timers. 
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4. Select Power Saver/Energy Saver, and select Change Settings. 

5. Using the up/down arrow buttons, configure a power saver mode migration time from 1 to 
240 minutes, in 1 minute increments.

a. From Last Selection to Low Power Mode: Set the time to move to the Low Power 
Mode after the last operation.

Note
The default for From Last Selection to Low Power Mode is 15 minutes. 

b. From Last Selection to Sleep Mode: Set the time to move to the Sleep Mode after 
the last operation.

Notes
The default for From Last Selection to Sleep Mode is 60 minutes. Configure the From Last 
Selection to Sleep Mode time to be longer than the From Last Selection to Low Power 
Mode time.

6. Press Save.
7. Select Close.
8. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
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Exiting the Power Saver Mode

The following describes how to exit the Power Saver mode. The Power Saver mode is exited in 
the following instances:

• By pressing the Power Saver button

• Receiving Print Data

1. Press the Power Saver button.

Interface cables
When connecting to a network, use the Ethernet interface.

Using the Ethernet Interface

The Ethernet interface supports the following 2 types:

• 100Base-TX
• 10Base-T

This section describes the installation procedure for the Ethernet interface.

1. Confirm that the power switch is turned off.

2. Connect a network cable to the Ethernet interface connector.

Note
Prepare a network cable suitable for your network connection. When changing the network 
cable, consult the appropriate personnel.

3. Switch on the machine.

Power Saver 
button
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Internal Fonts
The listed fonts are available as standard fonts on the machine: 

Stroke fonts (for PCL5 and 
HP-GL/2) European Stroke fonts

Outline 
fonts

European HP-GL/2 Roman
Sans Serif

PDF Arial
Arial Italic
Arial Bold
Arual
Bold Italic
Courier
Courier Italic
Courier Bold

Courier Bold Italic
Symbol
Times New Roman
Times New Roman Bold 
Italic
ITC Zepf Dingbats
GoldSEMM
Gold SAMM

PCL CG Times
CG Times Italic
CG Times Bold
CG Times Bold Italic
Univers Medium
Univers Medium Italic
Univers Bold
Univers Bold Italic
Univers Medium Condensed
Univers Medium Condensed Italic
Univers Bold Condensed
Univers Bold Condensed Italic
Antique Olive
Antique Olive Italic
Antique Olive Bold
CG Omega
CG Omega Italic
CG Omega Bold
CG Omega Bold Italic
CG Omega Bold Italic
Garamond Antiqua
Garamond Kursiv
Garamond Halbfett
Garamond Kursiv Halbfett
(Default): Courier
Courier Italic
Courier Bold
Courier Bold Italic
Letter Gothic
Letter Gothic Italic
Letter Gothic Bold

Times New Bold
Times New Bold Italic
Symbol
Wingdings
Line Printer
Times Roman
Times Italic
Times Bold
Times Bold Italic
Helvetica
Helvetica Oblique
Helvetica Bold
Helvetica Bold Oblique
CourierPS
CourierPS Oblique
CourierPS Bold
CourierPS Bold Oblique
SymbolPS
Palatino Roman
Palatino Italic
Palatino Bold
Palatino Bold Italic
ITC Bookman Light
ITC Bookman Light Italic
ITC Bookman Demi
ITC Bookman Demi Italic
Helvetica Narrow
Helvetica Narrow Oblique
Helvetica Narrow Bold
Helvetica Narrow Bold 
Oblique
New Century Schoolbook 
Roman
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Outline 
fonts

European PCL 
continued

Albertus Medium
Albertus Extra Bold
Clarendon Condensed
Coronet
Marigold
Arial
Arial Italic
Arial Bold
Arial Bold Italic
Times New
Times New Italic

New Century 
Schoolbook Italic
New Century 
Schoolbook Bold
New Century 
Schoolbook Bold 
Italic
ITC Avant Garde 
Book
ITC Avant Garde 
Book Oblique
ITC Avant Garde 
Demi
ITC Avant Garde 
Demi Oblique
ITC Zapf Chancery 
Medium Italic
ITC Zapf Dingbats

KO PCL5 Muyngio
Gothic
R- Gothic
Graphic
Kungso
Saemmul

T-Myungio
T-Gothic
TR-Gothic
T-Graphic
T-Kungso
T-Saemmul

TC PCL5 Sou tail
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2Configuration

TCP/IP (LPD/Port 9100)

Preparations

The following items are required when using TCP/IP (LPD/Port 9100) protocol on the machine.

• A network environment where TCP/IP can be used.
• The "CentreWare Utilities" CD-ROM, which is included with this product.

Configuration procedure

Overview

The machine can be connected to computers using TCP/IP (LPD/Port 9100) protocol.

The following is the procedure to use TCP/IP(LPD/Port 9100) protocol.

• Configuration on the Machine: Configure TCP/IP (LPD/Port 9100) on the machine.
• Configuration on the Computer: Install the print driver.

Configuration on the machine (LPD)

This section describes the configuration procedure to use TCP/IP (LPD/Port 9100) protocol on 
the machine. First enable the LPD Port or Port 9100 port, then assign the IP address.

LPR/LPD is a platform-independent printing protocol that runs over TCP/IP. LPD (or Line Printer 
Daemon) refers to the process that accepts print jobs from the line printer daemon client (LPR 
client). This is analogous to the printer software and is often called “LPD server.”

The print server waits for the client to send a job. A print server may be capable of handling 
multiple printers and print queues at once. Since it (usually) has a single IP address, the queue 
name must be used to specify the intended print queue.

Note
The configuration can also be performed using CentreWare Internet Services or CentreWare 
Utilities. Refer to “Using CentreWare Internet Services”.
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Note
Enable the SOAP port and the SNMP port in most cases.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable either the LPD port or the Port 9100 port as appropriate. In this example, the LPD 
port is enabled.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select LPD and then select Change Settings.
e. Select LPD - Port Status and select Change Settings.
f. Select Enabled and then select Save.
g. Select Close repeatedly until the Connectivity & Network Setup screen is displayed

3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the LPD 

port is enabled.

Note
Configure the LPD as necessary. Refer to LPD on page 3-10 for the LPD configuration. Also 
if using Port 9100, configure as necessary. Refer to Port 9100 on page 3-15 for the Port 
9100 configuration.

Configuration on the computer

This section describes the configuration procedure for the computer.

• Install the print Driver.

Notes
• For information about the usable operating systems, refer to Supported operating systems 

on page 1-4.
• Refer to the manual contained in the “CentreWare Utilities” 

CD-ROM for the print driver installation procedure.
To print from a Macintosh using TCP/IP (LPD), refer to the manual contained in the CD-ROM 
included with this product for the print driver installation procedure.
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NetWare

Preparations

The following items are required when using NetWare network:

• A NetWare server.
• The "CentreWare Utilities" CD-ROM which is included with this product.

Configuration procedure

Overview

The machine supports PServer mode for both the NetWare Directory Service and Bindery 
Service. PServer mode enables the machine to function as a print server and to capture print 
jobs in the print queue to output. The printer created for the machine consumes one file server 
license.

Note
The machine does not support Remote Printer (RPrinter) Mode.

Supported interfaces
• 100Base-TX
• 10Base-T

Supported frame types

• Ethernet II specification
• IEEE802.3 specification
• IEEE802.3/IEEE802.2 specification
• IEEE802.3/IEEE802.2/SNAP specification

Note
The machine will send packets of each frame type on the network, and will initialize for the 
same frame type as the first reply packet received. However, if there are multiple protocols 
running on the same network, use Ethernet II specification.

Configuration on the machine (NetWare)

This section describes the configuration procedure to connect the machine to a NetWare 
network.

Note
Configuration can also be performed using the Network configuration tools included in 
CentreWare Internet Services or CentreWare Utilities. Refer to “Using CentreWare Internet 
Services”.

1. Confirm the device name and network address.
Print the Printer Settings List to confirm the device name and network address printed 
under the NetWare item.

2. Configure the machine using the “CentreWare Utilities” CD-ROM.

There is no need to activate the NetWare port on the machine prior to configuration when 
using the “CentreWare Utilities” CD-ROM.
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Note
Refer to the manual contained in the “CentreWare Utilities” CD-ROM for the configuration 
procedure.

Microsoft Network (SMB)

Preparations

The following items are required when using a Microsoft Network (SMB):

• Network environment where either TCP/IP or NetBEUI can be used.
• The "CentreWare Utilities" CD-ROM, which is included with this product.

Configuration procedure

Overview

The machine can be connected to computers using Microsoft Networks (SMB).

Depending on the network environment, the machine may need to be configured with an IP 
address, subnet mask and gateway address. Confirm with the network administrator and set up 
the necessary items.

The following is the procedure to connect the machine to a Microsoft Network (SMB):

• Configuration on the Machine: Enable the SMB port on the machine.
• Configuration on the Computer: Install the print driver.

Configuration on the machine (SMB)

This section describes the configuration procedure to connect the machine to Microsoft 
Networks (SMB). First enable the SMB port, then set the IP address.

Notes
• The configuration can also be performed using the IP configuration tools included in 

CentreWare Internet Services or CentreWare Utilities. Refer to “Using CentreWare Internet 
Services”.

• Enable the SOAP port and the SNMP port in most cases.
1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 

on page 1-10.)
2. Enable the SMB port.

a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select SMB and then select Change Settings.
e. Select Port Status and select Change Settings.
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f. Select Enable and then select Save.
3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the SMB 

port is enabled.

Note
If using the NetBEUI protocol, select NetBEUI as the protocol used by SMB for the port 
configuration using CentreWare Internet Services.

Configure the SMB as necessary. Refer to Microsoft Networking (SMB) on page 3-6 for the SMB 
configuration.

Configuration on the computer

See Chapter 2 Configuration on the computer on page 2-2.

Internet Printing Protocol (IPP)

Preparations

The following items are required when using Internet Printing Protocol (IPP):

• A network environment where TCP/IP can be used.
• The "CentreWare Utilities" CD-ROM, which is included with this product.

Configuration procedure

Overview

The machine can be connected to computers using IPP.

The following is the procedure to connect the machine to enable Internet Printing (IPP):

• Configuration on the Machine: Enable the IPP port on the machine
• Configuration on the Computer: Install the print driver

Configuration on the machine (IPP)

This section describes the configuration procedure to enable Internet Printing (IPP) on the 
machine. First enable the IPP port, then set the IP address.
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Notes
• The configuration can also be performed using IP configuration tools included in 

CentreWare Internet Services or CentreWare Utilities. Refer to “Using CentreWare Internet 
Services”

• Enable the SOAP port and the SNMP port in most cases.
1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 

on page 1-10.)
2. Enable the IPP port.

a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select IPP and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enable and then select Save.

3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the IPP 

port is enabled.

Note
Configure the IPP as necessary. Refer to IPP on page 3-14 for the IPP configuration.

Configuration on the computer

See Chapter 2 Configuration on the computer on page 2-2.

EtherTalk

Preparations

The following item is required when using an EtherTalk network:

• A network environment where EtherTalk can be used.

Configuration procedure

Overview

The machine can be connected to computers using an EtherTalk network.

The following is the procedure to connect the machine to EtherTalk network:

• Configuration on the Machine: Set up EtherTalk on the machine.
• Configuration on the Computer: Install the print driver.
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Configuration on the machine (EtherTalk)

This section describes the configuration procedure to connect the machine to EtherTalk 
network.

Enable the EtherTalk port

Note
The configuration can also be performed using CentreWare Internet Services or CentreWare 
Utilities. Refer to “Using CentreWare Internet Services”.

Note
Enable the SOAP port and the SNMP port in most cases.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable the EtherTalk port.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select EtherTalk and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enable and then select Save.

3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the 

EtherTalk port is enabled.

Note
Configure EtherTalk as necessary. Refer to EtherTalk on page 3-5 for the EtherTalk configuration.

Configuration on the computer

See Chapter 2 Configuration on the computer on page 2-2.
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3Using CentreWare 
Internet Services 

Preparations
Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

The following items are needed to use CentreWare Internet Services:

• A computer which can use TCP/IP as the network protocol.
• The configuration of the machine which includes:

• IP address
• Subnet mask
• Gateway address

Note
Refer to Troubleshooting on page 10-1 when any troubles occur during the configuration.

Configuration procedure
CentreWare Internet Services provides a variety of services, including job and printer status, and 
the ability to alter configurations using a web browser in a TCP/IP environment.

For setting as a printer, the properties screen of the services in CentreWare allow the users to 
configure the system settings and port settings for each network that are otherwise set using 
the touch screen on the machine.

Follow the procedure below to use CentreWare Internet Services.

• Configuration on the Machine: Configure the machine to be able to use CentreWare 
Internet Services. First enable the Internet service port, then set the IP address.

• Confirmation of the Configuration: Confirm whether the machine is set to use CentreWare 
Internet Services.
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Configuration on the machine

This section describes the configuration procedure for using CentreWare Internet Services on 
the machine.

First enable the Internet service port, then set the IP address.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable either the LPD port or the Port 9100 port as appropriate. In this example, the LPD 
port is enabled.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select Internet Services (HTTP) and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enabled and then select Save.
g. Select Close repeatedly until the Connectivity & Network Setup screen is displayed

3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the 

Internet service port is enabled.

Connect to CentreWare Internet Services from a computer
1. Start a web browser.
2. Type the IP address or the Internet address for the machine in the address bar on the 

browser, and press the Enter key.
• Example of the IP address (when the machine IP address is 192.168.1.1):
• http://192.168.1.1/

• Example of the Internet URL (when the machine Internet address is in the form 
xxx.yyy.zz.vvv):
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Notes
• If your network uses DNS (Domain Name System) and host name for the machine is 

registered with the domain name server, you can access the device using a combination of 
the host name and the domain name as the "Internet address." For example, if the host 
name is "dcf1100", and the domain name is "mycompany.com", then the "Internet address" 
becomes "dcf1100.mycompany.com."

• When specifying a port number, add ":" and a port number to the end of the Internet 
address.

• If the "Login Setup" facility is enabled on the machine, enter the UserID and password in 
User ID and Password. Please query the System Administrator about the UserID and 
password.

• Enter an address beginning with "https" rather than "http" into the address bar in the 
browser if encrypted communication is employed.
Example of the IP address entry
https://192.168.1.1/
Example of the Internet address entry
https://xxx.yyyy.zz.vvv/

Refer to Troubleshooting on page 10-1 if CentreWare Internet Services is not displayed.

Network setting items for CentreWare 
Internet Services
CentreWare Internet Services enable you to alter various settings on the machine from a 
computer.

Notes
• Confirm that the ports are enabled, if an item which you want to set is not displayed.
• When a setting is changed from CentreWare Internet Services while operating the control 

panel, the setting items changed on the screen of the control panel are not displayed
Power-cycle the printer in this case.

The following network settings are discussed in this section:

• Ethernet
• EtherTalk
• SMB
• NetWare
• TCP/IP
• LPD
• SNMP
• IPP
• Port 9100
• LDAP
• E-mail
• HTTP

Note
Click Help at the top right of the CentreWare Internet Services screen for details on the setting 
items.
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The following browsers have been confirmed to operate with CentreWare Internet Services:

For Windows
• Microsoft Internet Explorer ver.6.0 Service Pack 1 (SP1) or later.

• Netscape 7.0 or later.

For MacOS 10.2 or later
• Microsoft Internet Explorer 5.2 or later.

• Netscape 7.0 or later.

Ethernet

This section describes the settings for the Ethernet interface.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.
3. Click + on the left of Connectivity and + on Physical Connections to display the items in 

the folder.
4. Click Ethernet.
5. Set the communication speed for the Ethernet interface using the Ethernet Settings pull-

down menu.
6. Save the selection as the machine’s default setting.

a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The web browser pages displays a message asking if you want to reboot the machine.
d. Click Reboot. The machine will reboot and the setting value will be reflected.
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EtherTalk

This section describes the settings for EtherTalk.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click the EtherTalk.
5. Set the Printer Name.
6. Set Zone Name.
7. Reflect the values as the machine’s setting values.

a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
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d. Click Reboot. The machine will reboot and the setting value will be reflected.

Microsoft Networking (SMB)

This section describes the settings for Microsoft Networking.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click the Properties tab.
4. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 

folder.

5. Click Microsoft Networking.
6. Set the Workgroup Name.
7. Set the SMB Host Name.
8. Set the Maximum Connections.
9. Select the Enable check box to enable the TBCP Filter.
10. Select the Enable check box to enable Unicode Support.
11. Select the On check box when using Automatic Master Mode.
12. Select the On check box when using Encryption Password.
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13. Reflect the values as the machine's setting values.
a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

NetWare

This section describes the settings for NetWare.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click NetWare.

5. Select an operation mode from the Active Mode pull-down menu.
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6. Set the Printer Server Name.
7. Set the Fileserver Name.

Note
Set this item only when the operation mode is in Bindery Service.

8. Set the Poling Interval.
9. Set the Number of Searches.
10. Set the Password.

a. Enter the Password.
b. Re-enter the same password in the Re-enter Password field.

11. Select the Enable check box to enable the TBCP Filter.

Note
The TBCP Filter checkbox will have a checkmark in it indicating that the TBCP Filter is 
enabled.

12. Set the NDS Tree Name.
13. Set the NDS Context Name.

Note
Set this item only when the operation mode is in Directory Service.

14. Select a frame type from the Transport Protocol - Frame Type pull-down menu.

Note
Set this item only when the operation mode is in Directory Service.

15. Select the Enable check box to enable SLP - Active Discovery.
16. Reflect the values as the machine's setting values.

a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.
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TCP/IP

This section describes the settings for TCP/IP.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click TCP/IP.

5. Set the Host Name.
6. Select how to obtain an IP address from the Get IP Address pull-down menu.
7. Set the IP Address.

Note
This item is not necessary if either DHCP, BOOTP, RARP, or DHCP/Autonet has been 
selected from the Get IP Address pull-down menu.

8. Set the Subnet Mask and Gateway Address.
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Note
This item is not necessary if either DHCP, BOOTP, RARP, or DHCP/Autonet has been 
selected from the Get IP Address pull-down menu.

9. Set the DNS information.
a. Select the check box if using DHCP for Obtain DNS Server Address Automatically.
b. Set the DNS Address 1 to 3.

Note
This item is not necessary if DHCP has been specified for the Get the DNS Server Address.

c. Set the DNS Name.
d. Select the Enable check box when using the Generate Domain Search List 

Automatically.
e. Set the Domain Name 1 to 3.
f. Set the Connection Timeout.
g. Select the Enable check box to enable the DNS Dynamic Update.

10. Reflect the values as the machine's setting values.
a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

LPD

This section describes the settings available for the LPD feature.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.
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3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click LPD.

5. Set the Port Number.
6. Select the Enable check box to enable the TBCP Filter.
7. Set the Connection Time-Out.
8. Set the Maximum Number of Sessions.
9. Reflect the values as the machine’s setting values.

a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

SNMP

This section describes the settings for SNMP.

Note
When using the CentreWare software to manage the machine by remote control, enable the 
SNMP port.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).
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2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click SNMP Configuration.

Note
Another option exists called Enable SNMP v3 Properties. If using this option, configure 
HTTPS before configuring SNMP v3. Configuring this feature requires secure web page 
comminications.

5. Select Edit SNMP (v1/v2c or v2) Properties.
a. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.



Using CentreWare Internet Services

Xerox 4112/4127 Copier/Printer 3-13
System Administration Guide

Note
The default User ID value is 11111 and password is x-admin.

6. When changing the community name, set all the Community Name (Read only), 
Community Name (Read/Write), and Trap Community Name (Trap Notification).

Note
Normally, do not change the settings.

7. Set the System Administrator's Login ID.
8. Reflect the values as the machine’s setting values.

a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

if necessary, and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.
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IPP

This section describes the settings for the IPP port.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click IPP.

5. Set the Add Port Number.
6. Select the Enable check box to enable the TBCP Filter.
7. Select the Enable check box to enable Administration Mode.
8. Select the Enable check box to enable DNS.
9. Set the Connection Time-Out.
10. Reflect the values as the machine's setting values.

a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
If necessary, and then click OK.
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Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot.The machine will reboot and the setting value will be reflected.

Port 9100

This section describes the settings for Port 9100 port.

Note
Enable the Port 9100 port when using HP-UX.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click Port 9100.

5. Set the Port Number.
6. Select the Enable check box to enable the TBCP Filter.
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7. Set the End of Job Timeout.
8. Reflect the values as the machine’s setting values.

a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and then click OK. 

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

LDAP

This section describes the settings for the LDAP port.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click + on the left of LADP Folder to display the items in the folder.
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5. Click LDAP Server.

6. Set the IP Address/Host Name & Port.
7. Set the Backup IP Address/Host Name & Port.
8. Set the Optional Information and the Search Name Order.
9. Click LDAP User Mappings.

10. Set the Search information.
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11. Click LDAP Authentication.

12. Set the LDAP Authentication information.
13. Click LDAP Authorization Access.
14. Set the LDAP Authorization Access information.
15. Click Custom Filters.

16. Set the Custom Filters information.
17. Reflect the values as the machine’s setting values.

a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
18. Click Reboot. The machine will reboot and the setting value will be reflected.
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HTTP

This section describes the settings for the HTTP port.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click HTTP.

5. Set the Port Number.
6. Set the Maximum Session Number.
7. Set the Connection Time-Out.
8. Reflect the values as the machine’s setting values.

a. Click the Apply button. A screen to enter the user name and password will be displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.
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c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

Encrypting HTTP communication
Note
Refer to the CentreWare Internet Services online help for how to import the certificate.

This section describes the procedure to generate the certificate using CentreWare Internet 
Services and how to establish encrypted communication.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Security to display the items in the folder.
4. Click Machine Digital Certificate Management. 

a. If necessary, enter the System Administrator UserID and password into User Name 
and Password, and then click OK.

Note
The default User ID value is 11111 and password is x-admin.
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5. Generate the Certificate.
a. Click the Create New Self Signed Certificate button.
b. Set the Size of the Public Key.
c. Set the Issuer.
d. Click the Apply button. A screen to enter the user name and password will be displayed.

6. Refresh the web browser.
7. Click SSL/TLS Settings.
8. Select the Enable check box for HTTP - SSL/TLS Communication. Display the items in the 

folder.
9. Set the HTTP - SSL/TLS Communication Port Number.
10. Reflect the values as the machine's setting values.

a. Click the Apply New Settings.
b. The right frame on the web browser will change to the machine reboot display.
c. Click Reboot. The machine will reboot and the setting value will be reflected.
Type an address beginning with "https" rather than "http" into the address bar in the 
browser when accessing CentreWare Internet Services if encrypted communication is 
enabled.

• Example of the IP address entry:
• http://192.168.1.1/
• Example of the Internet address entry:
• http://xxx.yyyy.zz.vvv/

Encrypting HTTP communication additional information
• The communication data between the machine and networked computers can be 

encrypted using HTTP.

• The SOAP port, Internet service port, and IPP port use HTTP.

• The SSL and TLS protocols are used to encrypt the communication data. Also, a public key 
and certificate are used to decrypt the data.

• The public key and certificate can be generated using CentreWare Internet Services. The 
certificate is valid for a year. Also, an existing certificate can be imported into the machine.

Notes
• When performing SSL communication using the self-certificate generated by the machine, 

or the certificate with which the character code is indicated by UTF-8, the following 
phenomena occur. 

• If Internet Explorer is used in the OS environment Windows 98E or earlier, the publisher/
publishing place of the certificate will not be displayed correctly. 

• SSL connection will not be made if Internet Explorer is used in the OS environment of Mac 
OS X 10.2 because OS cannot recognize the character code (UFT-8) of the certificate. Use 
Netscape7 in the preceding OS environment.

• By enciphering HTTP communication, communication data can be enciphered at the time 
of printing (SSL encrypted communication). For how to encrypt, refer to the CentreWare 
Internet Services online help.
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WebDAV

This section describes the settings for the WebDAV port.

Note
WebDAV is used to access a folder on the machine from a computer connected to a network 
using CentreWare Internet Services.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.

4. Click WebDAV.

5. Set Port Number.
6. Set Connection Time-Out.
7. Reflect the values as the machine's setting values.

a. Click the Apply button. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and click OK.

Note
The default User ID value is 11111 and password is x-admin.
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c. The right frame on the web browser will change to the machine reboot display.
8. Click Reboot. The machine will reboot and the setting value will be reflected.

E-mail

Enabling the E-mail ports

This section describes the procedure to enable the ports that are used for the e-mail feature.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.

3. Click Port Settings from the Properties area of the web browser page.

4. Enable the ports which are used for the e-mail feature.
a. Select the Enable check box for Receive E-Mail when using the mail print feature.
b. Select the Enable check box for Mail Notice Service when using the mail notice or job 

completion notice feature.
5. Reflect the values as the machine’s setting values.
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a. Click the Apply New Settings. A screen to enter the user name and password will be 
displayed.

b. Enter the System Administrator UserID and password into User Name and Password, 
and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

Setting the E-mail items

This section describes the setting items for the E-mail feature.

Note
Click Help at the bottom left of the CentreWare Internet Services screen for details on the 
setting items.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab.
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3. Click Description from the Properties area of the web browser page.

4. Set the e-mail address for the machine and administrator.
a. Set the Administrator E-Mail Address.
b. Set the Machine E-Mail Address.

5. Set the TCP/IP if necessary (See Chapter 3 TCP/IP on page 3-9).
6. Click Configuration Overview and then the E-Mail Settings button.
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7. Click the E-Mail Settings Configure button Services area of the web browser page.

8. Set the receive protocol using the Receiving Protocol pull-down menu.

Note
Set this item when using the mail print feature.

9. Set the print method using the Incoming E-mail Print Options pull-down menu.

Note
Set this item when using the mail print feature.

10. Set the Output Destination for Incoming E-mail pull-down menu.
11. Set the print method using the Print Delivery Confirmation Mail pull-down menu.

Note
Set this item when using the mail print feature.

12. Select the Enable checkbox to enable the Print Error.
13. Select the Enable checkbox to enable the Response to Read Status (MDN).

Note
Set this item when using the mail print feature.

14. Click + on the left of Connectivity and + on the left of Protocols to display the items in the 
folder.
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15. Click POP3 Setup.

16. Set the POP3 server information.

Note
Set this item when using the mail print feature and POP3 is specified for the Receive 
Protocol.

a. Set the POP3 Server Address, POP3 Port Number, and POP Receiving 
Authentication.

b. Set the POP3 Server Check Interval.
c. Set the POP User Name.
d. Enter the POP User Password.

17. Set the mail exchange restrictions.

Note
Set this item when using the mail print feature.

a. From the Domain Filtering drop-down menu, select either Off, Allow Domains, or 
Block Domains.

b. Click Edit button.
c. If you selected Allow Domains, specify the domain names that will be allowed by the 

machine.
• If you selected Block Domains, specify the domain names that will be blocked by the 

machine.
d. Click the Apply New Settings.
e. Click the Back button until the E-Mail Settings screen is displayed.
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18. Click SMTP Server.

19. Set the SMTP Server Address, Host Name and Port.

Note
Set this item when using the scanner (mail transmission), mail notice, or job completion 
notice feature.

20. Set the WorkCentre E-mail Address.

21. Set the Optional Information as necessary.

22. Reflect the values as the machine's setting values.
a. Click the Apply New Settings. A screen to enter the user name and password will be 

displayed.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK.

Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.
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Network Scanning
The scanned document is stored on the machine’s hard drive and then transmitted 
automatically to a networked computer (server), using a Job Template. You can access the 
Network Scanning feature by the selecting Network Scanning button from the All Services 
screen. A list of all the Job Templates created are displayed on the Network Scanning screen.

Creating Job Templates

The job template is a configuration file that defines conditions, information about the transfer 
destination server, and other information for the scanned file.

A job template can be created using CentreWare or remotely using a Network Scanning server 
application such as the EFI Controller. According to the settings in the template, documents are 
automatically scanned, saved in TIFF/JPEG or PDF format, and then sent to a specified server.

Adding a new Template

This section describes the procedure to create Job Templates for network scanning.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Scan tab and ensure that Job Templates is selected.

3. Enter Template Name, Description (Optional), and Owner (Optional) and click Add.
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4. The added template Screen appears. Click the Edit button in the File area.

5. Set the Filing Policy and File Destination parameters and click Apply.

Note
To set the File Destination parameters, such as Protocol and IP Address, go to Chapter 3 
Adding a Job Template File Destination on page 3-34.
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6. Click Add or Edit in the Document Management Fields (Optional) area. Enter the field as 
required for your Document Management software and click Apply.

7. Click Edit in the Network Scanning area. Set the Color Scanning, 2 Side Scanning, and 
Original Type parameters and click Apply.
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8. Click Edit in the Advanced Settings area. Set the Image Options, Image Enhancement, 
and Resolution parameters and click Apply.

9. Click Edit in the Layout Adjustment area. Set the Original Orientation, Original Size, 
Reduce/Enlarge, Output Size, and Edge Erase parameters and click Apply.
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10. Click Edit in the Filing Options area. Set the Document Name, and Document Format 
parameters and click Apply.

11. Click Edit in the Report Options area. Click to enable the Confirmation Sheet and/or Job 
Log and click Apply.
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12. Click Edit in the Compression Capability area. Click to enable the desired compressions 
and click Apply.

Adding a Job Template File Destination

This section describes the procedure to add a file destination(s) to be used by the Job 
Templates for storing scanned documents.

1. Connect to CentreWare (See Chapter 3 Connect to CentreWare Internet Services from a 
computer on page 3-2).

2. Click the Properties tab and ensure that Configuration Overview is selected. Click the 
Network Scanning Settings button.
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3. Click the File Repository Configure button.

4. Click the Default File Destination Edit button.

5. The File Destination screen appears.

6. Set the File Destination parameters.
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a. Set the Friendly Name for the file destination.
b. Set the Protocol (FTP or SMB).
c. Set the Host Name/IP Address & Port.
d. Set the Share (destination shared folder on network).
e. Set the Document Path (if necessary).
f. Enter the Login Name and Password of the destination server.
g. Click Apply.
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4E-mail

E-mail overview
The machine is capable of exchanging e-mails. The following features are available by 
exchanging e-mails:

• Mail print
• Mail notice
• Job completion notice
• Scanner (mail transmission)

Note
This feature does not appear for some models. An optional package is necessary. For more 
information, contact the Customer Support Center.

Scanner (mail transmission)

Documents can be scanned and transmitted via e-mail in black and white or color (with 
optional color scanner kit).

Mail print

E-mail with attachments in either TIFF or PDF format can be sent to the machine from 
computers. Received e-mail will automatically be printed.

Mail notice

When the machine is configured with the rejected IP addresses notice or rejected mail domains 
notice, a mail notice about the rejection can be sent to a specified recipient.

Job completion notice

When a computer has submitted a job to the machine, its completion can be notified by e-mail.
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Preparations
The following items are required in order to use the e-mail feature. (Required items differ by the 
feature.)

Item Description Scanner Mail
Transmission

E-mail

Print
E-mail
notice

Job

completion 
notice

TCP/IP
address

The TCP/IP 
address for the 
machine. 
E-mail is 
exchanged using 
TCP/IP.

Subnet 
mask

Necessary when 
the network is 
divided into 
subnets.

Gateway
address

Necessary when 
multiple networks 
are connected by 
gateways.

Administrator 
e-mail address

Set the e-mail 
address for the 
machine 
administrator.

Main mail
address

Used as the sender 
address when the 
machine is 
transmitting e-
mail.

DNS server
address

Required when the 
addresses for a 
POP3 server and a 
SMTP server are 
set with a domain 
name format 
rather than their 
IP addresses.

SMTP server
address

The machine uses 
a SMTP server to 
transmit e-mail. 
The SMTP server 
can also be used 
for receiving e-
mail.
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: A required setting : May set as needed for your individual environment

Register a Mail Account

In order to use e-mail on the machine, a mail account for the machine needs to be registered.

Configuring the E-mail Environment

Enable the port and configure the machine e-mail address, TCP/IP environment, and e-mail 
server from the machine.

Note
The configuration can also be performed using CentreWare Internet Services.

SMTP 
authentication 
user

If the SMTP server 
requires 
authentication, 
specify the 
authentication 
user name.

POP3
server

If a POP3 server is 
used to receive 
e-mails, register 
the e-mail address 
of the machine 
and user to the 
POP3 server.
Also, it is necessary 
to set the POP3 
server address on 
the machine.

POP user name Set the POP 
receiving user 
address.

Item Description Scanner Mail
Transmission

E-mail

Print
E-mail
notice

Job

completion 
notice



E-mail

4-4  System Administration Guide
Xerox 4112/4127 Copier/Printer

Configuration procedure

Overview

This section describes the configuration procedure to use the e-mail feature on the machine.

The following two steps are necessary to use the e-mail feature:

• Enabling the port and setting TCP/IP: Set the machine to be able to use TCP/IP
• Configuring the e-mail feature: Set the e-mail function items on the machine.

Enabling the ports and setting the IP addresses

This section describes the configuration procedure to use TCP/IP on the machine.

First enable the e-mail port, then set the IP address.

Note
The configuration can also be performed using CentreWare Internet Services. Refer to “Using 
CentreWare Internet Services.”

Note
Enable the SOAP port and the SNMP port in most cases.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable the ports that are used for the e-mail feature.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select Send E-mail and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enabled and then select Save.
g. Select Receive E-mail and then select Change Settings.
h. Select Port Status and select Change Settings.
i. Select Enabled and then select Save.
j. Select Close repeatedly until the Connectivity & Network Setup screen is displayed

3. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
4. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
5. After the machine is restarted, print out the Printer Settings List to confirm that the ports 

are enabled and TCP/IP is configured.
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Configuring the E-mail environment

This section describes the configuration procedure to use the e-mail feature.

Notes
• The configuration can also be performed using CentreWare Internet Services. Refer to 

“Using CentreWare Internet Services.”
• Enable the SOAP port and the SNMP port in most cases.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Set the e-mail address, host name, and domain name.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Machine E-mail Address/Host Name.
d. Select E-mail Address and then select Change Settings.
e. Enter the E-mail Address using the keyboard displayed.
f. Select Save.
g. Set the Host Name and Domain Name as above.
h. Select Close.

If SMTP has been selected for the E-mail Receiving Protocol
• Alias cannot be configured. User can decide the account (the left side of @ mark). The 

address (the right side of @ mark) is a combination of host name and domain name.
• Example: mymail@mycompany.com

• Account name: mymail
• Host name: host
• Domain name: mycompany.com

If POP has been selected for the E-mail Receiving Protocol
• Specify POP user name to the account (the left side of @ mark), and POP3 receiving mail 

server to the address (the right side of @ mark). User can decide an alias such as 
mymail@mycompany.com
• Example: mymail@mycompany.com
• Account name: mymail

3. Set the protocol for receiving e-mail.
a. Select Other Settings.
b. Select E-mail Receive Protocol and then select Change Settings.
c. Select either SMTP or POP3 as appropriate for your environment.
d. Select Save and then select Close.
e. From the Connectivity & Network Setup list, select Outgoing/Incoming (i.e. E-mail 

Send/Receive Settings).
If SMTP has been selected for the Mail Receiving Protocol:

a. Select SMTP Server Settings
b. Select SMTP Server Port Number.
c. Enter a value in the range from 1 to 65535. The default is 25.
If POP3 has been selected for the Mail Receiving Protocol:
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a. Select POP3 Server Settings
b. Select Server Name/IP Address.
c. Enter the POP3 Server Name/IP Address and press Save.

Note
Enter the address in the format “xxx.xxx.xxx.xxx”. The “xxx” should be a numeric value in 
the range from 0 to 255. However, 224 - 255.xxx.xxx.xxx and 127.xxx.xxx.xxx cannot be 
used.

d. Select POP3 Server Port Number.
e. Enter a value in the range from 1 to 65535. The default is 110 (Do not use the numbers 

of any other ports) and press Save.
f. Select Polling Interval.
g. Set the interval for checking the e-mail on the POP3 server and press Save.
h. Select Login Name.
i. Enter the name to log in to the POP3 server and press Save.
j. Select POP3 Server Password.
k. Enter the same password twice in the New Password and Re-enter Password. If you do 

not set the password, leave it blank and select Save.
l. Select POP Password Encryption.
m. Select On (APOP) to encrypt the password, if desired and press Save and press Close 

twice.
4. Configure the E-mail transmission

a. From the Connectivity & Network Setup list, select Outgoing/Incoming (i.e. E-mail 
Send/Receive Settings).

b. Select SMTP Server Settings
c. Select SMTP Server Name/IP.
d. Enter the SMTP Server Name/IP Address and press Save.

Note
Enter the address in the format “xxx.xxx.xxx.xxx”. The “xxx” should be a numeric value in 
the range from 0 to 255. However, 224 - 255.xxx.xxx.xxx and 127.xxx.xxx.xxx cannot be 
used.

e. Select SMTP Server Port Number.
f. Enter a value in the range from 1 to 65535 and press Save. The default is 25.
g. Select E-mail Send Authentication.
h. Select one from Off, POP before SMTP, or SMTP AUTH. Tip: If you are having trouble 

sending E-mail, to see if Authentication is the problem, set this item to Off and set the 
SMTP Server IP Address (above) to a server that does not require authentication.

i. Select SMTP AUTH Login Name.
j. Set this item if SMTP AUTH is selected for E-mail Send Authentication.
k. Select SMTP AUTH Password.
l. Set this item if SMTP AUTH is selected for E-mail Send Authentication. Enter the 

same password twice in the New Password and Re-enter Password. If you do not set 
the password, leave it blank and select Save and Close.
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5. Configure the Domain restriction
Select Domain Filter and set the following items.

• Domain filtering
• Select one from Off, Allow Domains, or Block Domains.
• Domain 1 - Domain 50
• Specify up to 50 domains if either Allow Domains or Block Domains has been selected 

for Domain Filter.
6. Select Close repeatedly until the System Settings screen is displayed.
7. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
8. After the machine is restarted, print out the Printer Settings List to confirm that each item 

is configured.
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5Using the Scan 
Service

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

Scan Service overview
The following functions are available by using scan services:

• Scanner (mail transmission)
• Scanner (save to a folder)
• Job template scan
• Scanner (save to a computer)
• Job flow scan

Notes
• An optional package is necessary for this feature to function. For more information, contact 

the Customer Support Center.
• The optional color scanner kit will allow scanning in color or black and white. Scans from 

Scan Service cannot be printed unless retrieved at the client and resubmitted as a print job. 

Scanner 
(mail transmission)

Documents can be scanned and transmitted via e-mail.

Scanner
(save to a folder)

Documents which you would like to take in as data can be scanned and stored into a folder. 
Stored documents can be accessed from network computers.
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Job template scan

A job template is a configuration file for scanning parameters. Specify a job template for the 
document to be scanned in as data. The scanned document will be stored on a hard disk on the 
machine, then transmitted automatically to a networked computer (server).

Note
You can create a maximum of 500 Job Templates.

Scanner 
(save to a computer)

When the machine is connected to a network, scanned data can be stored on network 
computers using the FTP or SMB protocol. 

Documents which you would like to take in as data can be scanned and stored on network 
computers.

Job flow scan

A scan can be performed using a job flow which has been created using an external editor.

Configuration of the scanner (mail 
transmission)

Preparations

Prepare the following to use the scanner (mail transmission) function:

• A registered mail account

A mail account for the machine needs to be registered.

Overview

The following is the procedure to use the scanner (mail transmission) function:

• Enabling the port and setting TCP/IP
• Enable the mail send port and mail receive port, and set IP addresses on the machine.
• Configuring the E-mail Environment

Set the e-mail function items on the machine.

1. Enable the ports and set the IP address (Chapter 4 Enabling the ports and setting the IP 
addresses on page 4-4)

2. Configure the e-mail environment (Chapter 4 Configuring the E-mail environment on page 
4-5)
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Configuration of the scanner (Save to a 
Folder)

Overview

The following is the procedure to use the scanner (save to a folder) function:

• Enabling the port and setting TCP/IP

First enable the Salutation port, then set the IP address.

• Registering a Folder

Register a folder for storing the scanned data.

Enabling the ports and setting the IP addresses

Enable the IPP port (Salutation) for the scanner (save to a folder) and then set the IP address. 
The procedure for setting the machine is as follows.

Notes
• The configuration can also be performed using CentreWare Internet Services. Refer to 

“Using CentreWare Internet Services”.
• Enable the SOAP port and the SNMP port in most cases.

Refer to Chapter 2 Configuration on the machine (IPP) on page 2-5.

Registering a Folder

Documents stored in a folder can be taken into an application via the scan driver by a computer.

A maximum of 200 folders can be registered. The following items can be configured or 
changed:

Folder name

Set the name used for a folder. Up to 10 characters can be used for the name.

Password

A password of up to 20 characters can be set. A password is not a required setting. Passwords 
are valid only when the System Administrator password is set.

Check password

When the password is set, configure whether each operation (such as read or write) requires 
password restrictions.

Delete document after retrieval

Set whether to delete a document in the folder after the document is retrieved, printed, or 
transferred by a job flow.
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Link a job flow sheet to a folder

Set or change a link to a job flow, or select and run a job flow.

The procedure that follows describes how to register a folder on the machine.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Select Setup Menu.
3. Select Create Folder.

4. Select a box to register and then select Create/Delete.
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Note
Folders that have not been registered are displayed as “(Not In Use).”

5. Configure other items as necessary. Select an item to configure and select Change 
Settings. When the setting is completed, select Save.

Folder name

Set the name used for a folder. Up to 10 characters can be entered.

Note
The buttons on the Control Panel can also be used for the entry.

Check passcode

When the password is set, configure whether each operation (such as read or write) requires 
password restrictions.

• Always
• A password is required for both the above operations.
• Save (write)
• A password entry is required when selecting a folder.
• Print/delete (read)
• A password entry is required when printing or deleting a document in a folder.

Delete document after retrieval

Set whether to delete a document in the folder after the document is retrieved, printed, or 
transferred by a job flow.

• No
• The document is kept.
• Yes
• The document is deleted.
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Delete documents with expiration date

When an Document Expiration Date is set in Stored Document Settings under System 
Settings, expired documents are deleted at the specified time.

Link a job flow sheet to a folder

Set or change a link to a job flow, or select and run a job flow.

6. Set a password.

When setting a password:
• Select On.
• Enter the password using the numeric keypad then select Save.
• The Folder XXX - Create/Delete screen is displayed. XXX indicates the folder number to 

register.

Note
The password entered is displayed as “*.” If you make a mistake while entering the password, 
press the C (Clear) button and enter the password again.
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When not setting a password
• Select Off and then select Save.
• The Folder XXX - Create/Delete screen is displayed. XXX indicates the folder number to 

register.
7. Configure other items as necessary. Select an item to configure and select Change 

Settings. When the setting is completed, select Save.

Folder name

Set the name used for a folder. Up to 10 characters can be entered.

Note
The buttons on the Control Panel can also be used for the entry.

Check passcode

When the password is set, configure whether each operation (such as read or write) requires 
password restrictions.

• Always
• A password is required for both the above operations.
• Save (write)
• A password entry is required when selecting a folder.
• Print/delete (read)
• A password entry is required when printing or deleting a document in a folder.

Delete document after retrieval

Set whether to delete a document in the folder after the document is retrieved, printed, or 
transferred by a job flow.

• No
• The document is kept.
• Yes
• The document is deleted.
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Delete documents with expiration date

When an Document Expiration Date is set in Stored Document Settings under System 
Settings, expired documents are deleted at the specified time.

Link a job flow sheet to a folder

Set or change a link to a job flow, or select and run a job flow.

8. Confirm the entries made in the Create/Delete screen and select Close.
9. Continue to select Close until the System Settings screen is displayed.

Configuration of the Job Template

Preparations

The following environment is required to use the job template scan function on the machine:

• Using with FTP

For information on the required FTP server.

• Using with SMB

To use SMB forwarding, your computer should have one of the following operating systems 
installed that supports folder sharing:

• Microsoft Windows 2000
• Microsoft Windows Server 2003
• Microsoft Windows XP
• Microsoft Windows Vista

Overview

The following is the procedure to use the job template scan function:

• Enabling the port and setting TCP/IP

Enable the SNMP port, Internet service port and FTP port or SMB port, and set IP addresses 
on the machine.

• Configuring the SNMP port

Configure the transport protocol for the SNMP port using CentreWare Internet Services.
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Enabling the ports and setting the IP addresses

In order to use FTP service on the machine, enable the port and set the IP address.The 
procedure for setting the machine is as follows.

Note
The configuration can also be performed using CentreWare Internet Services. Refer to “Using 
CentreWare Internet Services”

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable the SNMP port.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select SNMP and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enable and then select Save.
g. Select Close

3. Enable the FTP client port and Internet service (HTTP) port as above.
4. Select Close.
5. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
6. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
7. After the machine is restarted, print out the Printer Settings List to confirm that the ports 

are enabled and TCP/IP is configured.

Configuring the SNMP port

Configure the transport protocol for the SNMP port using CentreWare Internet Services.

1. Start a web browser.
2. Enter the machine’s IP address or the Internet address to the address entry column on the 

browser, and press the Enter key.
• Example of the IP address entry:
• http://192.168.1.1/
• Example of the Internet address entry:
• http://xxx.yyyy.zz.vvv/

Note
When specifying a port number, add “:” and a port number to the end of the Internet 
address.

3. Click the Properties tab.
4. Click Port Status from the Properties area.
5. Select the UDP checkbox to the right of SNMP (Port Status feature).
6. Reflect the values as the setting values of the machine.

a. Click the Apply button.
b. Enter the System Administrator UserID and password into User Name and Password, 

and then click OK. 
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Note
The default User ID value is 11111 and password is x-admin.

c. The right frame on the web browser will change to the machine reboot display.
d. Click Reboot. The machine will reboot and the setting value will be reflected.

Configuration of the scanner (Save to a 
Computer)

Preparations

Prepare the following to use the scanner (save to a computer) function:

Using with FTP

When using with FTP transmission, one of the following FTP servers and an account to FTP 
servers (login name and password) are required:

• Microsoft Windows 2003 Server

The FTP service of Microsoft Internet Information Server 6.0.

• Microsoft Windows 2000 Server, Microsoft Windows 2000 Professional, or Microsoft 
Windows XP.

The FTP service of Microsoft Internet Information Server 3.0.

• Novell NetWare

FTP service of NetWare 5.11J or 5.12J.

Refer to the manual provided with the software for how to configure the FTP service.

Using with SMB

When using with SMB transmission, your computer must have one of the following operating 
systems installed that supports folder sharing:

• Microsoft Windows 2000

• Microsoft Windows 2003 Server

• Microsoft Windows XP

• Microsoft Windows Vista
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Overview

This section describes the configuration procedure to use the scanner (save to a computer) 
function on the machine.

The following is the procedure to use the scanner (save to a computer) function:

• Enabling the port and setting TCP/IP

Enable the FTP port or SMB port and set the machine's IP address.

• Preparing a FTP folder or SMB folder

Create a folder for transmission destinations on the computer.

Note
When using with SMB protocol, you must login to the FTP server of your choice and create a 
destination directory for your files.

Enabling the ports and setting the IP addresses

In order to use the scanner (save to a computer) service, enable a port (SMB or FTP client) and 
set the IP address. The procedure for setting the machine is as follows:

Note
The configuration can also be performed using CentreWare Internet Services. Refer to “Using 
CentreWare Internet Services”.

Note
Enable the SOAP port and the SNMP port in most cases.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable the SNMP port.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select SMB and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enable and then select Save.
g. Select Close

3. Enable the FTP client port and Internet service (HTTP) port as above.
4. Select Close.
5. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
6. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
7. After the machine is restarted, print out the Printer Settings List to confirm that either the 

SMB port or FTP client port is enabled and the IP addresses are configured.
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Configuration on the computer

This section describes the configuration procedure for the computer.

Using with FTP

Create a destination directory/folder for your files. this directory/folder should be created on 
the FPT server where you logged in.

Using with SMB

Create a folder on the computer and configure it as a shared folder.

Configuration of the Job Flow
The following is the procedure to use the job flow scan function:

• Enabling the port and setting TCP/IP

Enable the SOAP port, SNMP port, and Internet service port, and set IP addresses on the 
machine.

• Configuring the SNMP port

Configure the transport protocol for the SNMP port using CentreWare Internet Services.

• Configuring the computer

Enabling the ports and setting the IP addresses

In order to use the job flow service, enable the SOAP port, SNMP port, and Internet service port, 
and set IP addresses. The procedure for setting the machine follows.

Note
The configuration can also be performed using CentreWare Internet Services. Refer to “Using 
CentreWare Internet Services”.

1. Enter the System Administrator Mode (Chapter 1 Entering the System Administrator mode 
on page 1-10.)

2. Enable the SOAP port.
a. Select System Settings.
b. Select Connectivity & Network Setup.
c. Select Port Settings.
d. Select SOAP and then select Change Settings.
e. Select Port Status and select Change Settings.
f. Select Enable and then select Save.
g. Select Close
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3. Enable the SNMP port.
a. Select Network Settings.
b. Select Port Settings.
c. Select SNMP and then select Change Settings.
d. Select SNMP - Port and select Change Settings. 
e. Select Enable and then select Save.
f. Select Close.

4. Enable the Internet service (HTTP) port as above.
5. Select Close.
6. If necessary, set the IP Address (Chapter 1 Setting the IP address on page 1-11).
7. Select Close repeatedly until the System Settings screen is displayed.
8. Exit the System Administrator Mode (Chapter 1 Exiting the System Administrator mode on 

page 1-11).
9. After the machine is restarted, print out the Printer Settings List to confirm that the SOAP 

port is enabled and the IP addresses are configured.
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6Folder backup and 
restore

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

Overview
The folder Backup Tool for restored document is a software application that allows you to:

• Copy and save (backup) documents and folderes from the machine onto your personal 
computer’s hard drive or onto a secondary backup device (such as USB flash drive) that is 
attached to your computer

• Create, copy, delete, or change settings from your computer for documents/folderes that 
reside on the machine

• Restore the backed up documents/folders from your computer to the machine

Note
Always refer to the online Help for information on the features and functions of the Backup Tool 
for restore document application. The online Help can be accessed by starting the application 
and selecting Help.

Tip
The following important criteria applies when using the Backup Tool for restored document 
application:

• The machine cannot be used while making backups.
• When using the backup documents on any 4112/4127 Copier/Printer, ensure that all the 

settings on the machine along with the paper tray settings are exactly the same as when 
the backup documents were saved to your computer.
• If these settings are not the same, or if optional features have been added to the 

machine since the folder documents were copied and saved, then the restored 
documents may not print in accordance with their original settings.

• When you backup the folders, the following settings are not backed up and will be lost:
• Folder Passwords
• Access restrictions (Target Operations): Always (All Operations): Requires a password 

for:

– Scanning and saving documents to the folder

– Viewing (reading) the folder’s Document List

– Printing or deleting documents from the folder

– Save (Write): Requires a password only when scanning and saving to a 
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folder. Does not require a password for reading (viewing) the folder’s Document 
List nor for printing or deleting documents from the folder.

– Print/Delete (Read): Requires a password only when reading (viewing) the folder’s 
Document List, and when printing or deleting documents from the folder. Does 
not require a password when scanning and saving documents to the folder.

• If the folders use any of these settings, the folder owners should record these settings so 
that, if necessary, they can reprogram the folders and its documents after they are restored 
onto the machine.
• Automatic deletion of documents after retrieval
• Deletion of documents after their expiration date
• Links to Job Flow Sheets

Install the software
The Backup Tool for restored document software resides on a CD-ROM that came with your 
machine. If you do not have or cannot find this CD, contact your local Xerox Representative.

The CD contains the software for installing the application and two other important files:

• Readme.txt: This text file provides an overview of the features and functions of the 
software application.

• Manual.pdf: This file provides instructions for installing the software on a user’s computer.

Tip
Before installing the software, access these files on the CD and print a hard copy for easy access 
and reference.

1. Insert the CD into your CD-ROM drive.
2. Follow the instructions provided in the Manual.pdf file for installing the software onto your 

computer.

Backup Tool for restored document 
requirements
Before you can use the application, specific settings on the machine must be configured.

1. Obtain and record your computer’s IP address.
2. At the machine, login in as the System Administrator; refer to System Administrator mode 

on page 1-10.
3. Press the Machine Status button on the Control Panel.
4. Select the Tools tab from the UI.
5. Select Connectivity and Network Setup > Port Settings.
6. Ensure that the following ports are Enabled:

• SNMP
• SOAP
• WebDAV port
• (CentreWare) Internet Services (HTTP)

7. From the Port Settings screen, select Close to return to the main Tools screen.
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8. Select Connectivity and Network Setup > Other Settings.
9. Select Folder Backup Tool - IP address and the Change Settings button.
10. Enter your computer’s IP address and select Save.
11. Exit Tools mode by pressing the Log In/Out button on the Control Panel.
12. From your computer, select Start > Program > Xerox > Back-Up Tool for restored 

document > Back-Up Tool for restored document
13. Enter a password, and click OK. The default password is x-admin.

14. The application opens to the main screen.
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Add a machine to the application service
Follow the steps below to register the machine’s IP address or DNS host name on your computer 
via the Back-Up Tool for restored document application.

Note
For information about how to register the machine by searching the network, refer to the 
application’s online help.

1. Select Backup Folder Document, and from the Edit menu, select Add Device....

2. Select the Device Type from the pull-down menu.

3. Enter an IP v4 Address, IP v6 Address or Host Name, and click OK. 
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4. Click OK.

Import folder information from the 
machine
Follow the steps below to import the information from the folders and documents stored on the 
machine onto your computer via the Back-Up Tool for restored document application.

1. Select the machine, and from the Edit menu, select Get Attributes from Device.

2. Click OK.
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3. Click OK.

Note
When the attribute values cannot be imported, ensure that the machine is powered on and that 
its IP address or host name are entered correctly in the backup application on your computer. 

4. Right-click on Folder List and select Retrieve Folder Document Information.

5. Click OK.
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6. After the import is complete, click OK.

Copy (backup) the folders onto your 
computer
Tip
The machine cannot be used while making backups.

1. Right-click on a folder, and select Backup Folder documents.

Note
If you select the Folder List and then Backup Folder documents, you can back up all the 
files in the list. 
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2.Click Backup.

3. After the backup is complete, click Close.
4. To confirm that the folder box was copied and saved, click on the plus sign to the left of the 

Backup File List; the saved folder is displayed.
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Save the backup on your computer
1. From the Backup File List right-click on a folder and select Export Backup Files.

Note
If you select the Backup File List and then Export Backup Files, you can save all the files in 
the list.

2. If necessary, select a location on your computer to save the folder and click Save.
3. After the processing is complete, click OK.
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Read (view/edit) the saved folders on 
your computer
1. From the Backup File List, right-click on a folder, and select Import Backup Files.

2. Select a folder, and click Open.

Note
Only folders/documents with an extension of “.bf1” can be read (viewed).

When two of the same folders/documents exist, a confirmation window opens and ask you 
to choose either Overwrite Existing Backup File or Save As A New Backup File. 

3. After the processing is complete, click OK.
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Restore backed-up folders to the 
machine
Tip
When the folders were backed up, the following settings were not backed up and thereby lost:

• Folder Passwords
• Access restrictions (Target Operations):

• Always (All Operations): Requires a password for:

– Scanning and saving documents to the folder

– Viewing (reading) the folder’s Document List

– Printing or deleting documents from the folder
• Save (Write): Requires a password only when scanning and saving to a folder. Does 

not require a password for reading (viewing) the folder’s Document List nor for printing 
or deleting documents from the folder.

• Print/Delete (Read): Requires a password only when reading (viewing) the folder’s 
Document List, and when printing or deleting documents from the folder. Does not 
require a password when scanning and saving documents to the folder.

• Automatic deletion of documents after retrieval
• Deletion of documents after their expiration date
• Links to Job Flow Sheets

Each folder owner must reprogram their folder and document contents with the appropriate 
settings.

1. From the Backup File List right-click on a folder, and select Restore Backup Files.
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2. Enter a Folder Number, and click Restore.

Note
If the entire Backup File List is selected, the following dialog box opens:

Setup New Folder in the Device: Check this box when there is currently no folder with the 
same name residing on the machine. If this item remains unchecked, a new folder will not be 
created on the machine.

Delete Folder Documents in the Device: Check this box if you want to delete documents 
currently stored in the machine’s selected folder before restoring the backup files into the folder.

3. Click OK.



Folder backup and restore

Xerox 4112/4127 Copier/Printer 6-13
System Administration Guide

Note
Deleted documents cannot be recovered. If necessary, always copy and save (backup) 
before deleting them. 

4. After the processing is complete, click Close.

Password information
The Back-Up Tool for restored document requires the system administrator ID and password 
when communicating with the machine. Initially, the application is configured with factory 
default ID and password. 

Note
The default system administrator ID is “11111.” The default password is “x-admin.”

If the machine’s ID and password are changed from their default settings, you must also 
change the ID and password on the Back-Up Tool for restored document application.

Note
If you change the system administrator’s ID and password, you must select [Get attributes from 
the machine] in order to obtain the latest folder information/attributes.

1. Select a machine, and select Device Communication Settings... from the Edit menu.
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2. Enter the system administrator’s ID in System Administrator ID.

3. Enter the password in Password and Confirm Password.
4. Click OK.
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7Computer 
Operations

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

Overview of features

Network Scanner Utility2 

Using Network Scanner Utility2, you can import scan documents stored in the folder of the 
machine onto a network computer.

There are 2 types of Network Scanner Utility2:

Note
Use the included CentreWare Utilities CD-ROM to install Network Scanner Utility2.

Network scan driver

The Network Scan driver is used to allow client-side application software to import documents 
(scan data) stored in the folder on the machine via the network.

• Network Scanner • Folder Viewer2
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Folder Viewer2

Using Folder Viewer2, you can import documents stored in the folder on the machine without 
using any application software.

CentreWare Internet Services

CentreWare Internet Services requires a TCP/IP environment, and enables you to view the 
status of the machine and its jobs, as well as change settings via a web browser. You can also 
import documents saved in a folder.

The CentreWare Internet Services Screen

The CentreWare Internet Services screen is made up of 4 frames. The contents displayed in 4 
frames change depending on the feature in use (service, job, status, property, maintenance, 
support).

Note
You can read explanations of CentreWare Internet Services via the online help by clicking on the 
Help button in the top frame. 

Top frame

The Top Frame includes the logo, the machine name, a link to online help, and tabs (links) to 
each feature.

Right frame, upper left frame

Contents change depending on the selected feature. When a feature is selected, configurable 
features and data are displayed in the right frame and upper left frame.

A link to the Copyright screen is displayed in the Status tab.

Lower left frame

A link to the Xerox home page is shown.

Top Frame

Right FrameUpper Left 
Frame

Lower Left 
Frame
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Primary features provided by CentreWare Internet Services are listed below:

Notes
• Some field settings only take effect after a reboot (after power cycle of the machine, or 

after changing a system setting from the control panel).
• When a setting is changed from CentreWare Internet Services while operating the control 

panel, the setting items changed on the screen of the control panel are not displayed. 
Power-cycle the printer in this case.

• A user name and password is required to make changes to system administrator settings. 
The default user name is 11111. The default password is x-admin.

Browser

CentreWare Internet Services has been tested on the browsers listed below.

For Windows OS
• Microsoft Internet Explorer 6.0 Service Pack 1 or later

• Netscape 7.0 or later

For MacOS X 10.2

• Microsoft Internet Explorer 5.2 or later

• Netscape 7.0 or later

Tab name Main features

Service Print Commands
You can specify a file on your PC to print. 

Job Job List, Job History Report, Delete Jobs

Status Display Device Status
Display the status of paper tray and output tray, and consumables such as toner
Reboot by system administrator

Properties Display and configuration of the properties below:
Device information and date / time settings, memory and print language device 
configuration display, quantity display, paper tray settings, paper settings, power 
saver mode settings, folder edit, Job Flow edit, security settings, ID management, 
mail notification settings, Auditron settings, Internet Services settings, port 
settings
Port Settings
Protocol Settings
Emulation Settings
Memory Allocation

Maintenance Display Error History

Support Display Support Data
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Browser settings

Before using this service, check the following configuration settings for your browser. Internet 
Explorer 6.0 SP is used as an example.

1. Select Internet Options from the Tools menu.
2. In the General tab, click the Settings button in the Temporary Internet Files pane.
3. In the Settings dialog box, set Check for newer versions of stored pages to either Every 

visit to the page or Every time you start Internet Explorer.
4. Click OK.

Proxy server and port numbers

This section describes proxy server settings and port numbers when using this service.

Proxy server

We recommend that you use this service by connecting directly, and not using a proxy server.

Note
If using a proxy server, specifying the IP address of the machine in the browser results in slower 
responses and could prevent some screens from appearing. In this case, it is necessary to 
configure the machine’s IP address on the browser-side without going through a proxy server. 
Refer to the browser documentation for configuration instructions.

Port number

This service is configured to use port “80” by default. The port number can be changed in 
Properties > Protocol Settings > HTTP. Valid ports are 1 - 65535.

If you change the port to a value other than “80,” you must add “:” plus the port number to the 
IP address when typing the URL into your browser.

For example, if the port number is “8080,” the URL is: 

http://the IP address of the machine:8080

OR

http://the Internet address of the machine:8080

Notes
• You can verify the port number in Settings List > Maintenance. For information about the 

Setting List, refer to the section entitled “Print Report/List” in Chapter 10 of the User Guide.
• If communications are encrypted, you must specify an address that starts with “https” 

instead of “http” to access CentreWare Internet Services.
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Starting CentreWare Internet Services

To use this service, perform the following procedure on your computer.

1. Start up the computer and the browser.
2. Enter the device IP address or Internet address in the browser address field and press the 

Enter key.

Notes
• If your network uses DNS (Domain Name System) and the host name of the machine is 

registered with the domain name server, you can access the device using a combination of 
the host name and the domain name as the “Internet address.” For example, if the host 
name is “myhost,” and the domain name is “mycompany.com,” then the “Internet address 
“myhost.mycompany.com.” When specifying a port number, add “:” and a port number to 
the end of the Internet address.

• If using the authorization feature on the machine, enter a UserID and Password into the 
User Name and Password fields. Ask the machine administrator for the UserID and 
Password.

• If communications are encrypted, you must specify an address that starts with “https” 
instead of “http” to access CentreWare Internet Services.

E-mail print
You can send e-mail with TIFF or PDF documents attached from a computer to the machine. 
Received e-mail is automatically printed. This feature is called “E-mail Print.”

Setup

To use the E-mail Print feature, the following setup is necessary. Check with your system 
administrator or network administrator whether these settings have been completed.

Network environment Settings

Register a User Account

Set the e-mail environment

Configure the port, the e-mail address of the machine, TCP/IP environment, and e-mail server, 
for example.

Note
For more information, refer to Connectivity & Network Setup on page 9-119.

Set Login setup/Auditron Administration

When print jobs are being controlled from Login Setup/Auditron Administration, set Non-
Account Print to Enable in order to display it on the Properties tab of CentreWare Internet 
Services (on the browser page).
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8Accounting and 
Authentication/
Security Settings

The machine has Accounting and Authentication/Security Settings that are used for numerous 
security measures This chapter describes how to adjust these settings.

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

Overview
While the Accounting feature restricts local and remote access to Copy, Scan and Print features, 
Authentication/Security Settings restricts local and remote access to the Services area, which 
includes All Services, Job Status and/or Machine Status pathways.

Accounting settings and Authentication/Security Settings features generally work 
independently, but there are instances when a change in one will affect the other. As an 
example, if you set the Authentication feature to Login to Local Accounts, Local Accounting is 
automatically set in the Accounting menu.

Only the System Administrator can set and control Accounting and Authentication/Security 
Settings.
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Accounting
Accounting is a security feature that is designed to prevent unauthorized use of the machine. 

Overview

The accounting feature allows you to:

• Restrict local or remote access to some or all of the Print, Copy and Scan features. You may 
want certain departments or individuals to have access locally or remotely to only certain 
machine features.

• Prevent unauthorized users from using the machine. Only users with a valid User ID can 
access the machine. This allows you to determine which individuals are allowed to access 
the machine.

• Track the number of copies, scanned pages and printed pages for any user account. This 
can be useful when machine expenses are shared among various departments. As an 
example, the human resources and maintenance departments can each be invoiced 
separately for their machine usage.

• Impose restrictions on individual accounts, such as limiting the number of copy, scan, and 
prints jobs that are allowed a user. As an example, you can allow the maintenance 
department to have unlimited access the copy and print features, but limit scanning. 

Note
When used with Accounting, the Authentication/Security Settings features provide additional 
security options.

The type of information that users are prompted to enter when accessing machine features 
depends on the Accounting and Authentication settings. 

When the Login Setup/Auditron Administration feature is enabled, each user of the machine 
must enter a UserID and password, thus providing administrative control and for the machine.

Creating/Viewing User Accounts

Creating user accounts allows you to register user account information, such as User IDs, user 
names, and passcodes, and to impose restrictions:

• On the number of copy, scan and print pages allowed each user using the Accounting 
menu:.

• On the Services pathways allowed using the Authentication/Security Settings menu.

A maximum of 1000 users can be registered. 

Note
User IDs, and user names must be registered in Accounting before you can register users for 
Authentication
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Create/View User Accounts
Note
The following procedure is presented using the Accounting menu screens, but this same process 
is also performed using the Authentication/Security Settings menu screens.

1. Login as System Administrator.
2. Select the Machine Status button.
3. From the Tools tab, select Accounting or Authentication/Security Settings. 
4. Select Create/View User Accounts.

5. From the Create/View User Accounts screen, perform one of the following to select a user 
account:
• Select a (Not in Use) account that you want to create and then press the Create/Delete 

button.
• Using the numeric keypad, enter a four-digit number from 0001 to 1000, which 

corresponds to a (Not in Use) account. The entered number displays in the Go To field. 
Then select the Create/Delete button.
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Note
You can also edit a previously created user account to reflect new user information.

6. To continue the user account creation process continue to the next steps User ID, User 
Name, Account Limit and Feature Access on page 8-4.

User ID, User Name, Account Limit and Feature Access

To access the User ID, User Name, Account Limit and Feature Access screens login as System 
Administrator > select the Machine Status button > Tools tab > Accounting > Create View 
User Accounts > select a User.> Create/Delete.

The following is a continuation of the user account creation process from the previous page.

UserID
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7. Select the UserID button. The User ID screen appears. Using the keypad, enter a User ID of 
up to 32 characters and press Save.

User Name
8. Select the User Name button. The User Name screen appears. Using the keypad, enter a 

User Name of up to 32 characters and press Save.

Note
If you are creating a new (Not in Use) account, you would go directly to the UserID screen, 
which is shown below. Enter a UserID and select Enter.

Account Limit

9. Select the Account Limit button.
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Account Limit

You can set the maximum number of pages that can be used in a copier, scanner and 
printer. You can set from 1 to 9,999,999 pages (7 digits) in 1 sheet increments.

a. Select Account Limit.
b. Select the Copy, Scan or Print Service button to set account limits. 
c. Select Change Account Limit.

d. Enter the maximum number of pages using numeric keypad and press Save.
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Feature Access

10. Select the Feature Access button for any Service. This allows you to set the type of access 
that you want to give users. 

e. Select the type of feature access you want to allow the user.
f. Press Save.

11. Select Close and review the created user account information.
12. Select Close to return to the Tools tab.
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Resetting User Accounts
Note
Resetting user accounts within Authentication is a similar procedure to resetting user accounts 
in Accounting. Procedure differences are explained when encountered.

There are two options when resetting user accounts. 

• Resetting All User Account Information: You can reset All User Accounts, All Feature 
Access Settings, All Account Limits, Total Impressions and Meter (Print Jobs) and then print 
Auditron and Meter Reports.

• Resetting Individual User Accounts and Total Impression: You can reset individual 
accounts and total impressions: 

Resetting All User Account Information

Note
Resetting user accounts within Authentication is a similar procedure to resetting user accounts 
in Accounting. Procedure differences are explained when encountered.

You can delete all registered information for all registered users in a single operation, or just 
reset the statistics. This feature also enables you to print all service auditron reports.

Reset User Account

This deletes all registered information for the selected user.

1. Login as System Administrator and select the Machine Status button.
2. Press the Tools tab.
3. Select:

• From Accounting, select Reset User Accounts.
• From Authentication/Security Settings, select Authentication > Reset User Accounts.

4. Select from the Reset User Accounts options and press Reset. Once you select Reset, you 
will be prompted to accept Reset or Cancel the reset. Carefully review the displayed 
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information before performing a reset. It is important to remember that once you accept a 
reset, that information cannot be restored.

A confirmation screen, asking “Are you sure?” is displayed.

5. Select Reset or Cancel.

All User Accounts
This deletes all registered information for each user. It also deletes all data including the 
maximum number of pages, cumulative number of pages, color mode restrictions, printer 
statistics, and so forth.

Tip
All job flows, folders, and documents within folders belonging to the user are deleted. If the user 
is owner of a large amount of material (when a large quantity of documents is left remaining 
within a folder for example), the deletion may take a considerable time.

All Feature Access Settings

This resets the All Feature Access.

All Account Limits

This resets the maximum number of pages for all users to the default value, 9999999.

Total Impressions

This resets all Auditron administration data for all users including the system administrator. The 
number of pages is also reset to 0.

All Authorization Group

This is used to set the All Authorization Group.
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Meters (Print Jobs)

This resets all printer statistics, and deletes automatically registered job owner names. The 
count of the number of pages printed is also reset to zero.

Print the Auditron Report button

Prints the auditron reports. 

This option is available for all selections except Meter (Print Jobs).

Print the Meter Report button

Prints a print meter report. 

This option is available for Meter (Print Jobs), only.

Resetting Individual User Accounts and Total Impressions

Note
Resetting user accounts within Authentication is a similar procedure to resetting user accounts 
in Accounting. Procedure differences are explained when encountered.

You can reset individual user accounts. The following information is removed from the system: 
UserID, User Name, user details, folders created by the user, documents stored in the folders, 
Job Flow Sheets created by the user, and total impressions made by this user.

1. Login as System Administrator. and select the Machine Status button.
2. From the Tools tab, select Accounting or Authentication. 
3. Select:

• From Accounting, select Create/View User Accounts.
• From Authentication/Security Settings, select Authentication > Create/View User 

Accounts. 



Accounting and Authentication/Security Settings

Xerox 4112/4127 Copier/Printer 8-11
System Administration Guide

4. Select the user account that you want to reset.and press Create/Delete.

Reset User Account
This deletes all registered information for the selected user.

5. Select Reset Account. Once you select Reset, you will be prompted to accept (Reset) or 
Cancel the reset. Carefully review the displayed information before performing a reset. It is 
important to remember that once you accept a reset, that information cannot be restored.

Tip
All the contents of the folder (such as job flows, folders, and documents) are deleted. If the 
user is owner of a large amount of material, the deletion may take a considerable amount 
of time.
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Reset Total Impressions
Reset the current cumulative number of pages for a selected user, returning it to zero.

6. Select Reset Total Impressions. Once you select Reset, you will be prompted to accept 
(Reset) or Cancel the reset. Carefully review the displayed information before performing a 
reset. It is important to remember that once you accept a reset, that information cannot be 
restored.

Note
The selections available will depend on the setting selected in Accounting Type.

System Administrator's Meter (Copy Jobs)

You can check/reset the cumulative number of pages copied using the System Administration 
mode on the screen. The cumulative number of page is counted up to 9,999,999 pages.

1. Logon as System Administrator and select the Machine Status button.
2. Select the Tools tab.
3. Select System Administrator’s Meter (Copy Jobs).

Tip
A second reset screen is not provided when resetting System Administrator’s Meter (Copy 
Jobs). Once you select Reset, Total Impressions are reset to 0 (zero) immediately.
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4. To reset, select Reset.

 Accounting Type

You can enable or disable the Account Administration feature and specify the types of jobs that 
require account management. 

Tip
The available Accounting Type selections depend on the Login Type setting used in 
Authentication/Security Settings > Authentication. As an example, if you select a Login Type of 
Login to Local Accounts in Authentication, then Local Accounting will automatically be 
selected in Accounting > Accounting Type and Accounting Disabled will be unavailable for 
selection.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Accounting.
3. Select Accounting Type.
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4. Select an Accounting Type:

• Accounting Disabled: The machine does not require a user login ID and password in 
order to operate it.

• Local Accounting: Enables the Account Administration feature. User registration can 
be performed using the touch screen or CentreWare Internet Services.

• Network Accounting: Performs account management using user information 
managed by an external accounting service on a network. User registration is 
performed by the external server. 

• Xerox Standard Accounting: Performs account management based on the users 
registered on the machine.

Note
It is important to remember that the available selections depend on settings made in 
Authentication/Security Settings > Authentication. Refer to Login Type on page 8-24 for 
additional information.

5. Once an Accounting Type is selected, additional choices are displayed. Available selections 
will vary depending on the Login Type set in the Authentication feature and the Accounting 
Type you selected. 
• Auditron Mode - Specify whether to perform account management for copy, print and 

scan services.
• Verify User Details - Specifies whether to verify user details. Select No to allow access 

without verifying the User ID and Account ID. The entered information is logged on 
the machine. Select [Yes] to verify user information and then select a For Printer Jobs 
option.



Accounting and Authentication/Security Settings

Xerox 4112/4127 Copier/Printer 8-15
System Administration Guide

• Customize User Prompt - Specifies the type of user information used for the Account 
Administration feature. Select from the following options: Display User ID and 
Account ID Prompts, Display User ID Prompt Only, Display Account ID Prompt 
Only, or Display No Prompts.

6. Select Save.

Notes
• Even if the Auditron Mode and Folder Access features are set to On, a login password is 

not required to operate the machine.
• For information about authentication on the machine and how it relates to the options 

here, refer to Authentication/Security Settings on page 8-20

Auto Reset of User Billing Information

This feature allows you to reset Billing Information on particular dates.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Accounting.
3. Select Auto Reset of User Billing Information.
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4. Select Off, Reset Every Year, Reset Every Quarter or Reset Every Month.

5. If you select Reset Every Year, Reset Every Quarter or Reset Every Month, you can then 
select the date the reset will occur.

6. Select Save.
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Copy Activity Report

Enabling this feature will automatically generate a printed usage report of an individual's 
completed Copier service session.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Accounting.
3. Select Copy Activity Report. 
4. Select Disabled, or Enabled. If you select Enabled, you have to option of adding the 

company name or other designation to the printed report. 
5. Touch the Company Name text bar to access the keyboard and type in the information 

that you want to display.

6. Select Save.
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Accounting Login Screen Settings

This feature allows you to change the UserID designation and mask or unmask the User ID 
displayed on the Touch Screen. The available options depend on Accounting Type and 
Authentication Login Type selections.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Accounting.
3. Select Accounting Login Screen Settings.

4. To change the UserID designation:
a. Select Alternative Name for UserID. 
b. Select Change Settings.
c. Enter a new User ID designation using the keypad.
d. Select Save.
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5. To Show or Hide the User ID:
a. Select Mask User ID (***).
b. Select Change Settings.

c. Select Show or Hide.
d. Select Save.
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Authentication/Security Settings
Authentication/Security Settings works in conjunction with the Accounting feature to provide 
additional security for your system. 

Overview

While the Accounting feature restricts local and remote access to Copy, Scan and Print features, 
Authentication/Security Settings restricts local and remote access to the Services area, which 
includes All Services, Job Status and/or Machine Status pathways.

• Authentication cannot be used unless Accounting is enabled in the Accounting Type menu.

• The Accounting settings determine which features are available in Authentication/Security 
Settings.

• Authentication/Security Settings are available to System Administrator accounts, only.

• Restrictions depend if the machine will be accessed locally using the control panel, or 
remotely using CentreWare Internet Services.

• Refer to Authentication Controlled Users on page 8-20 and Types of Authentication on 
page 8-21 for additional information.

Authentication Controlled Users

Authentication controls how users access features: Users are classified into the following six 
types. 

• System Administrators: These are users who can enter System Administrator mode and 
change the machine settings. A System Administrator uses a special user ID called a 
System Administrator ID. 

• Authenticated Users (with System Administrator Privileges): These are users who have 
System Administrator privileges.

When using a restricted service, this user must enter their user ID on the authentication 
screen.

• Authenticated Users (with Account Administrator Privileges): These are users who are have 
Account Administrator privileges.

When using a restricted service, this user must enter their user ID on the authentication 
screen.

• Authenticated Users: Users with no System Administrator or Account Administrator 
Privileges:

When using a restricted service, this user must enter their user ID on the authentication 
screen.

• Unauthenticated Users: Users who are not registered with the machine.

An Unauthenticated User cannot use restricted services.

• General Users: Users other than System Administrators in non-authentication mode.
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Types of Authentication

Three types of authentication are used depending on where user information is stored.

• Local Machine Authentication: Uses the user information registered for the Account 
Administration feature to manage authentication. You need, therefore, to enable the 
Account Administration feature when you use Local Machine Authentication. The print 
data sent directly from a computer can be received on the machine after being 
authenticated by cross-checking the authentication information pre-configured on a 
client’s print driver with the one registered on the machine.

• Remote Authentication: Uses a remote authentication server to manage authentication. 
User information is not registered on the machine.

Note
A registered user ID on the remote authentication server can be a maximum of 32 characters, 
and the password a maximum of 128 characters. For SMB authentication, however, the 
password can be a maximum of 32 characters.

• Xerox Secure Access: A system that uses a magnetic-card, IC-card, and biometrics systems 
for authentication. If prompted, users must enter their user information on the machine’s 
control panel.

System Administrator Settings

The System Administrator Settings menu is used to set the system administrator ID and 
passcode. A new Login ID and passcode is recommended to prevent users from making 
unauthorized changes and to ensure system security.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select System Administrator Settings.
4. Select.from:

• System Administrator’s Login ID on page 8-22
• System Administrator’s Passcode on page 8-22
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System Administrator’s Login ID

The System Administrator’s Login ID can be from 1 to 32 characters.

Note
The default system administrator Login ID is 11111.

1. Select System Administrator Login ID.
2. Select On.
3. Select Keyboard, then in New System Administrator Login ID, enter the system 

administrator ID, and select Save.
4. Select Keyboard once more, and in Re-enter System Administrator Login ID, enter the 

same system administrator ID, and select Save.
5. Select Save.

System Administrator’s Passcode 

Set the passcode for System Administration mode.The passcode is used to access the control 
panel when Passcode Entry from Control Panel is set to On. A passcode must be entered for 
local account login. However, a passcode must always be entered when accessing either 
remotely or from the network.

Tip
This is recommended for stronger security.

Note
The default setting of the system administrator passcode is x-admin.

The System Administrator’s Passcode appears in Authentication/Security Settings > System 
Administrator Settings. Set the password after setting the system administrator UserID. The 
passcode must be from 4-12 characters.

Note
For more about enabling and disabling passwords, refer to Accounting on page 8-2.
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1. Select System Administrator Passcode.

2. Select Keypad.
3. Select Keyboard to enter the new password from 4-12 numeric digits in New Passcode, 

and select Next.
4. In Re-enter Passcode, enter the same password, and select Save.

Note
To set no passcode, leave the passcode blank, and select Save.

Authentication

Use the Authentication menu options to setup the login, access control and user accounts. 

Accessing Authentication menu options
1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select Authentication.
4. Select the item to be registered or changed from the Features menu.
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Login Type

When a Login Type is selected, users are required to login to their accounts before accessing the 
Copy, Scan and/or Print services. The availability of these services is determined by machine 
configuration and System Administrator’s settings. The Login Type can be changed at any time 
to fit your needs.

1. Logon as System Administrator and select Machine Status.
2. Select the Tools tab.
3. Select the Authentication/Security Settings menu.
4. Select Login Type from the Authentication menu.

5. Select from the following options:

No Login Required

The user does not require a login to access services.

Login to Local Accounts

This is the direct operation of the machine from the control panel. If you choose this option and 
select Save, “Local Accounting” will be automatically activated to enable this machine to track 
the account usage of the respective login users. 

When using Login to Local Accounts, you can also limit device access to All Services, Job Status 
and Machine Status pathways.

The Account Administration feature must also be enabled when using Login to Local Accounts. 
The print data sent from a computer is received on the machine after being authenticated by 
cross-checking the authentication information pre-configured on a client’s print driver with the 
one registered on the machine.
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Login to Remote Accounts

This is the operation of the machine through a network using CentreWare Internet Services. 
Login to Remote Accounts uses a remote authentication server to manage authentication. No 
user information is registered on the machine.

The functions restricted by Remote Access are as follows:

• Printing is limited to print jobs sent from a computer.

• To use the Account Administration feature, use the print driver to set account information 
such as user ID and passcode.

• If authentication using account information fails for a print job, the print data will be either 
saved in the machine or deleted depending on the Charge Print settings.

Note
Printing is not limited when the Login Type is set to Remote Access in System Administrator 
mode.

• If the Authentication feature is enabled, authentication is required to access the 
CentreWare Internet Services home page even if you are not using the Authentication 
feature for any service.

Create/View User Accounts and Reset User accounts are made unavailable once you enable 
Login to Remote Accounts.

If you choose this option and select Save, accounting will be automatically disabled. However, 
job log will be kept instead.

Note
A registered user ID on the remote authentication server can be a maximum of 32 characters, 
and the password a maximum of 128 characters. For SMB authentication, however, the 
password can be a maximum of 32 characters.

You will prompted to confirm your selection. Be sure to review the changes that will occur once 
Login to Remote Accounts is enabled. Select Yes to enable Login to Remote Accounts.
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Xerox Secure Access

A system that uses a magnetic-card, IC-card, and biometrics systems for authentication. If 
prompted, users must enter their user information on the machine’s control panel.

If you choose this option and select Save, accounting will be automatically disabled. However, 
job log will be kept instead.

You will prompted to confirm your selection. Be sure to review the changes that will occur once 
Login to Remote Accounts is enabled. Select Yes to enable Xerox Secure Access.

Access Control

Lock or unlock the Device Access, Service Access or Feature Access.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select the Authentication menu.
4. Select Access Control.
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5. Select from Device Access, Service Access or Feature Access: 
• Device Access: This determines the access allowed for pathway selections from the 

control panel, as indicated by the outlined buttons in the below graphic. 

• Select Lock or Unlock pathways and select Save.
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• Service Access

a. Select the service that you want to change and then select Change Settings.

b. Select and option and then select Save.

Note
If you are using local Authentication, the Unlock option is not available.
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• Feature Access:

a. Select the service that you want to change and then select Change Settings.

b. Select an option and then select Save.
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Create/View User Accounts
Note
Creating and viewing user accounts within Authentication is a similar procedure to creating and 
viewing user accounts in Accounting. 

Refer to Chapter 8 Creating/Viewing User Accounts on page 8-2.

Reset User Accounts
Note
Resetting user accounts within Authentication is a similar same procedure to resetting user 
accounts in Accounting.

Refer to Chapter 8 Resetting User Accounts on page 8-8.

Create Authorization Groups
Note
Resetting user accounts within Authentication is a similar same procedure to resetting user 
accounts in Accounting.

Refer to Chapter 8 Types of Authentication on page 8-21.

User Details Setup

This feature allows you to configure the settings for user ID authentication. The available 
settings depend on the authentication type selected at Authentication > Login Type.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select Authorization.
4. Select User Details Setup.
5. The User Details Setup menu options that display will depend on the type of 

Authentication that is enforced; Login to Local Accounts, Login to Remote Accounts, or 
Xerox Secure Access. Available options depend on the Login Type selected. From the User 
Details Setup screen, select from the displayed options:
• Mask User ID (***) on page 8-30
• Failed Access Log on page 8-31
• Display Login Status on page 8-31
• Display Login Status on page 8-31
• User ID for Login on page 8-31

Mask User ID (***) 

Sets how the User ID is displayed during input. To change the setting, select Change Settings 
and then select from the following:

• Show: As you enter the UserID, the characters are echoed on the screen in the normal 
way.

• Hide: As you enter the UserID, the character string is hidden as a row of asterisks (*****).
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Failed Access Log

If the number of times that authentication fails within a set time exceeds the Failed Attempts 
value set here, then an error is logged. You can set the failing times within the range from 1 to 
600. To enable the setting:

• Select Change Settings.
• Select On.
• Using the controller keypad, enter the maximum number of system consecutive access 

attempts that will be allowed before it is logged as an error.
• Select Save.

Display Login Status

This option allows you to enable the Login Status to be displayed in the top right corner of the 
screen. 

• Select Enabled
• Select Disabled

Logout Confirmation Screen

This option allows you to enable a confirmation screen when users logout. 

• Select Change Settings.
• Select Enabled.
• Select Save.

User ID for Login 

You can set the User ID for Login to be Non-case Sensitive. The default setting is Case Sensitive.

• Select Change Settings
• Select Non-Case Sensitive.
• Select Save.
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Maximum Login Attempts

You can set the number of attempts a person is allowed to enter the same System 
Administrator's Login ID after which access to the system will be disabled.

Set the number of authentication attempts allowed between 1-10.

Note
The count is reset when the machine is restarted.

Note
To cancel the access rejection, shut down the machine by switching off the power and switching 
it on again.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select Authentication > Maximum Login Attempts by System Administrator.
4. Select from:

• Unlimited Attempts
• Limit Attempts: Enter a number from 1-10 using the  and and then select Save.

Passcode Policy

When On is selected, a passcode must be entered for local account login.

However, a passcode must always be entered when accessing either remotely or from the 
network.

1. Logon as System Administrator and select the Machine Status button.
2. From the Tools tab, select Authentication/Security Settings.
3. Select Authentication.
4. Select Passcode Policy.
5. Select Change Settings.
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6. Select Off or On.
• Off: A password is not required even if the password is set by System Administrator’s 

Passcode, Creating/Viewing User Accounts on page 8-2.
• On: Setting of System Administrator’s Passcode on page 8-22, Creating/Viewing User 

Accounts on page 8-2 becomes enabled and functional. Use a password when the 
control panel asks for it.

7. Select Save.

Tip
The setting of Password Entry from Control Panel applies to functions occurring on the 
machine. If you are using CentreWare Internet Services (or other external access), a password 
is ALWAYS required regardless of the password settings on the machine. Furthermore, a 
password may be required depending on authentication methods set on the machine.

Note
The system administrator password is also used to change settings from CentreWare Internet 
Services.

Charge/Private Print Settings

Set how received print jobs should be handled.

1. Logon as system Administrator and select Machine Status.
2. From the Tools tab, select Authentication/Security Settings.
3. Select Authentication.
4. Select Charge/Private Print Settings.
5. Select the item to be set, and select Change Settings.
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6. Select from the displayed options:

Receive Control

When using the authentication feature, set how to handle print jobs for which authentication 
failed (the print driver did not provide the correct UserID, password, and other authentication 
information). The available options depend on your selection of According to Print Auditron, 
Save in Private Charge Print, or Save in Charge Print. 

• According to Print Auditron - The receiving control depends on the Authentication setting 
made on the machine. 

When According to Print Auditron is selected, the Job Login Success, Job Login Failure, 
and Job without User ID options are displayed.

• Save in Private Charge Print: Saves jobs with incorrect User ID in Private Charge Print. 

When selected, the Job without User ID is also displayed.

• Save in Charge Print: Saves jobs in Charge Print. Unwanted jobs should be discarded on a 
regular basis. When enabled, this feature allows you to print or delete documents stored for 
each billing user ID.

Select how jobs will be handled when they are sent with invalid authentication or no 
UserID:

• Job Login Success: Available when According to Print Auditron is selected, only. Specifies 
how to treat print jobs when user ID or passcode authentication is successful.

– Print Job 

– Save in Private Charge Print

• Jobs Login Failure: Available when According to Print Auditron is selected, only. Specifies 
how to treat print jobs when user ID or passcode authentication fails.

– Save in Charge Print: 

– Cancel Job: Received jobs are deleted.
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• Jobs without User ID: Available when According to Print Auditron and Save in Private 
Charge Print is selected, only. Specifies how to treat jobs without a user ID (such as email 
print jobs). Select from:

– Print Job 

– Save in Charge Print 

– Cancel Job

Allow User to Disable Active Settings

This feature allows privileged users to temporarily disable certain active settings such as Force 
Watermark, Universal Unique ID that have been enabled by the System Administrator to be 
applied to all jobs.

Select Disable Active Settings to temporarily disable the active settings before running a job.

Return to this screen and select Enable Active Settings at the end of your job. Otherwise the 
settings automatically become active when a job session is ended and logged out.” 

• Enable Active Settings 
• Disable Active Settings

Job Status Default

In Job Status Default the System Administrator can set the view default settings for the Active 
Jobs view and the Completed Jobs view.

1. Logon as System administrator and select Machine status.
2. Select the Tools tab.
3. From the Authentication/Security Settings screen, select Job Status Default.
4. Select the item to be changed.

• Active Jobs View on page 8-36
• Completed Jobs View on page 8-36
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Active Jobs View

The system administrator can set the default view of the active jobs.

1. Select Active Jobs View.

2. Select Yes or No to hide the details.

Completed Jobs View

The system administrator can set the default view of the completed jobs.

1. Select Completed Jobs View.
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2. Set the defaults for the Completed Jobs view.
• Allow Job Viewing at All Times: Allows all users to view the details of completed jobs. 

Select Yes or No from Hide Job Details.
• Require Login to View Jobs: Allows only authenticated users to view the details of 

completed jobs.

– From the Access To menu, select from:

– All Jobs: You can also select Yes or No from Hide Job Details.

– Jobs Run By Login User Only: Display only the jobs of authenticated users.

– From the Hide Job Details menu, select from Yes or No.
• No Job Viewing: Does not allows any users to view the details of completed jobs.

Overwrite Hard Disk (optional)
Tip
This is an optional feature that may not be available on your copier/printer; it is part of the 
optional Data Security Kit. For more information, contact the Customer Support Center.

The Overwrite Hard Disk feature forces any temporary image files (that are created during a 
copy, scan, fax, scan-to-email, or print job) to be overwritten when those files are no longer 
needed during processing or are overwritten at point of need. If this option is available on your 
machine, you can select whether or not to perform a hard disk overwrite process. If this option 
is on, you can specify the specific number of times to perform the overwrite process.

After deleting data from the hard disk, the area on the hard disk where the data was stored is 
overwritten. This prevents unauthorized retrieval or restoration of the previously recorded 
data. This applies to files and other information stored temporarily by the system.

Tip
• A service representative can block changes to the settings of this feature. For more 

information, refer to Service Representative Restricted Operation on page 9-85.
• If the machine is powered off during the overwriting process, some files may remain on the 

hard disk.

Note
• The data on the hard disk is erased by overwriting it one time. However, overwriting the 

data three times ensures that the data cannot be recovered. The three times overwrite 
process does take a longer amount of time to perform than the one time overwrite process.

• During the overwriting process, normal operations may run slower than normally.

The following procedures set the default number of overwrites and specify a scheduled time to 
perform the overwrite procedure.
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Number of Overwrites

This option allows administrators to specify the exact number of allowed hard disk overwrites. 
Perform the following steps:

1. Enter the System Administration mode (Chapter 1 Entering the System Administrator mode 
on page 1-10).

2. Press the Machine Status button on the Control Panel.
3. Select the Tools tab.
4. Select Authentication/Security Settings.

5. Select Overwrite Hard Disk.
6. Select Number of Overwrites.

7. Select the desired number of overwrites.
8. Select Save.
9. Exit the System Administration mode.
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Scheduled Image Overwrite

This option allows administrators to specify how frequently (daily, weekly, or monthly) the 
overwrite hard disk process should occur. The Scheduled Image Overwrite feature may also be 
disabled. Perform the following steps:

1. Enter the System Administration mode (Chapter 1 Entering the System Administrator mode 
on page 1-10).

2. Press the Machine Status button on the Control Panel.
3. Select the Tools tab.
4. Select Authentication/Security Settings.

5. Select Overwrite Hard Disk.
6. Select Scheduled Image Overwrite.

7. Select the desired Scheduled Image Overwrite option.
8. Select Save.
9. Exit the System Administration mode.
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Accounting and Authentication using 
CentreWare Internet Services
CentreWare Internet Services enables you to display, configure and change settings of the 
machine by using a web browser instead of the machine’s control panel. 

A System Administrator can manage how users access the machine by selecting from similar 
accounting and authentication accounting that are available through the control panel. 

• Accounting using CentreWare Internet Services on page 8-40
• Authentication/Security Settings using CentreWare Internet Services on page 8-45

Accounting using CentreWare Internet Services

The available options depend on your machine configuration.

• Accounting Disabled

• Accounting Disabled (Keep Log)

• Local Accounting: Account administration is performed using the user information 
registered on the machine.

• Network Accounting: Account administration is performed using the user information 
registered by a remote server.

• Xerox Standard Accounting: Account administration is performed based on the user and 
account information pre-registered on the machine.

Xerox Standard Accounting

When enabled, Xerox Standard Accounting (XSA) tracks the numbers of Copy, Print, Network 
Scanning, and E-mail jobs for each user. Usage limits can also be applied to restrict the total 
number of copy, print, and scan jobs that a user can perform. Administrators can print a report 
which contains all XSA data.

• Administrators must create accounts and specify limits before users are authorized to 
access the machine.

• When using XSA, users must login at the machine to use the device. 

• When XSA is enabled, users must enter their account details in the print driver to print 
documents from workstations.

The XSA feature is mutually exclusive from any other accounting feature. If XSA is enabled at 
the device:

• You cannot enable Foreign Device Interface, Auditron or Network Accounting.

• Each device supports unique XSA User IDs and Group Accounts.

• All user IDs must be assigned to one or more group accounts.

Note
The XSA settings and account data are stored in the machine. It is strongly recommended that 
you back up the settings and data regularly.

Enabling Accounting and Setting User Account Options
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You can perform the following accounting options form within the Accounting Configuration 
screen of CentreWare Internet Services:

• Enabling Accounting on page 8-41
• Setting User Account Options on page 8-42

Enabling Accounting

At your workstation:

1. Open your web browser and in the Address bar, enter the machine’s TCP/IP address.
2. Select the Properties tab.
3. From the left pane of the screen, expand the Accounting folder and select Accounting 

Configuration.
4. Login as System Administrator. The default User Name is 11111 and the default passcode 

is x-admin.
5. From the Accounting Type menu, select from:

• Local Accounting
• Network Accounting
• Xerox Standard Accounting

Note
The available options depend on machine configuration.

6. Select Apply and follow any prompts.
• Local Accounting: You are required to reboot the machine for local settings to take 

affect.
• Network Accounting: TBD
• Xerox Standard Accounting: If you are changing the Accounting Type, only, and you 

select Apply, a warning displays. Review the warning before continuing.

7. For each service, select the type of account management to perform by placing a 
checkmark in the Enabled box. For example, if you want to enable account management to 
the Print Service, place a checkmark in the Enable box of Auditron (Print Service). 

8. Verify User Details: Specify whether to verify user details upon user authentication. This 
item becomes active only when the Accounting Type is set to Network Accounting.
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9. Verify User Details for Printer Jobs: Specify whether to check user details upon user 
authentication for print jobs. This item becomes active only when the Accounting Type is 
set to Network Accounting.

10. Customize User Prompts: Specify whether to prompt entry of both a User ID and an 
Account ID or only a User ID or an Account ID upon authentication. This item becomes 
active only when the Accounting Type is set to Network Accounting.

11. Select from the following:
• Select the Next button to access individual account settings. 
• Select Apply and follow any prompts to enable the changes you made.

Setting User Account Options
12. Within Step 2 of the Authentication Configuration screen, enter the user account number 

whose settings you want to adjust.
13. Select Edit to change settings.

14. At the User Account Settings screen, you can set User Identification, Feature Access, 
Impressions/Limits and User Role.
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15. Enter a User Name of up to 32 characters.
16. Enter and reenter a passcode of 4 to 12 alphanumeric characters.
17. Card ID: Enter the card ID for the user.
18. From the Feature Access section, you can select from Free Access or No Access to a 

particular service. As an example, you may want to allow a user access to the Print Service, 
but deny access to the Copy and Scan Services.

19. In the Impressions/Limits section, you can set the maximum number of impressions that 
the user is allowed.within the range of 0 to 9999999.
• Black Copy Limit: Set the maximum number of impressions allowed for Black and 

White copying.
• Color Scan Limit: Set the maximum number of impressions allowed for color scanning.
• Black Scan Limit: Set the maximum number of impressions allowed for Black and White 

scanning.
• Black Print Limit: Set the maximum number of impressions allowed for Black and White 

printing.
20. Select the User Role of the user account from System Administrator, Account Administrator 

or User.
21. To enforce settings, select Apply. 
22. Reboot the machine.
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Accounting Login Screen Settings

This feature allows you to set an alternative login name which the user sees on the login screen 
and to mask the user ID during login. 

At your workstation:

1. Open your web browser and in the Address bar, enter the machine’s TCP/IP address.
2. Select the Properties tab.
3. From the left pane of the screen, expand the Accounting folder and select Accounting 

Login Screen Settings.
4. If required, login as System Administrator. The default User Name is 11111and the default 

passcode is x-admin.
5. In the Alternative Name for User ID field, enter an alternative name. As an example, you 

can change the default setting to User Login.
6. Determine if you want to mask the User ID when it is entered by the user. If you select 

Hide, the User ID is not displayed when entered.
7. Select Apply to enable any changes and follow any prompts.
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Authentication/Security Settings using CentreWare Internet 
Services

This feature allows you to select the login type that will be required by machine users. You can 
select from:

• No Login Required
• Login to Local Accounts
• Login to Remote Accounts
• Xerox Secure Access

You can also set user account options using this feature.

Enabling Authentication 

At your workstation:

1. Open your web browser and in the Address bar, enter the machine’s TCP/IP address.
2. Select the Properties tab.
3. From the left pane of the screen, expand the Security folder and select Authentication 

Configuration.
4. Login as System Administrator. The default User Name is 11111 and the default passcode 

is x-admin.
5. Select a Login Type.

6. Select Enabled if you want to allow Folder to PC/Server.
7. Select Enabled in Non-account Print if you want to allow printing to those without an 

account on the machine.
8. If you want to allow Guest Users: 

a. Select On. 
b. Enter and reenter the Guest Passcode.
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9. Select Apply and follow any prompts.
• If you select Login to Local Accounts, you will be prompted to reboot the machine. 
• If you select Login to Remote Accounts or Xerox Secure Access, you will receive a 

warning prompt. Review the prompt before continuing.
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9Setups

The machine has factory default (initial) settings which can be customized. To change the 
settings, enter the System Administration mode and use the System Settings screen. This 
chapter describes how to change system settings.

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your system. The UI screens vary from system to system and from marketplace to 
marketplace. Therefore, the UI screens in this guide are a representation of the type of screens 
that may be seen on your particular system.

System settings procedure 
This section describes the basic procedure for changing system settings. To make or change the 
system settings, it is necessary to be in System Administration mode. 

1. Enter the System Administration mode (Chapter 1 Entering the System Administrator mode 
on page 1-10). 

2. From the System Settings screen, select a group. 

Note
For the items that can be selected in the system settings, refer to System Settings on page 
12-1.

3. Select a feature. After setting the feature, select Save.
4. Exit the System Administration Mode: (Chapter 1 Exiting the System Administrator mode 

on page 1-11)
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System Settings

From System Settings, you can set or change the initial values. The system settings features 
include:

Common Service Settings: These settings relate to the machine itself.

Copy Service Settings: You can set the copy feature defaults, copy operation control, button 
functions, and so on.

Connectivity & Network Setup: You can set the ports, protocols, and so on.

Print Service Settings: You can set the memory settings, print time operation, and so on.

Scan Service Settings: You can set the scanner feature defaults, button functions, and other 
items.

E-mail Service Settings: You can set the e-mail feature defaults, address search, and so on.

Folder Service Settings: You can set the folder service settings, and so on.

Folder Service Settings: You can set and modify the folder settings.

Job Flow Service Settings: You can set and modify the Job Flow settings.

Stored Document Settings: Documents stored in the folder can be set.

Network Controller Settings: You can select and set the following network controller features:

• Ethernet Rated Speed
• TCP/IP - IP Address
• TCP/IP - Subnet Mask
• TCP/IP - Gateway Address
• Frame Type
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Setup Menu

From the Setup Menu, you can create folders, create and change the addresses in the address 
book, assign paper tray attributes, create job flow sheets/keywords, and Stored 
Programming. For more information, refer to Setup Menu on page 9-157.

Accounting

You can set restrictions on users using specific machine features, or set restrictions on individual 
users. For more information, refer to Accounting on page 8-2.
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Authentication/Security Settings

You can set the system administrator ID and system administrator password used to enter 
System Administration mode. For more information, refer to Authentication/Security Settings 
on page 8-20.

System Settings Menu List
To view a table showing a list of the items that can be set, refer to System Settings on page 12-
1.

Entering Text
During operations, a screen sometimes appears for the entry of text. To see a description on 
how to enter text using the screen keyboard, refer to Entering Text on page 12-8.
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Common Settings
In Common Settings, you select default settings that affect the machine itself.

1. From the System Settings screen, select Common Settings.

Note
To display the System Settings screen, refer to System settings procedure on page 9-1.

2. Select the item to be set.
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Machine Clock/Timers

You can set the clock time, or the timer interval until power saving or reset features take effect.

1. Select Machine Clock/Timers.

2. From the Machine Clock/Timers screen, select the item to be set or changed.

3. Select Change Settings.
4. Follow the screen directions to change the settings.
5. Select Save.
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Date

Set the date in the in the system clock of the machine. The date set here is printed on lists and 
reports.

1. From the Machine Clock/Timers screen, select Date, and select Change Settings.

2. Select the date format.
3. Select Year/Month/Day by using the , , or the numeric keypad to enter a numeric 

quantity.
4. Select Save to save the settings and return to the previous window.

Time

Set the time in the system clock of the machine, using 12-hour or 24-hour representation. The 
time set here is printed on lists and reports.

1. From the Machine Clock/Timers screen, select Time, and select Change Settings.

2. Select the display format.
3. When 12 Hour Clock is selected, select AM or PM.
4. Set the minutes and seconds by using the , , or the numeric keypad to enter a numeric 

quantity.
5. Select Save to save the settings and return to the previous window.



Setups

9-8  System Administration Guide
Xerox 4112/4127 Copier/Printer

NTP Time Synchronization

You can get the time from a time server (NTP: Network Time Protocol), to synchronize the 
machine to the time server time.

1. From the Machine Clock/Timers screen, select NTP Time Synchronization, and select 
Change Settings.

2. Select On or Off.
3. Select Save to save the settings and return to the previous window.

Connection Interval

Select the time interval at which a connection is made to the time server.

Select an interval from 1 to 500 hours, in steps of one hour.

1. From the Machine Clock/Timers screen, select Connection Interval, and select Change 
Settings.

2. Enter the Connection Interval using the numeric keypad.

3. Select Save to save the settings and return to the previous window.
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Time Server Address

This is used to enter the IP address for the time server.

Note
Set the NTP Time Synchronization to on.

1. From the Machine Clock/Timers screen, select Time Server Address and press Change 
Settings. 

2. Enter the IP address:
• IP Address: Set the IP address of the time server from which the time is obtained, 

using values 0 to 255.

Note
• Addresses 244 to 255.XXX.XXX.XXX and 127.XXX.XXX.XXX cannot be set.
• Select Next to enter the next part of the IP address if the address between dots is less 

than 3 digits.
3. Select Save to save the settings and return to the previous window.

Auto Clear

If a given time period elapses with no operation, the machine automatically returns to the 
initial screen.

Set a period from 1 to 4 minutes, in intervals of 1 minute. To cancel the setting select C, or select 
the Cancel button to delete any selections made on this screen.

Note
Even if Off is selected, any currently scanned and pending jobs continue processing after one 
minute of inactivity on the machine.
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1. From the Machine Clock/Timers screen, select Auto Clear and press Change Settings. 

2. Select Off or On.
3. If you selected On, set the time by using the , , or the numeric keypad to enter a 

numeric quantity.
4. Select Save to save the settings and return to the previous window.

Auto Job Release

If an error occurs during a copy or scan job, you can set the time that elapses until the current 
job is automatically cleared, and thereby enabling the completion of the next job. Errors that 
may occur include a paper feed, a jammed original, a copy jam, running out of hard disk space, 
etc. Once the current job is cleared, jobs that can be continued are limited to those that only 
use parts of the machine not affected by the error.

Set the value in the range 4 to 99 minutes, in 1 minute increments. Select Off if you do not 
want to use this feature.

1. From the Machine Clock/Timers screen, select Auto Job Release, and select Change 
Settings.

2. Select Off or On.
3. If you selected On, set the time by using the , , or the numeric keypad to enter a 

numeric quantity.
4. Select Save to save the settings and return to the previous window.
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Auto Print

Set the time from the end of print job until the execution of next print job. Set the value from 1 
to 240 seconds, in one second steps. If you select Off printing can start immediately, once the 
machine is ready.

1. From the Machine Clock/Timers screen, select Auto Print, and select Change Settings.

2. Select Off or On.
3. If you selected On, set the time by using the , , or the numeric keypad to enter a 

numeric quantity.
4. Select Save to save the settings and return to the previous window.

Printer Lockout Duration

Set the time from the start to the end of printer lockout. Set the values from 0 to 23 hours and 
to 59 minutes. If you select Off no printer lockout occurs.

1. From the Machine Clock/Timers screen, select Printer Lockout Duration, and select 
Change Settings.

2. Select Off or On.
3. If you selected On, set the time by using the , , or the numeric keypad to enter a 

numeric quantity.
4. Select Save to save the settings and return to the previous window.
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Power Saver/Energy Saver Timers

In power saving mode, there is a “low-power mode” and a “sleep mode,” and when the set time 
has elapsed, the following occurs:

Last operation on the machine  Low-power mode  Sleep mode

1. From the Machine Clock/Timers screen, select Power Saver/Energy Saver Timers, and 
select Change Settings.

2. Set low-power mode and sleep mode.
• From Last Selection to Low Power Mode: Set the time to go from last operation to low-

power mode. Set the time from 1 to 240 minutes, in 1 minute increments.

Note
The time From Last Operation to Low-power Mode must not exceed the time From Last 
Operation to Sleep Mode.

• From Last Selection to Sleep mode: Set the time to go from last operation to sleep 
mode from 1 to 240 minutes, in 1 minute increments.Disabled.

Time Zone

Use the ,  to set the time difference from Greenwich Mean Time (GMT).

Select Save to save the settings and return to the previous window.
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Daylight Savings

With this feature enabled, the machine automatically adjusts the current time when the 
summer time starts and ends.

Adjust off

Select this feature if you do want to use the Daylight Savings feature.

Adjust by Month, Day & Time

Select this feature to specify the start of the daylight savings feature, by month, day and time.

Adjust by Month, Week, Day of Week & Time 

Select this feature to specify the start of the daylight savings feature, by month, week, day of 
the week and time.

Audio Tones

Select whether or not to sound an alarm, for example when a job ends or there is a fault.

1. From the Common Settings screen, select Audio Tones.
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The Audio Tones screen opens.

2. Select the item to be set or changed.

Note
Select  to display the previous screen and select  to display the next screen.

3. Select Change Settings.
4. Select the desired setting for the specific Audio Tone feature.

5. Select Save.

Control Panel Select Tone

Select the volume level that sounds when a button displayed on the screen is correctly 
selected. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Control Panel Alert Tone

Select the volume level that sounds when a non-functioning (or grayed-out) button is selected 
or when an error occurs. Select from Loud, Normal, and Soft. To disable the sound, select Off.
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Base Tone

For a button that toggles (the setting changes each time it is pressed), select the volume level 
that sounds when the button is in its initial (first) position. This is the sound made when the 
Interrupt button is released. Select from Loud, Normal, and Soft. To disable the sound, select 
Off.

Machine Ready Tone

Set the volume level that sounds when the machine is ready to copy or print or after the 
machine powers on. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Note
It is possible to set targeted jobs, such as, Copy Jobs, Printer Jobs, Report Jobs, and so-on, from 
the Job Complete Tone 1, Job Complete Tone 2, and Fault Tone screens.

Job Complete Tone 1

Select the volume level that sounds when the machine successfully completes the copy 
cycle. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Job Complete Tone 2

Select the volume level that sounds when the machine completes a job other than a copy 
job. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Fault Tone

Select the volume level that sounds when there is an error termination. Select from Loud, 
Normal, and Soft. To disable the sound, select Off.

Auto Clear Alert Tone

Select the volume level that sounds when the automatic clear feature is enabled and it is 5 
seconds before the machine automatically returns to the initial screen. Select from Loud, 
Normal, and Soft. To disable the sound, select Off.

Alert Tone

Select the volume level that sounds when a fault, such as a paper jam occurs, and the fault is 
left unattended. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Out of Paper Warning Tone

Select the volume level that sounds when there is no paper in the paper tray and the job is left 
unattended. Select from Loud, Normal, and Soft. To disable the sound, select Off.

Low Toner Alert Tone

Select the volume level that sounds when it is time to replace the drum toner cartridge. Select 
from Loud, Normal, and Low. To disable the sound, select Off.
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Stored Programming Tone

Select the volume level that sounds while the machine is records a job into the job 
memory. Select from Loud, Normal, and Soft.

Note
It is not possible to disable this sound.

Screen/Button Settings

Set the initial screen display when the power is turned on.

1. From the Common Settings screen, select Screen/Button Settings.

The Screen/Button Settings window opens.

2. Select the item to be set or changed.
3. Select Change Settings.
4. Select the desired setting for the specific Screen Defaults feature.
5. Select Save.
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Screen Default at Power On

You can assign the screen default when the machine powers on (Services, Job Status, or 
Machine Status).

1. From the Screen/Button Settings window, select Screen Default at Power On, and select 
Change Settings.

2. Select the desired screen default.

3. Select Save.

Service Screen Default 

You can assign the Service Screen default.

1. From the Screen/Button Settings window, select Service Screen Default, and select 
Change Settings.

2. Select the desired screen default.

3. Select Save.
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Service Screen After Auto Clear

You can assign the Service Screen after auto clear.

1. From the Screen/Button Settings window, select Service Screen After Auto Clear, and 
select Change Settings.

2. Select the desired screen default.

3. Select Save.

Auto Display of Login Screen

You can display the login screen automatically.

1. From the Screen/Button Settings window, select Auto Display of Login Screen, and select 
Change Settings.

2. Select On or Off.

3. Select Save.
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All Services

From this screen, you can select the specific buttons and their layout as they will appear on the 
All Services screen when the All Services button on the control panel is pressed.

Note
It is not possible to assign the same feature to more than one button.

1. From the Screen/Button Settings window, select All Services.
2. Select Change Settings.

The All Services window opens:

Note
Select  to display the previous screen and select  to display the next screen.

3. Select a feature that you will want displayed on the All Services screen (when the All 
Services button on the control panel is pressed). For the purpose of this feature, the Copy 
feature is selected.
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4. The Main Feature Selection window opens. Select the desired feature that you want 
displayed on the All Services screen of the UI.

5. Select Save.
6. Repeat Steps 1-6 for the other All Services features.

All Services - Screen Default

From this screen, you can select whether or not the All Services Screen displays a functional 
description of the button selected.

1. From the Screen/Button Settings window, select All Services - Screen Default and select 
Change Settings.

2. The All Services - Screen Default window opens. Choose the Select Services Without OK 
or Explain Service then Press OK.
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3. If the Select Services Without OK is chosen, then the all Services Screen will display as 
shown below.

4. If the Explain Service then Press OK is chosen, then the all Services Screen will display as 
shown below.

5. Select Save.

Job Type on Job Status screen

Select the job types that you want displayed on the Completed Jobs screen of the Job Status 
screen when the Job Status button on the control panel is pressed.

1. From the Screen/Button Settings window, select Job Type on Job Status Screen and 
select Change Settings.
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2. Select from All Jobs, Printer & Print from Folder Jobs, Scan, Fax, & Internet Fax Jobs, and 
Job Flow & Auto File Transfer Jobs.

3. Select Save.

Default Language screen

Select the defaulted language that you want displayed on the machine’s UI screen.

1. From the Screen/Button Settings window, select Default Language and select Change 
Settings.

2. From the Default Language window, select either English or Japanese.
3. Select Save.

Reconfirm E-mail Recipient screen

Select whether, and when an email recipient reconfirmation is to occur from the Reconfirm E-
mail Recipient screen.

1. From the Screen/Button Settings window, select Reconfirm E-mail Recipient and select 
Change Settings.

2. Select from Confirmation not Required, Always Reconfirm Recipient, and Reconfirm if 
Multiple Recipients.

3. Select Save.
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Customize Keyboard Button

Select this option for frequently used information (e.g. domain names, IP addresses, or other 
related data) to create a customized button on the UI keyboard screen.

Note
You can customize one button only, not multiple buttons.

1. From the Customize Keyboard Button screen, select Change Settings.
2. Enter in your desired information that will appear on the customized button (e.g. “.com”, or 

“john.doe@xerox.com”).
3. Press the Preview button to see the selection displayed on the customized button, located 

in the lower, RIGHT corner of the keyboard screen.
4. Press Save.

Paper Tray Settings

Set the items relating to the paper and trays, including the types of paper loaded in each tray, 
the priority order of the trays, the priority order of the paper types, custom paper information, 
and more.

1. From the Common Settings screen, select Paper Tray Settings.

The Paper Tray Settings screen opens.
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2. Select the item to be set or changed.
• Make the appropriate selections or changes to that item.
• Select Save to return to the Paper Tray Settings screen.

3. Repeat Step 2 for each of the specific Paper Tray Settings features.
4. Select Close to return to the Common Settings screen.

Custom Paper Name/Color

You can set a custom name for paper 1-5 (refer to the screen in Step 1 of the following 
procedure). A maximum of twelve characters can be entered for each custom paper name. For 
example, use the name “Color” for colored paper.

Note
For information about entering text, refer to Entering Text on page 9-4.

1. From the Paper Tray Settings screen, select Custom Paper Name/Color feature.
The Custom Paper Name/Color screen opens.

2. Select the item to be set or changed, and select Change Settings.
3. The Keyboard screen opens.

4. Enter the desired name for Custom Paper 1.
5. Select Save to save the name and return to the previous screen.
6. If desired, repeat Steps 1-5 for the other custom paper types and custom paper colors.
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7. Select Close to return to the Paper Tray Settings screen.

Paper Tray Attributes

Select the paper size and paper type that will be loaded in trays 1-4, tray 5 (Bypass) and 
optional trays 6 and 7.

1. From the Paper Tray Settings screen, select Paper Tray Attributes.
2. Select the item to be set or changed, and select Change Settings.

3. Select Change Settings.
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Paper Size

Standard-sized paper that is loaded into trays 3, 4, and optional trays 6 and 7 is automatically 
detected. However, when a nonstandard size is loaded, it is necessary to specify the width and 
height.

Tip
Depending on the paper size, the guide lever may not fit, and this may cause paper jams or 
other errors. Tray detection may also not be possible. In such cases, use tray 5 (Bypass Tray).

Note
Trays 1 and 2 are preset at manufacturing at size 8.5 x 11 in. (A4); therefore, the paper size for 
these two trays cannot be changed on this screen.

Paper Type
The Paper Type feature is discussed in Step 3. on page 9-27

1. When selecting Paper Size, select Auto Size Detect or Custom Size (Trays 3, 4, 6, and 7 
only).

Tip
Remember: You cannot select or set the Paper Size for Trays 1 and 2.

2. When Custom Size is selected, enter the paper size using , , , and .

Auto Size Detect

Standard-sized paper loaded in trays 3, 4, and optional 6 and 7 is automatically detected.
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Custom Size

When setting a non-standard size for trays 3 and 4, set the size in the X (horizontal) direction 
within the range of 182-488 mm (7.17-19.21 in.) and in the Y (vertical) direction within the 
range 148-330 mm (5.82-13 in.) in 1 mm increments. For optional trays 6 and 7, set the size in 
the X direction within the range 210-241 mm (8.26-9.48 in.) and in the Y direction within the 
range 297-330 mm (11.69-12 in.) in 1 mm increments.

1. From the Paper Size screen, select Save to save the paper size and return to previous 
screen.

2. Select either Paper Type or Save.
• If you select Save, you are returned to the Paper Tray Attributes screen. Proceed to 

Step 7. on page 9-25
• If you select Paper Type, proceed to the next step.

3. When selecting Paper Type, keep the following in mind:
• For trays 1, 2, and optional 6 and 7 you can select from six paper types and from 

custom paper types 1-5.
• For trays 3 and 4 you can select from seven paper types, and from custom paper types 

1-5.
• In tray 5 (Bypass) you can select from eleven paper types and from custom paper types 

1-5.
• If the optional OHCF (tray 6) is installed, an additional Paper Type option, Coated 

Stock is available.

a. Select the desired Paper Type for this specific tray. (For this procedure, Tray 4 is 
shown.)

b. Select Save to save the Paper Type and return to the previous screen.
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4. Set the attributes for other trays as desired.

5. Select Close to return to the Paper Tray Settings screen.

Customize Paper Supply Screen

Select the features that are displayed about a paper in the Paper Supply screen (Copy feature).

1. From the Paper Tray Settings select Customize Paper Supply screen. 
2. Select an item.

3. Select Save to close this screen and return to the Paper Tray Settings screen.
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Paper Tray Attributes on Setup Menu

The selection made on this screen determines whether or not the Paper Tray Attributes feature 
is displayed on the Setup Menu. Select Disabled or Enabled.

1. From the Paper Tray Settings select Paper Tray Attributes on Setup Screen. 
2. Select Disabled or Enabled.

Disabled:

If this feature is selected, then the Setup Menu does not display the Paper Tray Attributes 
feature.

Enabled:

If this feature is selected, then the Setup Menu displays the Paper Tray Attributes feature, as 
shown in the below illustration.
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Paper Tray Attributes During Loading

When a paper tray is removed from the machine and then replaced, selecting Disabled or 
Enabled determines whether or not the tray change is displayed on the UI.

1. From the Paper Tray Settings select Paper Tray Attributes During Loading. 
2. Select Off or On.

Off:

If this feature is selected, then the UI does not display the paper tray attributes while you are 
loading paper in the tray.

On:

If this feature is selected, the UI displays the paper tray attributes as you are loading paper into 
the tray.

Paper Tray Priority

Set the paper tray priority sequence for automatic tray selection. Automatic tray selection 
means that a tray containing the appropriate paper is automatically selected by the machine 
for copying or printing.

You can select paper trays 1-4 and optional 6 and 7. Tray 5 (Bypass) cannot be selected.

1. From the Paper Tray Settings screen, select Paper Tray Priority.
2. Select the item to be set or changed, and select Change Settings.
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3. Select a Priority setting (First-Sixth) and assign a specific tray to that priority setting.

Note
Only one tray can be set to each priority.

4. Select Save to save the selections and return to the Paper Tray Priority screen.
5. Select Close to return to the Paper Tray Settings screen.

Paper Type Priority

Set the paper type priority sequence for automatic tray selection. Automatic tray selection 
means that a tray containing the appropriate paper is automatically selected by the machine 
for copying or printing.

You can select from a variety of paper types including bond paper, plain paper, recycled paper, 
side 2 paper, etc.

Note
The paper type selections for this feature will vary depending on your machine and your work 
environment requirements (such as the types of paper you use most frequently).

Note
The paper type setting takes precedence over the tray priority sequence. If different paper 
types appear in the same priority sequence, the paper selection is determined by tray priority 
sequence.

For information about the tray priority sequence, refer to Paper Tray Priority on page 9-30.
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1. From the Paper Tray Settings screen, select Paper Type Priority.
2. Select the item to be set or changed, and select Change Settings.

3. Select the priority sequence for this paper type.

4. Select Save to save the setting and to return to the Paper Type Priority screen.
5. Select Close to return to the Paper Tray Settings screen.

Tray 5 (Bypass) - Paper Size Defaults

This feature allows you to assign specific paper sizes to Tray 5. This will facilitate easier copying 
when using Tray 5 (Bypass). 

You can assign a maximum of twenty paper sizes to the Tray 5 (Bypass) size selections, which 
are listed 1-20.

To assign paper sizes to the Tray 5 buttons, perform the following steps.

Note
If a nonstandard size paper is frequently used for copying, set this feature to accommodate 
that paper size. This avoids repeatedly selecting the paper dimensions each time you use that 
nonstandard paper for copying. This feature also allows you to set commonly used paper sizes 
in the descending order shown on the screen below; this provides ease and quickness in 
selecting the desired paper size when copying jobs. For example, if you frequently use 12 x 18 
in. (304.8 x 457.2 mm) paper, you can set Item 1 for that paper size.
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1. From the Paper Tray Settings screen, select Tray 5 (Bypass) Paper Size Defaults.
2. Select the item to be set or changed, and select Change Settings.

Note

Select  to display the previous screen and select  to display the next screen.

3. Select the paper series.

If Custom Size is selected, go to Step 5. on page 9-34

4. Select a specific paper size.
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5. If Custom Size is selected, set the numeric values using , , , and . 

6. Select Save to save your selections and return to the previous screen.
7. Repeat steps 1-6, as required, for Tray 5 paper sizes.
8. Select Close to return to the Paper Tray Settings screen.

Auto Tray Switching Control

Choose the auto tray switching method and how to copy mixed size documents.

1. From the Paper Tray Settings screen, select Auto Tray Switching.
2. Select the item to be set or changed, and select Change Settings.

Auto Tray Switching

Set the method of auto tray switching.

• Always Enable

Regardless of which paper tray is selected, depending on circumstances, the machine 
automatically selects a tray containing appropriate paper.

• Enable during Auto Paper Select

When the paper selection is Auto only, the machine automatically selects a tray containing 
appropriate paper.

• Enable for Same Paper Type/Color

When the paper selection is Auto only, the machine automatically selects a tray containing 
the same paper type and color.
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3. When completed, select Save.
4. Select Targeted Paper Type.
5. Select Targeted Paper Color.
6. Select Close.

Image Quality

You can select the image quality processing method that is used when the machine is scanning 
an original.

1. From the System Common Service Settings, Features menu, select Image Quality.

2. Select Image Quality. 

3. Select the item to be set or changed, and select Change Settings.
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Photo and Text Recognition

This feature allows the System Administrator to set the default level for Photo & Text 
Recognition. (The Photo & Text function is used with the Original Type (Image Quality) 
feature when copying jobs.) The setting selected here enables the machine to accurately 
distinguish text from photos when it scans the original document.

Select “Photo & Text Recognition” and then select the “Change Settings” button. Photo & 
Text Recognition options include the following:

Select Normal to enable optimum image quality during copy jobs. Select More Text if the 
majority of the copy jobs contain mostly fine print; this enables the machine to recognize the 
fine print as text. Select More Photo if the majority of copy jobs contain more photographs 
than text. This enables the machine to recognize newspaper and advertisement halftone 
images as photos.

Note
If a copy job requires a setting other than “Normal,” the System Administrator may change the 
default level for that job. However, at the completion of the job, ensure that the default level is 
reset to “Normal” in order to provide optimum image quality on your output.

Background Suppression (Black copy)

Background Suppression prevents reproduction of unwanted shading from originals where the 
opposite side printing shows through.

Select High Quality to enhance the quality of the black copy.

Select High Speed to increase the rate of speed of data transmission
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Background Suppression (Scan Jobs)

Background Suppression prevents reproduction of unwanted shading from originals where the 
opposite side printing shows through

Select High Quality to enhance the quality of the black copy.

Select High Speed to increase the rate of speed of data transmission.

Image Enhancement

You can select whether or not to carry out image enhancement. If you select On, copy data is 
smoothed, to give a smoother appearance. If Off is selected, the machine will not perform 
image enhancement.

Reports

These settings relate to printing reports.

1. From the Common Settings screen, select Reports.

The Reports screen is displayed.

Note
The reports actually listed on your Reports screen may vary according to the enablement or 
disablement of related features or options.”

2. Select the item to be set or changed, and select Change Settings.
3. Select the appropriate option for the specific Reports feature.

Print Reports Button

When enabled, the Print Reports button appears on the Machine Information Tab without 
entering the SA passcode.

Job History Report

You can select whether or not to automatically print a Job History Report after a total of fifty 
jobs have been processed.
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Scan File Transfer Report

You can select No Report, Print Report, or Print When Delivery Fails.

2 Sided Report

When printing a report/list, select whether to print 1 sided or 2 sided.

Job Flow Error 

You can select No Report or Print Report.

Other reports you can select include Activity Report, Transmission Report - Job Undelivered, 
Transmission Report - Job deleted, Folder Report, Broadcast/Multi-Poll Report, and Relay 
Broadcast Report.

4. Select Save.
5. Select Close.

You are returned to the Common Settings screen.

Maintenance

The following features are available:

• Initialize Hard Disk
• Delete All Data
• Software Options
• Alignment Adjustment Settings
• Finisher Adjustment (optional)
• Delete all certificates
• Initialize Settings

Tip
The Software Options feature is restricted to the Xerox Service Representative only. It is not for 
customer use.

1. From the Common Settings screen, select Maintenance (It may be necessary to scroll).

2. The maintenance screen is displayed.
3. From the Maintenance screen, select the applicable option.
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4. Follow the instructions provided on the screen for carrying out a specific function.
5. Select Close to return to the Maintenance screen.
6. Select Close to return to the Common Settings screen.

Initialize Hard Disk

This procedure initializes the hard disk. The data erased by formatting includes additional 
fonts, ESC/P, HP-GL/2, and SMB folder.

Tip
The secure print document log is not erased.

1. From the Maintenance screen, select Initialize Hard Disk.

2. Select the partition to be reformatted and select Start.
3. Select Yes.

4. When reformatting completes successfully, the message screen appears, select Confirm.
5. Select Close to return to the Maintenance screen.
6. Select Close to return to the Common Settings screen.
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Delete All Data

Tip
Do not use this function unless you are authorized and have checked with your Xerox Service 
Representative.

This deletes all data recorded in the machine. This includes all user settings, and data recorded 
automatically by the system.

Software Options

Use the Keyboard to type passcodes for the Software Options and select Reboot. Up to 5 
passcodes can be typed.
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Alignment Adjustment Settings

Adjustments can be made to the image based on the alignment output of a document. Various 
adjustments can be modified such as: image position, scale, and skew. This can be achieved 
through the use of the twenty default adjustment types. In addition, a specific paper tray can 
be assigned to a specific adjustment type.

Adjustments can be made when the position of the output image is misaligned or skewed. This 
may be a result of paper expansion or contraction, cutting inaccuracy, or paper storage 
conditions. To compensate for this scenario, the Alignment Adjustment Settings feature can 
be used to adjust the image alignment.

Note
It is recommended that you read through the entire Alignment Adjustment Settings section 
before performing any actual alignment adjustments.

Adjust the position of the output image (alignment adjustment)

The following adjustments can be made to the position of the output image. These are 
described in more detail in the following pages.

• Squareness Adjustment (Skew): Adjust a skewed image

• Scale Adjustment: Adjust this when the size (scale) of the printed image is offset

• Print Position Adjustment: Use this option when making adjustments to the lead edge of 
the image (X direction) and side edge of the image (Y direction). For example, use this 
when the images on sides 1 and 2 are misaligned.

Tip
When making adjustments to multiple items, adjust the image in the following 
order: Squareness Adjustment, then Scale Adjustment, and finally Print Position Adjustment.

Before using the Alignment Adjustment Settings feature

Follow these steps before using the Alignment Adjustment Settings procedure:

1. Load paper in a tray.
2. Print a sample output and check for any misalignment of the output image.
3. If the output image is misaligned, adjust the position accordingly. 

Save the adjustment values. 

Assign the saved values to the desired paper tray. 

Skew Scale Print Positions of 
Sides 1 and 2



Setups

9-42  System Administration Guide
Xerox 4112/4127 Copier/Printer

Alignment Adjustment Settings procedure

Save the adjustment results for squareness, print position, and scale as an alignment 
adjustment type, and then assign the type to the desired paper tray.

1. Load paper in a tray.
2. Press the Log In/Out button, and enter the system administrator mode.

3. Select the Tools tab followed by the System Settings tab.
4. Select the Common Service Settings followed by the Maintenance Settings.

Log In/Out
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5. Select Alignment Adjustment Settings.

6. Select Alignment Adjustment Type Setup, and press Change Settings.

7. Select the alignment adjustment type you want to set or adjust, and press Change 
Settings.
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8. Select Name, and press Change Settings.

9. Assign a type name, and press Save.

Note
We recommend using a name such as “A4 Plain” that allows you to know what the content of 
the paper type is.

10. Press Sample Printout.
11. Select the paper tray in which you loaded paper in Step 1, and then select 1-Sided or 2-

Sided followed by the desired number of sheets via the Number of Sheets option 

Note
When using the Squareness Adjustment option, select the A3 paper size. When using the 
Number of Sheets option, we recommend printing about 10 sheets in order to calculate the 
average value of the variations.

12. Press the Start button.
The current sample output is printed. 

If the position of the sample output is correct, a line is printed at a position 10 mm from 
the edge of the paper. If the position of the line on the sample output is misaligned, make 
adjustments accordingly.
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Note
Two lines are printed on the image of side 1 and one line is printed on the image of side 2 of the 
sample that is printed with Sample Printout to indicate the paper feed direction.

13. Press Save.
14. Check the sample output, and adjust the position if misalignment has occurred.

Note
For details on making each adjustment, refer to the sections starting on page 9-46.

15. After you finish making adjustments, print another output sample by pressing the Sample 
Printout and verify the adjustment results. 

16. Make adjustments again if necessary and press Save.
17. Press Save.
18. Press Close.
19. Select the tray to assign the set type (the tray in which you loaded the paper in Step 1), and 

press Change Settings.
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20. Select the adjusted type, and press Save.

Squareness Adjustment

Adjust image skew (squareness) in 0.1 mm increments for Side 1 and 2. Maximum adjustment 
is 1.2 mm.

Specify a positive value when you want to adjust the position of the image in the opposite 
direction to the paper feed direction, and a negative value when you want to adjust the image 
in the paper feed direction.

1. Check the sample output, and measure the squareness offset amount that occurred. 

Use the following equation to obtain the squareness offset amount (where “A” represents 
the length of the lead registration which faces the back of the machine, and “B” represents 
the length of the lead registration which faces the front of the machine):

• Squareness offset amount = (A - B) × 400 ÷ 277 (when A3 paper is placed horizontally)
• (A - B) × 190 ÷ 277 (when A4 paper is placed vertically)
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2. Select Squareness, and press Change Settings.

3. Enter a value with the squareness offset amount measured in Step 1 added as the current 
setting value of Side 1 and Side 2.
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Note
Entering a positive or negative value adjusts the squareness as shown below. 

4. Press Save.

Scale Adjustment

Adjust the size (scale) of the image with respect to the lead edge direction and the side edge 
direction according to the paper feed direction by 0.025% increments for each of sides (side 1 
and 2). You can adjust up to 0.400%. Specify a positive value when you want to increase the 
scale, and a negative value when you want to reduce it.

1. Check the sample output, and measure the scale offset amount that occurred.

• Paper feed direction: X direction scale
X direction scale offset amount = image reference length in the X direction - image 
actual measurement length in the X direction

• Vertical direction in relation to the paper feed direction: Y direction scale
Y direction scale offset amount = image reference length in the Y direction - image 
actual measurement length in the Y direction
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Note
The reference lengths for a sample output of A3 or A4 size printed with Sample Printout are as 
follows. 

2. Select X% or Y%, and press Change Settings.

3. Enter the offset amount of the X direction scale you measured in Step 1 for Side 1 and Side 
2 of X%.

4. Enter the offset amount of the Y direction scale you measured in Step 1 for Side 1 and Side 
2 of Y%.

Note
If the scale offset amount is positive, enter a negative value in the adjustment value field. If 
negative, enter a positive value. 

Paper Size Image Reference Length in X 
Direction

Image Reference Length in Y 
Direction

A3 400 mm 277 mm

A4 190 mm 277 mm
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Note
For a rough guide on the image scale adjustment values to enter, refer to Chapter 9 Sample 
Printout of 11 x 17 inch/A3 Size on page 9-50 and Chapter 9 Sample Printout of 8.5 x 11 inch/
A4 Size on page 9-51.

5. Press Save.
Table 1: Sample Printout of 11 x 17 inch/A3 Size

11 x 17 inch/A3 
Y Direction 

(Front)

11 x 17 inch/A3 
Y Direction

(Back)

11 x 17 inch/
A3 X 

Direction 
(Front)

11 x 17 inch/A3 
X Direction

(Back) Adjustment 
Amount (%)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset 
Amount 

(mm)

Offset Amount 
(mm)

1.60 1.60 -0.400

1.04 1.50 1.50 -0.375

0.97 1.40 1.40 -0.350

0.90 1.30 1.30 -0.325

0.83 1.20 1.20 -0.300

0.76 1.10 1.10 -0.275

0.69 1.00 1.00 -0.250

0.62 0.90 0.90 -0.225

0.55 0.55 0.80 0.80 -0.200

0.48 0.48 0.70 0.70 -0.175

0.72 0.72 0.60 0.60 -0.150

0.35 0.35 0.50 0.50 -0.125

0.28 0.28 0.40 0.40 -0.100

0.21 0.21 0.30 0.30 -0.075

0.14 0.14 0.20 0.20 -0.050
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Note
The above values for the offset amount of the image scale are rounded off.

Table 2: Sample Printout of 8.5 x 11 inch/A4 Size

0.07 0.07 0.10 0.10 -0.025

0 0 0 0 0

-0.07 -0.07 -0.10 -0.10 0.025

-0.14 -0.14 -0.20 -0.20 0.050

-0.21 -0.21 -0.30 -0.30 0.075

-0.28 -0.28 -0.40 -0.40 0.100

-0.35 -0.35 -0.50 -0.50 0.125

-0.42 -0.42 -0.60 -0.60 0.150

-0.48 -0.70 -0.70 0.175

-0.55 -0.80 -0.80 0.200

-0.62 -0.90 -0.90 0.225

-0.69 -1.00 -1.00 0.250

-0.76 -1.10 -1.10 0.275

-0.83 -1.20 -1.20 0.300

-0.90 -1.30 0.325

-1.40 0.350

-1.50 0.375

-1.60 0.400

8.5 x 11 inch/A4 
Y Direction 

(Front)

8.5 x 11 inch/A4 
Y Direction

(Back)

8.5 x 11 inch/A4 
X Direction 

(Front)

8.5 x 11 inch/A4 
X Direction

(Back) Adjustment 
Amount (%)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset Amount 
(mm)

0.76 0.76 -0.400

1.04 0.71 0.71 -0.375

0.97 0.67 0.67 -0.350

0.90 0.62 0.62 -0.325

0.83 0.57 0.57 -0.300

0.76 0.52 0.52 -0.275

11 x 17 inch/A3 
Y Direction 

(Front)

11 x 17 inch/A3 
Y Direction

(Back)

11 x 17 inch/
A3 X 

Direction 
(Front)

11 x 17 inch/A3 
X Direction

(Back) Adjustment 
Amount (%)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset 
Amount 

(mm)

Offset Amount 
(mm)
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Note
The above values for the offset amount of the image scale are rounded off.

0.69 0.48 0.48 -0.250

0.62 0.43 0.43 -0.225

0.55 0.55 0.38 0.38 -0.200

0.48 0.48 0.33 0.33 -0.175

0.72 0.72 0.29 0.29 -0.150

0.35 0.35 0.24 0.24 -0.125

0.28 0.28 0.19 0.19 -0.100

0.21 0.21 0.14 0.14 -0.075

0.14 0.14 0.10 0.10 -0.050

0.07 0.07 0.05 0.05 -0.025

0 0 0 0 0

-0.07 -0.07 -0.05 -0.05 0.025

-0.14 -0.14 -0.10 -0.10 0.050

-0.21 -0.21 -0.14 -0.14 0.075

-0.28 -0.28 -0.19 -0.19 0.100

-0.35 -0.35 -0.24 -0.24 0.125

-0.42 -0.42 -0.29 -0.29 0.150

-0.48 -0.33 -0.33 0.175

-0.55 -0.38 -0.38 0.200

-0.62 -0.43 -0.43 0.225

-0.69 -0.48 -0.48 0.250

-0.76 -0.52 -0.52 0.275

-0.83 -0.57 -0.57 0.300

-0.90 -0.62 0.325

-0.67 0.350

-0.71 0.375

-0.76 0.400

8.5 x 11 inch/A4 
Y Direction 

(Front)

8.5 x 11 inch/A4 
Y Direction

(Back)

8.5 x 11 inch/A4 
X Direction 

(Front)

8.5 x 11 inch/A4 
X Direction

(Back) Adjustment 
Amount (%)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset Amount 
(mm)

Offset Amount 
(mm)
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Print Position Adjustment

Adjust the position of the image in the lead edge and side edge direction in relation to the 
paper feed direction by 0.1 mm increments for each of side (sides 1 and 2). You can adjust up to 
2.0 mm. 

Adjustments to the paper position feed direction can be made by making changes to the X 
Print Position, and Y Print Position.

1. Check the sample output, and measure the print position offset amount that occurred.

• X Print Position
Specify a positive value when you want to move the position of the image in the 
opposite direction to the paper feed direction, and a negative value when you want to 
move the position of the image in the paper feed direction.

• Y Print Position
Specify a positive value when you want to move the position of the image toward the 
back of the machine, and a negative value when you want to move the position of the 
image toward the front of the machine.

2. Select X Print Position or Y Print Position, and press the Change Settings button.
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3. Enter the measured value that was obtained in Step 1 for Side 1 by touching the up/down 
arrow buttons; refer to the Type 2 - X Print Position screen.

4. Enter the measured value that was obtained in Step 1 for Side 2 by touching the up/down 
arrow buttons; refer to the Type 2 - Y Print Position screen.

Note
X Print Position: Specify a positive value when you want to move the position of the image in 
the opposite direction to the paper feed direction, and a negative value when you want to move 
the position of the image in the paper feed direction.

Note
Y Print Position: Specify a positive value when you want to move the position of the image 
toward the back of the machine, and a negative value when you want to move the position of 
the image toward the front of the machine.

5. Press Save. 



Setups

Xerox 4112/4127 Copier/Printer 9-55
System Administration Guide

Adjust Fold Position

This section describes the procedure for adjusting the fold position. You can adjust the fold 
position for various paper types, as well as set adjustment values to any of 10 default types. You 
can assign a set type to each tray.

In addition, you can adjust the fold positions for single fold, booklet, C fold, Z fold, Z fold half 
sheet.

Fold Position Adjustment

1. Load the paper for adjusting the fold position in the desired paper tray. 
2. Press the Log In/Out button, and enter the system administrator mode.

3. Select the Tools tab followed by the System Settings tab.
4. Select the Common Service Settings followed by the Maintenance Settings.

Log In/Out
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5. Select Finisher Adjustment.

6. Select Adjust Fold Position.

7. Select Fold Position Type Setup, and press Change Settings.
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8. Select the paper fold position type you want to set or adjust, and press Change Settings.

9. Select Name, and press Change Settings.

10. Enter the desired type name, and press Save.

Note
We recommend using a name such as “Single Fold Plain” that allows you to recall what the 
content of that fold type is.

11. Select the fold type, and press Change Settings.

Note
For details on making each fold adjustment, refer to the procedures starting on page 9-60.
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12. Select the desired settings, and press Sample Printout.

13. Select the tray in which you loaded paper in Step 1, and then press the <Start> button.

14. Measure the fold position via the output sample, and adjust the fold position accordingly.
15. Make adjustments to the items if necessary.
16. After you finish making adjustments, print another output sample with Sample Printout 

and check the adjustment results.
17. Make adjustments accordingly. If necessary, repeat Steps 12 - 14.
18. Press Save. 
19. Press Close until the Adjust Fold Position screen appears. 
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20. Select the tray to assign the set type (the tray in which you loaded the paper in Step 1), and 
press Change Settings.

21. Select the adjusted fold position type, and press Save.
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Single Fold Position Adjustment

Adjust the single fold position.

1. Select Single Fold, and press Change Settings.

2. Specify Sheets to be folded, and press Sample Printout.
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3. Select the tray in which you loaded paper, and press the Start button.

An output sample is printed.

4. Press Close.
5. Check the output sample printout, and measure the offset amount. 
6. Select Long at Left or Long at Right.

7. Enter the measurement value you obtained in Step 5 in Values A Before Adjustment field 
by touching the up/down arrow buttons; refer to the screen above.

8. Press Adjust.
9. Press Sample Printout again to print an output sample printout, and check the adjustment 

results.
10. Make adjustments again if necessary. (Steps 6 - 8)
11. Press Save.
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Booklet Position Adjustment

Adjust the booklet position.

1. Select Booklet, and press Change Settings.

2. Press Sample Printout.
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3. Select the tray in which you loaded paper, select 2-Sheet Stack, and press the Start button.

An output sample is printed.

4. Select the tray in which you loaded paper, select 15-Sheet Stack, and press the Start 
button.
An output sample is printed.

5. Press Close. 
6. Check the output sample, and measure the position offset amount for 2-sheet stack and 

15-sheet stack. 
7. Press Booklet Fold State (2 Sheets).
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8. Select the state of the fold and staple position of the output paper, and enter the 2-sheet 
stack offset amount you measured in Step 6 in Values A & B Before Adjustment.

9. Press Save.
10. Set Booklet Fold State (15 Sheets) in the same way.

Note
The values between 2-sheet stack and 15-sheet stack are adjusted automatically.
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Note
When you want to specify the number of sheets separately, use the set Variable-Sheet Booklet 
option to make the proper selections.

11. Press Sample Printout again to print an output sample, and check the adjustment results.
12. Make adjustments again if necessary. (Steps 7 - 10) 
13. Press Save.

C Fold Position Adjustment

Adjust the C fold position.

1. Select C Fold-A4 or C Fold-8.5x11”, and press Change Settings.
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2. Press Sample Printout.

3. Select the tray in which you loaded paper, and press the Start button.

An output sample is printed.

4. Press Close.
5. Check the output sample, and measure the A and B fold position movement amounts.

A

B
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6. Enter the measurement value you obtained in Step 5 in Values A & B Before Adjustment, 
and the final value you want after adjustment in Desired Values A & B.

Tip
Set value A and value B so that an edge of the paper does not extend past a fold position of the 
paper. An edge of paper extending past a fold position of the paper may cause a paper jam.

7. Press Sample Printout again to print an output sample, and check the adjustment results.
8. Make adjustments again if necessary. (Step 6)
9. Press Save. 

Z Fold Position Adjustment

Adjust the Z fold position. 

1. Select Z Fold-A4 or Z Fold-8.5x11”, and press Change Settings.
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2. Press Sample Printout.

3. Select the tray in which you loaded paper, and press the Start button.

An output sample is printed.

4. Press Save.
5. Check the output sample, and measure the A and B fold position movement amounts.

A

B
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6. Enter the measurement value you obtained in the previous step in Values A & B Before 
Adjustment, and the final value you want after adjustment in Desired Values A & B.

Tip
Set value A and value B so that an edge of the paper does not extend past a fold position of the 
paper. An edge of paper extending past a fold position of the paper may cause a paper jam.

7. Press Sample Printout again to print an output sample, and check the adjustment results.
8. Make adjustments again if necessary (Step 6).
9. Press Save.

Z Fold Half Sheet Position Adjustment

Adjust the A fold position. 

1. Select Z Fold Half Sheet- A3, Z Fold Half Sheet- B4, Z Fold Half Sheet-11x17”, or Z Fold 
Half Sheet - 8K, and press Change Settings.
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2. Press Sample Printout.

3. Select the tray in which you loaded paper, and press the <Start> button.

An output sample is printed.
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4. Press Save.
5. Check the output sample, and measure the A and B fold position movement amounts.

6. Enter the measurement value you obtained in the previous step in Values A & B Before 
Adjustment, and the final value you want after adjustment in Desired Values A & B.

Tip
Set value B so that an edge of the paper does not extend past a fold position of the paper. An 
edge of paper extending past a fold position of the paper may cause a paper jam.

7. Press Sample Printout again to print an output sample, and check the adjustment results.
8. Make adjustments again if necessary. (Step 6)
9. Press Save.

A

B
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Watermark

Options selected here define what the default settings will be for the Annotation and 
Watermark features on the Output Format tab of the Copy feature. Use the following 
procedure for configuring the default settings for each of the Watermark options.

1. From the Common Settings screen, select Watermark. 

2. Select the item to be set or changed, and select Change Settings.

3. Select the desired option for the Watermark feature.
Each Watermark feature is discussed on page 9-72.

4. Select Save; you are returned to the Watermark screen.
5. Repeat Steps 1-4, if necessary, for other Watermark options.
6. Select Close from the Watermark screen to return to the Common Settings screen.

Date Format
• Set the default date format as it appears on the Annotation and Watermark screens in the 

Output Format tab (Copy feature). When selected, the default date format is printed on 
the copy output when On is selected for the Annotation/Date feature or when the Date 
option in the Watermark feature is selected.

• Choose from the following Date Format options: 20yy/mm/dd, mm/dd/20yy, dd/mm/
20yy, and 20yy-mm-dd.

• The option selected here becomes the default setting for both the Annotation and 
Watermark features.
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Default Watermark Effect

Select the default setting for Text Effect; this default value appears on the Watermark screen in 
the Output Format tab (Copy feature). This setting determines how the background text 
(watermark) appears on the printed output. Text Effect selections include: Off, Embossed, 
and Outline.

Default Watermark

You can select the default watermark from a displayed list.

Font Size

You can select from four possibilities: 48 point, 64 point, 80 point or a custom size of 24 to 80 
point.

Background Pattern

Select the background pattern to be used for the set numbering (watermark), Text Effect 
option (on the Output Format tab/Copy feature). Select from eight patterns: wave, circle, 
stripes, chain, beam, rhombic, sunflower, and fan.

Density

Select the density for printing the background text (watermark). You can select from three 
levels: Lighter, Normal, or Darker.

Watermark/Background Contrast

Select the text/background contrast for printing the set numbering (watermark) 
information. You can select from contrast levels 1 to 9. Set the text/background contrast after 
checking the results of printing a Text Effect Sample List.

Note
For information about sample printing, refer to the section entitled “Text Effect Sample List” in 
Chapter 10 of the User Guide.

Force Watermark - Copy Job

Select whether or not to force set numbering (watermark) printing for copy jobs. Select On to 
force all copy jobs to print with set numbering (watermark). Select Off if you do not want all 
copy jobs printed with set numbering (watermark).

Force Watermark - Client Print

Select whether or not to force set numbering (watermark) printing for all jobs that are printed 
from a client computer. Selections are Off or On (this forces all jobs sent from a client computer 
to print a watermark on the output).



Setups

9-74  System Administration Guide
Xerox 4112/4127 Copier/Printer

Force Watermark - Folder Print

Select whether or not to force set numbering (watermark) printing when printing from the 
folder. Select Off or On (this forces all jobs that are printed from a folder to print a watermark 
on the output).

Force Watermark - Media Print

Select whether or not to force set numbering (watermark) printing when printing to 
media. Select Off or On (this forces all jobs that are printed on media to print a watermark on 
the output.

Custom Watermarks - 1 through 3

Create your own watermark.

Secure Watermark (optional)

The Secure Watermark feature is designed to provide security management of paper 
documents by embedding job deterrence information into your paper document. This 
information may include; job type, date and time of job start, User information, Document 
name, and other such related information. A digital code is put onto your copies in order to 
prevent unauthorized recopying/printing of sensitive materials.

Options selected here define what the default settings will be for the Secure Watermark 
features on the Output Format tab of the Copy feature. Use the following procedure for 
configuring the default settings for each of the Secure Watermark options. (This feature 
embeds a digital code onto your copies in order to prevent unauthorized recopying or to track 
copies that have been made.)

Note
It is assumed that you have purchased the Security option that enables the Secure Watermark 
feature. If you did not, contact your Xerox Representative to purchase this option.

1. From the Common Settings screen, select Secure Watermark. 
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2. Select the desired setting for the Secure Watermark feature.

Each Secure Watermark feature is discussed on page 9-75.

3. Select Save; you are returned to the Secure Watermark screen.
4. Repeat Steps 1-4, if necessary, for other Secure Watermark features.
5. Select Close from the Secure Watermark screen to return to the Common Settings screen.

Secure Watermark Control

Select whether or not to set Secure Watermark Detection. Selections are Off or On.

Digital Codes Settings

Set a Decoding Passcode and a Custom Digital Watermark.

Force Secure Watermark 

Select whether or not to force a Secure Watermark for Copy Job, Client Print, Folder Print, 
Media Print, Incoming Fax Print and Report. Selections are Off or On.

Secure Watermark Defaults

Set the Protection Code setting. The selections are Off or Prevent Duplication.

Secure Watermark Effect

Set Default Secure Watermark, Background Pattern, Background Contrast, and Custom 
Secure Watermarks 1,2, and 3.
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Image Log Control
1. From the Common Settings screen, select Image Log Control. 

2. Select the desired setting for the Image Log Control feature.

Each Image Log Control feature is discussed on page 9-76.

3. Select Save; you are returned to the Secure Watermark screen.
4. Repeat Steps 1-4, if necessary, for other Image Log Control features.
5. Select Close from the Image Log Control screen to return to the Common Settings screen.

Image Log Control

Select whether or not to set Image Log Control. Selections are Off or On.

Image Log Target

Set the Image Log Target for Copy Service, Print Service, Scan Service, or Fax Service.

Image Log Generation

Set the Assurance Level, Resolution, and Page Range.

Image Log Transfer

Set the Assurance Level and Auto Transfer.
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Print Universal Unique ID
1. From the Common Settings screen, select Print Universal Unique ID. 

2. Select the desired setting for the Print Universal Unique ID feature.

Each Universal Unique ID feature is discussed on page 9-77.

3. Select Save; you are returned to the Secure Watermark screen.
4. Repeat Steps 1-4, if necessary, for other Image Log Control features.
5. Select Close from the Image Log Control screen to return to the Common Settings screen.

Print Universal Unique ID

Select whether or not to set Print Universal Unique ID. Selections are Yes or No.

Print Position

Set the Print Position (Top Left, Bottom Left, Top Center, Bottom Center, Top Right, and Bottom 
Right).

Print Position Adjustment

Set the Length and Width (X and Y) in 0.5mm increments.
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Print Position (Side 2)

Set side 2 as Same as Side 1 or Mirror Side 1.

Other Settings

This feature allows you to select the default settings for miscellaneous other options that relate 
to the machine.

Tip
Each one of these items is discussed starting on page 9-79.

Use the following procedure to access the Other Settings feature.

1. From the Common Settings screen, select Other Settings.

2. Select the item to be set or changed, and select Change Settings.

Note

Select  to display the previous screen and select  to display the next screen.

3. Select the default setting.
4. Select Save; you are returned to the Other Settings screen.
5. Repeat Steps 1-4 for the selecting the default setting for any additional desired Other 

Settings items.
6. Select Close to return to the Common Settings screen.
7. Select Close to return to the System Settings screen.
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Offset Stacking (Middle Right Tray)

Select the default offset stacking option for the finisher tray:

• None: If this option is selected, the finishing tray will not offset any output.

• Offset per set: If this option is selected, the finishing tray will offset each set of a copy/
print job. This option also offsets each job.

• Offset per job: If this option is selected, all the sets of a job are delivered on one stack to 
the output area. When the next job starts, that job is offset from the previous job in the 
tray. This option does not offset each set of a job.

Auto Job Promotion

This Other Settings option allows you set the machine to automatically promote a job for 
printing/copying if the machine is unable to start a prior job. For example, the machine is 
unable to start an operation because there is no paper in the tray (at the start of a copy or print 
operation). If this feature is enabled, then the machine can bypass the current job and allows 
other jobs to start.

Tip
The other jobs must not have the same copy/print requirements as the faulted job. If other 
jobs have different copy/print requirements, then these other jobs can be promoted and 
copied/printed.

3 sets of another job

3 sets
of a
job

3 sets of a job

Job 1

Job 2

(with stacked sets)

(with stacked sets)
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Note
Stored documents such as secure prints and sample prints are excluded and cannot be 
automatically promoted.

Default Print Paper Size

Select the default paper size that will be used when printing a report/list. Select between A4, or 
8.5 × 11 inch.

Paper Size Settings

Select the default paper sizes for standard size originals and for automatic paper 
detection. Select from five possibilities: A/B series (8 × 13"), A/B series, A/B series (8K/16K), A/
B series (8×13”/8×14”), and Inch series.

Refer to the Chapter 12 Entering Text on page 12-8.

Millimeters/Inches

Select the default setting for displaying the dimensions on the screen as millimeters or inches.

Keyboard Input Restriction

Select whether to restrict the display of the virtual keyboard on the UI. To prevent illegible 
characters from occurring when one character set is switched to another character set, restrict 
the input to ASCII characters only. If you select On (Standard ASCII only), the displayed 
keyboard shows ASCII characters only.

Operation of Up/Down Buttons

Select whether or not there is a continuous scrolling effect when the scroll buttons are held 
down.

• Disable Fast Scrolling: Scrolling does not occur when the scroll buttons are held down.

• Enable Fast Scrolling: Scrolling occurs when the scroll buttons are held down.
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Data Encryption
Tip
This is an optional feature that may not be available on your copier/printer; it is part of the 
optional Data Security Kit. For more information, contact the Customer Support Center.

If you want the recorded data on the hard disk encrypted, select On as the default setting for 
this feature. By switching on the data encryption, all data written to the hard disk is 
automatically encrypted. Encryption prevents unauthorized access to the stored data. When 
encryption is on, an encryption key must be set.

Perform the following steps:

1. Enter the System Administration mode (Chapter 1 Entering the System Administrator mode 
on page 1-10).

2. Press the Machine Status button on the Control Panel.
3. Select the Tools tab.
4. Select Common Service Settings.
5. Select Other Settings.

6. Select Data Encryption.
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7. Select Change Settings.
8. Select either On or Off.

If On is selected, Data Encryption screen is displayed.

9. From the Data Encryption screen, enter the desired encryption key password twice.

a. Select Keyboard and enter a 12-character encryption key.

Note
The default value for the encryption key is 111111111111 (twelve ones).

b. Select Save (from the Keyboard screen).
You are returned to the Data Encryption screen.

a. Select Keyboard again.
b. Enter the same encryption key once more.

10. Select Save (from the Keyboard screen).
11. Select Save (from the Data Encryption screen).
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12. Exit the System Administration mode.

Encryption Key for Confidential Data

IMPORTANT!
Do not forget the encryption key! The data cannot be restored if you forget the 
encryption key.

Tip
• This is an optional feature that may not be available on your copier/printer; it is part of the 

optional Data Security Kit. For more information, contact the Customer Support Center.
• A service representative can block changes to the settings of this feature. For more 

information about settings, refer to Service Representative Operation Limit on page 9-85.

NoteWhen an encryption key is set, confidential data and information such as the passcodes of 
the system administrator and folders are encrypted (or coded). This prevents unauthorized 
access to the information.

If the optional Data Encryption feature is available for your machine, use the following 
procedure for creating an encryption key.

1. Enter the System Administration mode (Chapter 1 Entering the System Administrator mode 
on page 1-10).

2. Press the Machine Status button on the Control Panel.
3. Select the Tools tab.
4. Select Common Service Settings.
5. Select Other Settings.
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1. Select Encryption Key for Confidential Data.

2. Select Keyboard and enter a 12-character encryption key.

Note
The default value for the encryption key is 111111111111 (twelve ones).

3. Select Save (from the Keyboard screen).

You are returned to the Encryption Key for Confidential Data screen.

4. Select Keyboard again.
5. Enter the same encryption key once more.
6. Select Save (from the Keyboard screen).
7. Select Save (from the Encryption Key for Confidential Data screen).
8. Exit the System Administration mode.

Data Restoration

Tip
The encrypted data cannot be restored if any of the following occur:

• When there is a physical hard disk error
• When you cannot remember the encryption key
• When attempting to access the Service Representative Operation Limit feature, but 

you cannot remember the System Administrator User ID and password.
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Start data encryption and/or changing the settings:

When data encryption is started or ended and when the encryption key is changed, the 
machine must be restarted. The corresponding recording area of the hard disk is reformatted 
when the machine restarts. Previous data is not guaranteed.

The recording area stores the following data:

• Spooled print data

• Secure print, sample print, and similar print data

• Forms for the form overlay feature

• Folder and job flow sheet settings (box name, passwords, etc.)

• Documents in folder

Tip
Save all necessary settings and documents before using the data encryption feature or 
changing its settings.

Service Representative Restricted Operation

This feature restricts the Service Representative from accessing certain security features and 
changing the System Administrator settings. Select either On or Off. When On is selected, the 
machine passcode can be set.

Software Download

Tip
This feature is not supported; however, it may still be accessible. This feature is only for service 
representative use. Contact the Customer Support Center. Select Disabled as the default 
setting.

Document Feeder Tray Elevator   

This feature allows specification of when the Document Tray elevator in the Document Handler 
is raised to the operating position. Select either When loading originals or When pressing 
Start. 

Document Feeder Tray Elevation

Select the default setting for when the elevator tray raises on the document feeder:

When loading originals

Select this option if you want the elevator tray to raise when you load documents in the 
document feeder.

When pressing Start

Select this option if you want the document feeder elevator tray to raise when you press the 
Start button on the control panel.
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Estimated Job Time 

Select the default setting that is displayed for the estimated job completion time. 

Cumulative time for all jobs

Select this option if you want the machine to display the total time for all jobs.

Time required for a single job

Select this option if you want the machine to display the time required for a single job.

Restrict Recipient Selection Method

Select the default setting that is displayed for the recipient selection. Select Yes or No.

Restrict User to Edit Address Book 

This feature allows you to specify if the user is allowed to edit Address Book information. Select 
Yes or No. 
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Copy Service Settings
In Copy Service Settings, you select default settings that relate to the copy feature.

1. From the System Settings screen, select Copy Service Settings.

Note
To display the System Settings screen, refer to System settings procedure on page 9-1.

2. Select the item to be set.

Preset Buttons

Select the default settings for the Preset Buttons including the most commonly used paper tray 
and magnification percentage. By assigning default values to these buttons, you reduce the 
number of selections when choosing features for the copy process. Each Preset Button item is 
discussed starting on page 9-89.

1. From the Copy Service Settings screen, select Preset Buttons. 
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2. Select the item to be set or changed, and select Change Settings.

Note

Select  to display the previous screen and select  to display the next screen.

Note
Each of the items shown in the above illustration is discussed on the following pages.

3. Select an item to be changed, such as Paper Supply-Button 2 (as shown below).

4. Select the desired setting for that item.
5. Press Save; you are returned to the Preset Buttons screen.
6. Repeat Steps 1-5 until you have selected the desired setting for each Preset Buttons item.
7. Select Close to return to the Copy Service Settings screen.
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Paper Supply Buttons 2-5

Select the default tray setting for the Paper Supply Buttons 2, 3, 4, and 5:

These five buttons appear in the Paper Supply column on the Basic Copying tab (Copy 
feature).

You can select a specific tray to be the default tray for buttons 2, 3, 4, and 5; refer to the below 
illustration:

Select from trays 1-7 (including Tray 5, Bypass).

Second
button

Third
button

Fifth
button

Fourth
button
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Reduce/Enlarge Buttons 3-5

Select the default magnification setting for the Reduce/Enlarge (R/E) Buttons 3, 4, and 5:

These three buttons appear in the Reduce/Enlarge column on the Basic Copying tab (Copy 
feature). You can select a specific magnification setting for buttons 3, 4, and 5; refer to the 
below illustration:

Stapling Buttons 4 and 5

Select the default setting for the Stapling Buttons 4 and 5:

Third
button

Fifth
button

Fourth
button
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These two buttons appear on the Finishing screen, which can be found by accessing the Copy 
feature, Output Format tab. You can select a stapling setting for buttons 4 and 5; refer to the 
below illustration:

Punching Buttons 4 and 5

Select the default setting for the Punching Buttons 4 and 5:

These two buttons appear on the Finishing screen, which can be found by accessing the Copy 
feature, Output Format tab. You can select a punching setting for buttons 4 and 5; refer to the 
below illustration:

Fifth
button

Fourth
button

Fifth
button

Fourth
button
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Front & Back Cover Tray Buttons 3 and 4

Select the default setting for the Front Cover Tray Buttons 3and 4 and for the Back Cover Tray 
Buttons 3 and 4:

These buttons appear on the Covers screen, which can be found by accessing the Copy feature, 
Output Format tab. You can select a setting for Front Cover Tray buttons 3 and 4 and Back 
Cover Tray buttons 3 and 4. From the Covers screen (Copy feature), select a Front and/or Back 
Cover option and then select the Paper Tray Settings button. The following screen is 
displayed:

Third button

Fourth
button
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Image Shift Preset 1, 2, and 3

Select the default setting for the Image Shift Preset Buttons 1, 2 and 3:

These buttons appear on the Image Shift screen, which can be found by accessing the Copy 
feature, Layout Adjustment tab.The following screen is displayed:

Edge Erase Preset 1, 2, and 3

Select the default setting for the Edge Erase Preset Buttons 1, 2 and 3:

Image Shift 
preset 
buttons



Setups

9-94  System Administration Guide
Xerox 4112/4127 Copier/Printer

These buttons appear on the Edge Erase screen, which can be found by accessing the Copy 
feature, Layout Adjustment tab.The following screen is displayed:

Copy Defaults

From this screen, you can select the default settings for the various copy features. Selections 
made here are displayed on the Copy screen.

When the power is switched on, when the machine exits the power-saving mode, or when the 
Clear All button is pressed, these default settings are displayed. By assigning default values to 
commonly used features, you reduce the number of selections when choosing features for the 
copy process.

Use the following procedure for selecting the various Copy Defaults.

1. From the Copy Service Settings screen, select Copy Defaults.

2. Select the item to be set or changed, and select Change Settings.

Note

Select  to display the previous screen and select  to display the next screen.

Note
Each of the items shown in the above illustration is discussed on the following pages.

Edge Erase 
preset 
buttons
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3. Select the item to be changed such as Paper Supply (as shown below).

4. Select the desired setting for that item.
5. Press Save; you are returned to the Copy Defaults screen.
6. Repeat Steps 1-5 until you have selected the desired setting for each Copy Defaults item.
7. Select Close to return to the Copy Service Settings screen.

Paper Supply

Select the default setting for the Paper Supply feature on the Basic Copying screen.

Tip
If the default value for the Reduce/Enlarge feature (refer to is on page 9-96) is set to Auto%, 
then you cannot select the Auto option as the default setting for Paper Supply.
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The selection made here appears as the default setting on the Basic Copying tab (Copy 
feature); refer to the below illustration:

Reduce/Enlarge

Select the default setting for Reduce/Enlarge feature on the Basic Copying screen. Select one 
of the following magnification levels as your default R/E option.

The selection made here appears as the default setting on the Basic Copying tab (Copy 
feature); refer to the below illustration:
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Tip
If the default value for the Reduce/Enlarge feature is set to Auto%, then you cannot select the 
Auto option as the default setting for Paper Supply (refer to is on page 9-95).

Note
For information about R/E Preset buttons, refer to Reduce/Enlarge Presets on page 9-117.

Original Type

Select the default setting for the Original Type feature on the Image Quality screen. Select 
one of the following items as your default Original Type option.

The selection made here appears as the default setting on the Original Type screen (Image 
Quality tab, Copy feature); refer to the below illustration:
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Lighten/Darken

Select the default setting for the Lighten/Darken feature on the Image Quality screen. Select 
one of the following items as your default Lighten/Darken option.

The selection made here appears as the default setting on the Lighten/Darken screen (Image 
Quality tab, Copy feature); refer to the below illustration:
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Sharpness

Select the default setting for the Sharpness feature on the Image Quality screen. Select one 
of the following items as your default Sharpness option.

The selection made here appears as the default setting on the Sharpness screen (Image 
Quality tab, Copy feature); refer to the below illustration:
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Background Suppression

Select the default setting for the Background Suppression feature on the Image Quality 
screen. Select one of the following items as your default Auto Exposure option.

The selection made here appears as the default setting on the Background Suppression screen 
(Image Quality tab, Copy feature); refer to the below illustration:

Note
Background Suppression is valid when Original Type is set to Text & Photo, Text, or Pencil 
Text.
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Copy Defaults

Select the default settings for the Copy Defaults items (refer to the below illustration).

Selections made here appear as the default settings on the Layout Adjustment tab (Copy 
feature), as shown in the below illustration:

2 Sided

Select the default value for 2 Sided copying. Selections include 1 1 Sided, 1 2 Sided, 2 2 
Sided, and 2 1 Sided.

Mixed Size Originals

Select the default setting for Mixed Size Originals. You can select either On or Off.

Edge Erase - Top Edge

Select the default setting for the amount of edge that is erased from the original in the top 
direction. Select from 0-50 mm in 1 mm increments.
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Edge Erase - Bottom Edge

Select the default setting for the amount of edge that is erased from the original in the bottom 
direction. Select from 0-50 mm in 1 mm increments.

Edge Erase - Left Edge

Select the default setting for the amount of edge that is erased from the original in the left 
direction. Select from 0-50 mm in 1 mm increments.

Edge Erase- Right Edge

Select the default setting for the amount of edge that is erased from the original in the right 
direction. Select from 0-50 mm in 1 mm increments.

Edge Erase- Side 2

Select the default setting for Independent Shift or Mirror Side 1.

Image Shift 

Select the default setting for Side 1 output. Select from the following options: No Shift or 
Auto Center.

Image Shift - Side 2

Select the default setting for Independent Shift or Mirror Side 1.

Image Rotation

Select the default setting for Image Rotation. Select from Always On, On during Auto, or Off.

Image Rotation - Rotation Direction 

Select the default settings for Image Rotation - Rotation Direction. Select either Staple 
Position or Portrait Original - Left Edge. 

Original Orientation

Select the default setting from either Upright Images or Sideways Images (Top to Left).
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Copy Output

Select the default setting for the Collation on the Copy Output Format screen. Select one of 
the following items as your default option.

The selection made here appears as the default setting on the Copy Output screen; refer to the 
below illustration:
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Uncollated - Separator Tray

Select the default setting for the Separator Tray feature on the Copy Output screen. Select 
one of the following as your default option.

The selection made here appears as the default setting for the Separator Tray feature on the 
Copy Output screen (Copy feature); refer to the below illustration:
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Output Orientation

Select the default setting for the Output Orientation feature on the Output Format 
screen. Select one of the following as your default option.

The selection made here appears as the default setting for the Output Orientation feature on 
the Output Format tab (Copy feature); refer to the below illustration:

Sample Job

Select the default setting for the Sample Job feature on the Job Assembly screen. Select one 
of the following as your default option.
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The selection made here appears as the default setting for the Sample Set feature on the Job 
Assembly tab (Copy feature); refer to the below illustration:

Annotations items

Select the default settings for the Copy Defaults items (refer to the below illustration).

Selections made here appear as the default settings on the Output Format tab - Annotations, 
as shown in the below illustration:
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Annotations - Font Size

Select Annotation Font Size default.

Annotations - Font Color

Select Annotation Font Color default.

Annotations - Position on Side 2

Select Same as Side 1 or Mirror Side 1 for the default.

Annotations - Comment

Select Off or On for the default.

Annotations - Apply Comment To

Select First Page Only, All Pages, or All Pages Except First for the default.

Annotations - Stored Comment

Not in use.

Annotations - Comment Position

Select the default position. 

Annotations - Date Stamp

Select Off or On for the default.

Annotations - Apply Date Stamp To

Select First Page Only, All Pages, or All Pages Except First for the default.

Annotations - Page Numbers

Select Off or On for the default.

Annotations - Apply Page Numbers To

Select All Pages or All Pages but First for the default.

Annotations - Bates Stamp

Select Off or On for the default.

Annotations - Apply Bates Stamp To

Select All Pages or All Pages but First for the default.
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Date Stamp Position

Select the default settings for the Position of the stamp on the copy output. Select your default 
setting for each Stamp Position option.

The selections made here appears as the default setting on the Annotation - Stamp - Position 
screen (after you select Annotation, Stamp On and then select the Position button; 
Annotation appears on the Output Format tab, Copy feature). Refer to the below illustration:
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Page Number Starting Number

Select the default setting for the page number Starting Number. Select a starting page 
number as your default option.

The selection made here appears as the default setting on the Page Number screen (after you 
select Annotation, Page Number On; Annotation appears on the Output Format tab, Copy 
feature). Refer to the below illustration:



Setups

9-110  System Administration Guide
Xerox 4112/4127 Copier/Printer

Page Numbers - Position

Select the default setting for the page number Position. Select a page number position as your 
default option.

The selection made here appears as the default setting on the Page Number screen (after you 
select Annotation, Page Number On; Annotation appears on the Output Format tab, Copy 
feature). Refer to the below illustration:
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Bates Stamp items

Select the default settings for the Copy Defaults items (refer to the below illustration).

Selections made here appear as the default settings on the Output Format tab - Bates Stamp, 
as shown in the below illustration:

Annotations - Bates Stamp

Select Off or On for the default.

Annotations - Apply Bates Stamp To

Select All Pages or All Pages but First for the default.

Bates Stamp - Starting Number

Select the default starting number.

Bates Stamp - Number of Digits

Select Auto Assign or Manual Assign for the default.
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Bates Stamp - Stored Prefix

Not in Use.

Bates Stamp - Stored Position

Set the Bates Stamp position.

Tab Margin Shift

Set the default value for Margin Shift for Tabs. Select one of the following items as your 
default option.

The selection made here appears as the default setting on the Tab Margin Shift screen 
(Output Format tab, Copy feature). Refer to the below illustration:
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Copy Control

The options here allow you to select the default settings that relate to the copy operation, such 
as Auto Paper, Original Type, Output Orientation, and many more. To select the default 
settings for the various Copy Control options, perform the following steps:

1. From the Copy Service Settings screen, select Copy Control.

2. Select a Copy Control item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

Note
Each of the items shown in the above illustration is discussed on the following pages.

3. Select the desired setting for that item.
4. Select Save; you are returned to the Copy Control screen.
5. Repeat Steps 1-4 until you have selected the desired setting for each Copy Control item.
6. Select Close to return to the Copy Service Settings screen.

Memory Full Procedure

While scanning/copying an original, if there is insufficient space on the machine’s hard disk, a 
screen appears. This screen asks the user how to handle the partially stored data. If the user 
does not respond to this screen and a predetermined amount of time elapses, then the machine 
will either cancel the job or run the partially scanned-in/copied job. The setting selected here 
determines how the machine will handle that partially scanned-in/copied job.

• Delete Job: The stored data is deleted from the machine’s hard disk.

• Run Job: The scanned-in/copied data is treated as valid and complete, and the job printed 
as is.

Note
You can set amount of time that elapses between an error occurring and the machine’s 
handling of the partially scanned-in/copied job. For more information, refer to Auto Job Release 
on page 9-10.

Maximum Stored Pages

Set the default maximum number of pages stored for a copy original. You can set a number 
between 1-2000 pages.
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2 Sided Scanning Options 

Select the default settings for 2 Sided Scanning Options. Select either 2 Sided Simultaneous 
Scan or 1 Sided Scan. 

Auto Paper Off

Select the default tray that will be used when the Auto feature (on the Paper Supply, Basic 
Copying screen) is canceled because the Auto% or the Independent X-Y% feature (on the 
Reduce/ Enlarge, Basic Copying screen) is selected. Select from Trays 1-4 or optional Trays 6-
7. 

Mixed Size Originals - 2 Sided Copy

Select the default setting that affects the 2-sided originals. Select either Copy to new sheet or 
Copy to Side 2.

Fine-tune 100%

The fine-tune value is applied to documents that are placed on the Document Glass for copying 
and the either 100% for Basic Copying (Reduce/Enlarge) or Preset%, 100% is selected. Set the 
value in the X/Y direction within the range 98 to 102% in 0.1% increments.

Tip
This feature is not applied if any other Reduce/Enlarge percentage is selected.

Use the following procedure to select a default fine tune setting.

1. Select Fine-tune 100%, and select Change Settings. 

2. Enter the desired fine-tune value by using s, t, , and .
3. Select Save to save the changes and return to the Copy Control screen.

Pseudo-Photo Gradation Mode

Select the default toning method for photo originals. To obtain an image quality that is closer 
to the photo image, select how gray tones will be handled by the machine. Select either Error 
Diffusion or Dither.
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Original Type - See - Through Paper

Select the default setting for See - Through Paper. The selection made here is displayed on the 
Image Quality screen, Original Type feature. Select either Enabled or Disabled.

Output Orientation-Reverse Order

Select whether or not Reverse Order is enabled for the delivery of the copy or print output. If 
Enabled is selected, Face Up, Reverse Order is displayed on the Output Orientation screen 
(Output Format tab).

Output Orientation-Auto (Single sheet)

Select the default setting for delivering the copy or print output. This default setting is 
displayed on the Output Orientation screen (Output Format tab). Select either Face Up or 
Face Down. The setting selected here is the default delivery method when the Auto feature is 
selected on the Output Orientation screen (Output Format tab).

Annotations - Edit Comment 1 through 8

Select Allow or Do Not Allow.

Bates Stamp - Edit Prefix 1 through 8

Select Allow or Do Not Allow.

Maximum Number of Sets

Select 1 through 9999.

Reading Order Options

Select Hide Reading Order or Show Reading Order.

Original Size Defaults

Select the default original sizes. Selections made here appear on Original Size feature (Scan 
Options tab/Copy screen). Assign an original size to each of the eleven buttons; Auto Size 
Detect cannot be selected.

You can also use this feature for assigning nonstandard paper sizes. This is advantageous when 
you are frequently copying nonstandard size originals. By presetting a nonstandard size, it is 
not necessary to enter the original size each time a copy is made.
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Use the following procedure for assigning default original sizes to the eleven buttons.

1. From the Copy Service Settings screen, select Original Size Defaults.

2. Select the item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

3. Select the item to be changed.

4. Select the desired setting for that item and select Save.
5. Repeat Steps 1-4 for all eleven options.
6. From the Original Size Defaults screen, select Close.

This returns you to the Copy Service Settings screen.
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Original Size Defaults options

For each of the eleven buttons you can select one of the following options:

A/B Series Size

If you select this option, you can then select from ten different A/B- series sizes.

Inch Size

If you select this option, you can then select from twelve different inch-series sizes.

Others

If you select this option, you can then select from thirteen other sizes.

Custom Size

If you select this option, you can enter any size. Set the width between 15-432 mm, and the 
height between 15-297 mm, in 1 mm increments.

Reduce/Enlarge Presets

From this screen you can select the default magnification levels. The selections made here 
appear on the Preset% feature on the Reduce/Enlarge section (More button) on the Copy 
screen; refer to the below illustration.
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Use the following procedure to assign default magnification levels to the Reduce/Enlarge 
buttons.

1. From the Copy Service Settings screen, select Reduce/Enlarge Presets.

2. Select the item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

3. Select the desired setting for that R/E Preset.

4. Select Save; you are returned to the Reduce/Enlarge Presets screen.
5. Repeat Steps 1-4 until you have assigned a magnification level to each of the R/E Presets.
6. Select Close to return to the Copy Service Settings screen.
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Connectivity & Network Setup
In Connectivity & Network Setup, you select the default network settings by which the 
machine is connected and communicates to the client PCs and the parameters required for the 
communications between the machine and its networked clients.

Note
When using CentreWare Internet Services, more detailed settings are possible. For more details, 
Using CentreWare Internet Services on page 3-1,” and other sections of this guide (CentreWare 
Internet Services on page 1-5 and CentreWare Internet Services on page 7-2).

1. From the System Settings screen, select Connectivity & Network Setup.

2. Select the item to be set or changed. 
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Port Settings

Select the interface by which the machine is connected to the client. In Port Settings, you can 
set the following items:

Protocol Settings

Select the parameters that are required for communications between the machine and client 
workstations. In Protocol Settings, you can set the following items.

Machine E-mail Address/Host Name

Select the e-mail address and host name for this machine. In Machine E-mail Address/Host 
Name, you can set the following items:

1. E-mail Address
2. Machine Name
3. Host Name
4. Domain Name

LPD Receive E-mail

NetWare Send E-mail

SMB E-mail Notification Service

IPP UPnP Discovery

EtherTalk WSD

Bonjour Internet Services (HTTP)

Port9100 SOAP

SNMP WebDAV

FTP Client

Ethernet Rated Speed IPv6 Address Manual Configuration

TCP/IP - IP Mode Manually Configured IPv6 Address

IPv4 - IP Address Resolution Manually Configured IPv6 Address Prefix

IPv4 - IP Address Manually Configured IPv6 Gateway

IPv4 - Subnet Mask Automatically Configured IPv6 Address

IPv4 - Gateway Address IPv6 - IP Filter

IPv4 - IP Filter
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Proxy Server Settings

Select the Proxy Server Settings. In Proxy Server Settings, you can set the following items:

Outcoming/Incoming E-mail Settings

POP3 Server Settings

Select the POP3 server. In POP3 Server Settings, you can set the following items:

SMTP Server Settings

Select the SMTP server. In SMTP Server Settings, you can set the following items:

Domain Filter

Select the accepted domains for this machine. In Domain Filter, you can set the following 
items:

Use Proxy Server HTTP Proxy Server Password

Proxy Server Setup HTTPS Proxy Server Name

Addresses to Bypass Proxy Server HTTPS Proxy Server Port Number

HTTP Proxy Server Name HTTPS Proxy Server Authentication

HTTP Proxy Server Port Number HTTPS Proxy Server Login Name

HTTP Proxy Server Authentication

HTTPS Proxy Server PasswordHTTP Proxy Server Login Name

1. Server Name/IP Address 4. Login Name

2. Port Number 5. Password

3. Polling Interval 6. POP Password Encryption

SMPT Server Name/IP Address Login Credentials for Sending E-mails

SMPT Port Number SMPT Login Name

E-mail Send Authentication SMTP AUTH Password

1. Domain Filtering 2-51 Domains 1 to 50
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Remote Authentication Server Settings

This feature sets the remote authentication server; a maximum of five servers can be set.

Note
This feature does not appear for some models. An optional package is necessary. For more 
information, contact our Customer Support Center.

1. Select Remote Authentication Server Settings.

2. Select Authentication System and then Change Settings.
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3. Select Authentication System.

4. You can select the system for authentication from Kebros (Windows2000) or Kebros 
(Solaris), LDAP, SMB, or Authentication Agent.

Kerberos Server Settings
1. Select Kerberos Server Settings.

2. Select a Kerberos Server.
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3. Select Change Settings.

4. In Kerberos Server Settings, you can set the following items:
• 1. Primary Server Name/Address
• 2. Primary Server Port Number
• 3. Secondary Server Name/Address
• 4. Secondary Server Port Number
• 5. Domain Name

5. Repeat steps 1 through 4 for any additional servers.

SMB Server Settings
1. Select SMB Server Settings.
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2. Select SMB Server Setup.

3. Select By Domain Name or By Domain & Server Names/IP Address and press Save.

4. Select an SMB Server.
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5. Select Change Settings.

6. In SMB Server Settings, you can set the Domain Name and the Server Name/IP Address.
7. Repeat steps 1 - 6 for any additional servers.

Security Settings

SSL/TLS Settings

If this feature is enabled, data between the machine and networked computers can be 
encrypted using HTTP.

Use the following procedure to access and change the SSL/TLS Settings:

1. From the System Settings screen, select Connectivity & Network Setup and then select 
Security Settings.
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2. Select SSL/TLS Settings.

3. Select the item to be set or changed, and select Change Settings. 

4. Select the desired setting or enter the desired value.
5. Press Save.
6. Press Close to return to the Security Settings screen.
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S/MIME Settings

Use the following procedure to access and change the S/MIME Settings:

1. From the Security Settings screen, select S/MIME Settings.
2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting or enter the desired value.
4. Press Save.
5. Press Close to return to the Security Settings screen.

PDF/XPS Signature Settings

Use the following procedure to access and change the PDF/XPS Signature Settings:

1. From the Security Settings screen, select PDF/XPS Signature Settings.
2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting or enter the desired value.
4. Press Save.
5. Press Close to return to the Security Settings screen.
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IPSec Settings

Use the following procedure to access and change the IPSec Settings:

1. From the Security Settings screen, select IPSec Settings.
2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting or enter the desired value.
4. Press Save.
5. Press Close to return to the Security Settings screen.

IEEE 802.1x Settings

Use the following procedure to access and change the IEEE 802.1x Settings:

1. From the Security Settings screen, select IEEE 802.1x Settings.
2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting or enter the desired value.
4. Press Save.
5. Press Close to return to the Security Settings screen.
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Certificate Revocation Retrieval Settings

Use the following procedure to access and change the Certificate Revocation Retrieval Settings:

1. From the Security Settings screen, select Certificate Revocation Retrieval Settings.
2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting or enter the desired value.
4. Press Save.
5. Press Close to return to the Security Settings screen.

Other Settings

Other Settings allows you to choose from a variety of options within the Connectivity Network 
Setup structure.

E-mail Receive Protocol

The E-mail Receive Protocol setting allows you to select between the following options;

• SMTP: Simple Mail Transfer Protocol (or SMTP) is a networking protocol used for sending e-
mail messages between servers. Most e-mail systems that send e-mail over the Internet use 
SMTP to send messages from one server to another; the messages then can be received 
with an e-mail client using either POP or IMAP.

• POP3: Post Office Protocol (or POP) is used to receive e-mail from a mail server. POP3 is a 
newer version of the protocol, and can be used with or without SMTP.

Add Domain Name to User Name

The Add Domain Name to User Name feature allows you to add your user name onto the 
domain name associated. For example, if your domain name was: na.xerox.net and your user 
name is: joe then the following example would be: joe.na.xerox.net

Choose from the following options;

• Off: Selecting this option disables this feature.

• On: Selecting this feature enables this feature and allows you to add your Domain name to 
the User name.
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FTP Server Login Name

The FTP Server Login Name feature allows you to enter in your FTP Server name via the 
keyboard on the machine UI screen.

FTP Server Password

The FTP Server Password feature allows you to enter in your FTP server password via the 
keyboard on the machine UI screen.

Folder Backup Tool - IP Address

The Folder Backup Tool - IP Address feature allows you to enter in the IP address of the server 
where Folder Backup Tool resides. This is done by using the keyboard on the machine UI screen. 
This feature, when enabled, allows you to backup all folder information including files that 
reside on the machine to a remote PC client.

Print Service Settings
In Print Service Settings, you select settings that relate to the machine’s memory and 
miscellaneous features, including tray substitution, paper type mismatch, printing a banner 
sheet, and more.

Note
When using CentreWare Internet Services, more detailed settings are possible. For more details, 
refer to CentreWare Internet Services on page 7-2.

Use the following procedure to access and change the various Print Mode Settings.

1. From the System Settings screen, select Print Service Settings and select the item to be 
set.
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Allocate Memory

For each interface, you can select the memory capacity for the receiving buffer (temporary 
storage for data sent from the client). You can change the receiving buffer capacity depending 
on the pattern of use and purpose. Increasing the receiving buffer capacity may allow a client 
to be released sooner from an interface.

Tip
If you change the memory capacity settings, the memory is reset, and therefore data stored in 
all memory areas is lost.

Note
It is not possible to assign more than the total memory. When the power is turned on, if the 
settings exceed the available memory capacity, they are automatically adjusted by the system.

1. From the System Settings screen, select Allocate Memory.

2. Select the item to be set or changed, and select Change Settings.
3. Select the desired value for that item.
4. Select Save; you are returned to the Print Service Settings screen.

Note
When a port is set to Disabled, the corresponding items that are associated with that port do 
not appear.

Note
Depending on the amount of data sent from the client, increasing the memory capacity may 
not change the amount of time that it takes to release the client.

PostScript Memory

Specify the memory capacity used for PostScript. Set a value from 8.00-96.00 MB, in 0.25 MB 
increments.

HP-GL/2 Auto Layout Memory

Specify the memory capacity used for HP-GL/2. Set a value from 64-5120 KB, in 32 KB 
increments.

Note
The maximum value that can be set for both the PostScript Memory and HP-GL/2 Auto Layout 
Memory options vary according to the available memory capacity.
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Receiving Buffer - LPD Spool
• Off: When Off is selected, the machine will not use spooling. During the LPD print process 

for one client, data cannot be received over that same interface from a different client. Set 
a value for the dedicated LPD receiving buffer memory capacity from 1024-2048 KB, in 32 
KB increments.

• Memory Spool: When selected, the machine will use spooling. The receiving buffer for 
spooling uses memory. When this candidate value is selected, set the memory capacity of 
the receiving buffer for spooling, from 0.50 MB to 32.00 MB, in 0.25 MB increments.

Note
Notice that print data exceeding the set memory capacity is not accepted. In such cases, select 
Hard Disk or Off.

• Hard Disk Spool: When selected, the machine will use spooling. The receiving buffer for 
spooling uses the hard disk.

Receiving Buffer - NetWare

Set the NetWare receiving buffer. Set a value from 64 to 1024 KB, in 32 KB increments.

Receiving Buffer - SMB Spool
• Off: When Off is selected, the machine will not use spooling. While SMB print processing is 

being carried out for one client, data cannot be received over the same interface from 
another client.

Set a value for the dedicated SMB receiving buffer memory capacity from 64 to 1024 KB, in 
32 KB increments.

• Memory Spool: When selected, the machine will use spooling. The receiving buffer for 
spooling uses memory. When this candidate value is selected, set the memory capacity of 
the receiving buffer for spooling from 0.50 MB to 32.00 MB, in 0.25 MB increments.

Note
Notice that print data exceeding the set memory capacity is not accepted. In such cases, select 
Hard Disk or Off.

• Hard Disk Spool: When selected, the machine will use spooling. The receiving buffer for 
spooling uses the hard disk.

Receiving Buffer - IPP Spool
• Off: When Off is selected, the machine will not use spooling. While IPP print processing is 

being carried out for one client, data cannot be received over the same interface from 
another client. Set a value for the dedicated IPP receiving buffer memory capacity from 64 
to 1024 KB, in 32 KB increments.

• Hard Disk: When selected, the machine will use spooling. The receiving buffer for spooling 
uses the hard disk.

Receiving Buffer - EtherTalk

Set the EtherTalk receiving buffer. Set a value from 1024 to 2048 KB, in 32 KB increments.

Receiving Buffer - Port 9100

Set the Port9100 receiving buffer. Set a value from 64 to 1024 KB, in 32 KB increments.
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Delete Form
1. From the System Settings screen, select Delete Form.

2. Select the form type and number, and select Confirm.
3. Select Delete Data.
4. Select Close; you are returned to the Print Service Settings screen.

Other Settings
Note
For information about each of the following items, refer to Overview of features on page 7-1, 
and also refer to the appropriate chapter (see the Table of contents) in the PostScript User 
Guide.

Make settings relating to the paper used in the machine.

1. Select Other Settings.

2. Select the item to be set or changed, and select Change Settings.
3. Select the item to be changed.
4. Select Save.

Print Area

Select whether or not to expand the print area.
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Note
For information about the print area, refer to the section entitled Printable Area of Chapter 13 
of the User Guide.

Substitute Tray

When there is no tray containing the paper size selected by the automatic tray selection, select 
whether or not to print replaced with paper loaded in another paper tray. In the event of using 
substitute tray, set the size.

• Display Message: Do not use substitute tray, but display a paper loading message.

• Use Larger Size: Replace with the next larger paper size than that selected, and print at 
the same size.

• Use Closest Size: Replace with the closest paper size to that selected, and print. If 
necessary, the printing is automatically reduced in size.

Note
If there is a client specification, the client specification takes precedence.

• Select Tray 5 (Bypass): Prints on the paper loaded in tray 5 (Bypass).

Paper Type Mismatch

Set the action to be taken when the paper type loaded in the paper tray does not match that 
specified.

• Print: Carry on printing, even if the paper type is different.

• Display Confirmation Screen: Show a confirmation screen, and prompt for action.

• Display Paper Supply Screen: This selection shows the Paper Supply screen when a paper 
type mismatch occurs.

Unregistered Forms

When a form specified for printing in a form data file (overlay printing) is not present on the 
host computer, select whether or not to print the job. If you select Print and the specified form 
is not present, only the data is printed.

This setting is added to the print settings menu when there is a print specification from the host 
computer.

Print User ID

When printing by a print driver, select whether or not to print the user authentication 
information to the paper for the purpose distinguishing the identity of the user. A maximum of 
64 characters can be printed in the user ID information.

Select from one of the following: Off, Top Left, Top Right, Bottom Left, and Bottom Right.

Note
To use the ID Print feature, the User ID, set by the printer driver, is necessary beforehand. For 
the configuration procedure, refer to the online help for the printer driver.

Note
If the user ID information cannot be acquired, the words “Unknown User” are printed.
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Banner Sheet

Select whether or not the banner sheets will be used to separate different output jobs. Select 
one of the following:

• Off: Do not print banner sheets.

• Start Sheet: Print a banner sheet before a print job.

• End Sheet: Print a banner sheet after a print job.

• Start Sheet & End sheet: Print a banner sheet both before and after a print job.

Note
Even if the stapler feature is enabled, banner sheets are not stapled.

Note
On a print job from a Macintosh, the document name does not appear on the banner sheet.

Note
When printing banner sheets, they are counted for metering purposes.

Banner Sheet Offset 

Select whether or not to offset the banner sheet from the rest of the printed set. Select Offset 
or No Offset.

Banner Sheet Tray

Select the paper tray from which the banner sheets are printed. Select one of the following 
trays: 1, 2, 3, 4, or optional 6 and 7. 

Separator Tray

Select the paper tray from which separator pages are inserted from. Select one of the following 
trays: 1, 2, 3, 4, 5, 6, 7, and 8.

PostScript Paper Supply

Select whether or not to enable the PostScript DMS (Deferred Media Selection) feature. Select 
either Auto or Select Paper Tray.

PostScript Font Absence

Select how the machine will handle a specified PostScript font that is not loaded on the 
machine.

• Cancel Printing: This selection cancels the job without printing it.

• Substitute Font and Print: This selection continues printing the job and uses a substitute 
font in place of the missing font.

PostScript Font Substitution

When a PostScript font specified in a job is not present, select whether or not to use ATCx for the 
substitute font.
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XPS Print Ticket Processing

The XPS Print Ticket feature processes the print ticket information written in XPS documents 
through the use of the Xerox ContentsBridge Utility. This utility enables printing for users who 
do not have the corresponding application on their Windows-XP based computer, to open the 
print job. The Xerox ContentsBridge Utility is a Windows-based software utility used to print 
files directly to a printer without having to open files. Select one of the following;

• Off: Selecting this option does not allow for print ticket processing.

• Standard Mode: This selection uses the standard mode of processing.

• Compatible Mode: This selection uses Microsoft-compliant mode to process print tickets.

Note
XPS stands for XML Paper Specification.

Note
The Xerox ContentsBridge Utility can only be used for supported Xerox printers. All other brands 
will appear on your network, but will not be operable.

Note
The Xerox ContensBridge Utility only supports the following file formats:.pdf, .tif, .tiff, .xdw, .ps, 
and .prn.

LPD Print Queue

LPD Print Queue is a platform-independent printing protocol that runs over TCP/IP. LPD (or Line 
Printer Daemon) refers to the process that accepts print jobs from the line printer daemon client 
(LPR client). This is analogous to the printer software and is often called “LPD server.”

The print server waits for the client to send a job. A print server may be capable of handling 
multiple printers and print queues at once. Since it (usually) has a single IP address, the queue 
name must be used to specify the intended print queue.

Select one of the following;

• Data Process Order

• Job Submission Order
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Scan Service Settings
This feature allows you to select settings that relate to the scanner feature.

Note
When using CentreWare Internet Services, more detailed settings are possible. For more details, 
refer to CentreWare Internet Services on page 7-2.

1. From the System Settings screen, select Scan Service Settings select the item to be set or 
changed.

Scan Defaults

In Scan Defaults, you select the default values for the scanner feature. When one of the 
following occurs, the machine returns to its preset scan defaults:

• The machine power is switched on,

• The machine returns from a power-saving mode, or

• The Clear All button is pressed.

The settings selected for Scan Defaults are valid after switching off and switching on the 
machine’s power.

1. From the Scan Mode Settings screen, select Scan Defaults.
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Note
If you have the optional color scanner, some of the selections will be different as noted below. 

2. Select the item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

3. Select the default setting for that item.
4. Select Save; you are returned to the Scan Defaults screen.
5. Repeat Steps 1-4 for the remaining Scan Defaults features.
6. Upon completion, select Close; you are returned to the Scan Mode Settings screen.

Color Scanning (with optional Color Scanner kit only)

Select the default value for Color Scanning in the Basic Scanning Tab screen. With the optional 
color scanner, select one of the following: Auto Detect, Color, Grayscale, or Black & White.

Original Type

Select the default value for Original Type in the Basic Scanning Tab screen. Select one of the 
following: Text & Photo, Text, or Photo.

File Format

Select the default value for FIle Format feature (as displayed on the Basic Scanning Tab 
screen). Select one of the following: TIFF, Single-page TIFF, or PDF.

File Format (with optional Color Scanner kit only)

Select the default value for FIle Format feature (as displayed on the Basic Scanning Tab 
screen). With the optional color scanner, select one of the following: TIFF/JPEG Auto Select, 
Multi-page TIFF, Single-page TIFF, or PDF.

Optimize PDF for fast web

If you select one of the PDF file format options, the Optimize PDF for Fast Web View option is 
available for selection.

Note
The Optimize PDF for Fast Web View feature allows the user to open and view the first page of 
a multi-page PDF document within a web browser, while the remainder of the document 
continues to load in the background. This may increase the overall file size. Fast Web View 
restructures an Adobe PDF document for page-at-a-time downloading (byte-serving) from web 
servers. With page-at-a-time downloading, the web server sends only the requested page, rather 
than the entire PDF document. This is especially important with large documents that can take 
a long time to download from a server. 

Check with your web master to make sure that the web server software you use supports page-
at-time downloading. To ensure that the PDF documents on your website appear in older 
browsers, you may also want to create HTML links (versus ASP scripts or the POST method) to 
the PDF documents and keep path names--or URLs--to the files at less than 256 characters.
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Lighten/Darken

Select the default value for Lighten/Darken/Contrast (as displayed on the Lighten/Darken 
feature on the Image Quality screen). Select one of the following: Lighter (+3), Lighter (+2), 
Lighter (+1), Normal, Darker (+1), Darker (+2), or Darker (+3).

Contrast (with optional Color Scanner kit only)

Select the default value for Contrast (as displayed on the Image Quality screen). With the 
optional color scanner, select one of the following: Higher, High, Normal, Low, or Lower.

Sharpness

Select the default value for Sharpness (as displayed on the Image Quality screen). Select one 
of the following: Sharper, Sharp, Normal, Soft, or Softer.

Auto Exposure

Select the default value for Auto Exposure (as displayed on the Image Quality screen). Select 
either Off or On.

Background Suppression (with optional Color Scanner kit only)

Select the default value for Background Suppression (as displayed on the Image Quality 
screen). With the optional color scanner, select either Off or On.

Shadow Suppression 
Select the default value for No Suppression or Suppression

Color Space (with optional Color Scanner kit only)

Select the default value for Color Space. With the optional color scanner, select either 
Standard Color Space or Device Color Space.

Original Orientation

Select the default value for Original Orientation position of originals when scanning. Select 
either Head to Top ( ) or Head to Left ( ).

Resolution

Select the default value for Scan Resolution in the Scan Options screen. Select one of the 
following: 200 dpi, 300 dpi, 400 dpi, or 600 dpi.

Mixed Size Originals

Select the default value for Mixed Size Originals (as displayed on the Scan Options 
screen). Select either Off or On.
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Edge Erase

Select the default value for Edge Erase (as displayed on the Scan Options screen). Select either 
All Edges or Parallel Edges.

Edge Erase - Top & Bottom Edges

Select the default value for the amount of edge erased from the original in the top and bottom 
directions in Edge Erase (as displayed on the Scan Options screen). Select a value between 0-
50 mm, 1 mm increments.

Edge Erase - Left & Right

Select the default value for the amount of edge erased from the original in the left and right 
directions in Edge Erase (as displayed on the Scan Options screen). Select a value between 0-
50 mm, in 1 mm increments.

Quality/File Size

Select the Quality and file size from four options ranging from Quality: Normal, File Size: Small 
to Quality: Maximum, File Size: Largest.

E-mail Subject

Type in E-mail Subject

Optical Character Recognition (OCR)

Select either Off or On.

Language To Identify

Select either Auto, English, Spanish, or French.

OCR - Text Compression

Select either Off or On.



Setups

9-142  System Administration Guide
Xerox 4112/4127 Copier/Printer

Scan-to PC Defaults

You can select the default protocol that is used for file transfer from FTP, SMB, and SMB (UNC 
format).

1. From the Scan Services Settings screen, select Scan to PC Defaults.

2. Select the item to be set or changed.
3. Select Change Settings.
4. Select the default settings for the selected item.
5. Select Save; you are returned to the Scan-to PC Defaults screen.
6. Select Close to return to the Scan Service Settings screen.

Transfer Protocol 

Select the default value for the transfer protocol. Select either FTP, SMB, or SMB (VNC Format)

Login Credential to Access Destination 

Select the default value for the login credentials. Select either None or Remotely Authorized 
User.

User Name for FTP Scan 

Select the default value for the User Name for FTP Scan. 
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Original Size Defaults

Select the original size shown (as displayed on the Original Size option on the Layout 
Adjustment tab). Assign an original size to each of the seventeen buttons (except the Auto 
Detect button). If you frequently scan nonstandard size originals, presetting a nonstandard 
size eliminates the need to enter the original size each time a scan is made.

1. From the Scan Service Settings screen, select Original Size Defaults.

2. Select the item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

3. Select the desired setting.

4. Select Save; you are returned to the Original Size Defaults screen.
5. Repeat Steps 1-4 for each Original Size Defaults option.
6. Select Close from the Original Size Defaults screen to return to the Scan Service Settings 

screen.

A/B Series Size

Select from ten different A- and B-series sizes.

Inch Size

Select from twelve different inch-series sizes.



Setups

9-144  System Administration Guide
Xerox 4112/4127 Copier/Printer

More

Select from thirteen other sizes.

Custom Size

Enter any size. Set the width between 15-432 mm, and the height between 15-297 mm, in 1 
mm increments.

Output Size Defaults

Select the sizes that will be displayed as the Output Size when selecting Auto% for scanning 
documents (as displayed on Reduce/Enlarge feature on the Scan Options screen). Any output 
sizes can be assigned to output size buttons 1-8. By selecting commonly used sizes, you can 
reduce the number of selection operations required for a scan job.

1. From the Scan Service Settings screen, select Output Size Defaults.

2. Select the item to be set or changed, and select Change Settings.

Note
Select s to display the previous screen and select t to display the next screen.

3. Select the desired setting.

4. Select Save; you are returned to the Output Size Defaults screen.
5. Repeat Steps 1-4 for the remaining Output Size Defaults items.



Setups

Xerox 4112/4127 Copier/Printer 9-145
System Administration Guide

6. Select Close from the Output Size Defaults screen; you are returned to the Scan Mode 
Settings screen.

A/B Series Size

Select from ten different A- and B-series sizes.

Inch Size

Select from twelve different inch-series sizes.

Others

Select from thirteen other sizes.

Reduce/Enlarge Presets

Select the magnification levels as shown in the Preset% option (as displayed on the Reduce/
Enlarge feature on the Scan Options screen). Assign any magnification to the Reduce/Enlarge 
Preset buttons 1-7; you cannot select 100%.

1. From the Scan Mode Settings screen, select Reduce/Enlarge Presets.
2. Select the item to be set or changed, and select Change Settings.

Note

Select  to display the previous screen and select  to display the next screen.



Setups

9-146  System Administration Guide
Xerox 4112/4127 Copier/Printer

3. Select Preset% or Variable%.

4. Select the desired setting.
5. Select Save.
6. Repeat Steps 1-5 for each of the R/E Presets items.
7. From the Reduce/Enlarge Presets screen, select Close to return to the Scan Mode Settings 

screen.

Preset%

Select from twenty-five standard magnification ratios.

Variable%

Select any magnification level. Specify a value from 25% to 400%, in 1% increments.

Other Settings

These settings relate to the scanner feature specification.

1. From the Scan Mode Settings screen, select Other Settings.
2. Select the item to be set or changed, and select Change Settings.

Note
If you have the optional color scanner, you will have additional selections as noted below.

3. Select the desired setting for that item.
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4. Select Save.
5. Repeat Steps 1-4 for the remaining Other Settings items.
6. From the Other Settings screen, select Close to return to the Scan Mode Settings screen.

Memory Full Procedure

Select either Delete Job or Run Job as the default setting. This default setting appears while 
scanning an original if there is insufficient hard disk space for the scanner. If an insufficient 
amount of hard disk space is determined, a confirmation screen appears asking how the 
partially stored data should be handled (cancel job or run job).

• Delete Job: The stored data is discarded.

• Run Job: The partially stored data is treated as valid and complete, the job is run.

If the user does not respond to the confirmation screen and a predetermined amount of time 
elapses, the machine automatically processes the partially-stored data according to the default 
setting selected here.

Note
You can set the time limit that occurs between the confirmation screen and the automatic 
processing of the stored data. For more information, refer to Auto Job Release on page 9-10.

Maximum Stored Pages

Select the maximum number of stored pages of a scan original. Select between 1-999 pages.

Color Saturation (with optional Color Scanner kit only)

Select the amount of color saturation for scanned data. Select from Lower, Low, Normal, High, 
or Higher.

Auto Exposure Level (with optional Color Scanner kit only)

Select the Auto Exposure Level for scanned data. Select from Normal, High (+1), Higher (+2), 
Higher (+3), or Higher (+4).

Background Suppression Level (with optional Color Scanner kit only)

Select the amount of background suppression for scanned data. Select from Higher +1, HIgher 
+2, Normal, Lower -1, or Lower -2.

Color Space (with optional Color Scanner kit only)

Select if color space is to be enabled for scanned data. Select either Disabled or Enabled.

TIFF Format

Select the TIFF format for scanned data. Select either TIFF V6 or TTN2.

Image Transfer Screen

Select whether or not to display a message when the scan process is completed.

• Disabled: Do not show a scan completion message.
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• Display Message Only: Show a scan completion message.

• Display Message and Screen: Show a screen while scanning an original and upon 
completion of the scan process.

OCR - Page Orientation

Select either Auto Upright Orientation or According to Original Orientation.

E-mail Service Settings
1. From the System Settings screen, select E-mail Settings, then select E-Mail Control.

2. From the E-mail Control screen, select the item to be set or changed, and select Change 
Settings.

3. Select the desired setting.
4. Select Save.
5. Repeat Steps 1-4 for the remaining items.
6. From the Other Settings screen, select Close to return to the E-mail Settings screen.

Maximum E-mail Size

Select whether or not to set an upper limit on the data size in e-mail transmissions:

• Off: There is no limit on data size.

• On: Set an upper limit on data size. Set a value between 50-65535 KB, in 1 KB increments.

Note
If the set value is exceeded, the e-mail transmission is aborted.

Maximum Address Entries

Set the maximum number of addressees that can be specified when sending an e-mail. The 
number of addressees is the total number in the To:/Cc:/Bcc: field. Set the maximum number 
of addressees in the range of 1-100. If the maximum number of addressees is exceeded, the e-
mail transmission is aborted.
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Incoming E-mail Print Options

When the machine’s e-mail address receives an e-mail, you can select the type of print 
operation:

• Attachment: Only the attached document is printed.

• Full headers and contents: The e-mail headers and body of the e-mail are printed.

• Basic headers and contents: This prints some e-mail headers (From/To/Subject/Date) 
and the e-mail body.

• Auto Print: If the e-mail body is not empty, this prints the e-mail headers and e-mail body.

Print Error Notification E-Mail

Select whether or not to automatically print an error e-mail resulting from an incorrect address 
or transmission error. Select either Off or On.

Response to Read Receipts

Select whether or not to respond when the machine receives a read receipt request from a client 
workstation:

• Off: Do not respond.

• On: Automatically notify that the e-mail has been opened.

Read Receipts

When an e-mail is sent from the machine, select whether or not a dialog box should open 
requesting the recipient to return the read status:

• Off: The read receipts feature cannot be used.

• On: All users are permitted to use the read receipts feature.

Print Delivery Confirmation Mail

Select whether or not to automatically print e-mail transmission results (DSN response/MDN 
response):

• Off: E-mail transmission results are automatically printed.

• On: E-mail transmission results are not automatically printed.

• Print when delivery fails: Prints only when the transmission fails.

Max number of pages for Max Number of pages per Split Send

Select whether or not to split the attachment data into pages for transmission. When the “split 
for transmission” option is selected, set the number of pages.

Tip
It is possible to split into multiple-page files only when the output file format is specified as 
PDF, DocuWorks or multiple-page TIFF.
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1. From the E-Mail Control screen, select Max Number of pages per Split Send.

2. Select Off or On.
• When On is selected, set the number of pages.

– Off: The attachment data is not split for transmission.

– On: Set a value between 1-999 pages, in 1 page increments.

3. Select Save; you are returned to the E-Mail Control screen.
4. Select Close to return to the E-mail Settings screen.
5. Select Close to return to the System Settings screen.

Allow Casual Users to Edit From Field

Select whether or not to Allow Casual Users to Edit From Field:

• Yes

• No

Allow Guest Users to Edit From Field

Select whether or not to Allow Guest Users to Edit From Field:

• Yes

• No

Allow to Edit From if Search Found

Select whether or not to Allow Edit From if Search Found:

• Yes

• No

Allow to Edit From if Search Failed

Select whether or not to Allow Edit From if Search Failed:

• Yes

• No
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E-Mail Sending When Search Failed

Select whether or not to automatically send an E-mail if Search Failed:

• Enabled

• Disabled

Add Me to To Field

Select whether or not to automatically add yourself to the To field:

• Yes

• No

Add Me to CC Field

Select whether or not to automatically add yourself to the To CC field:

• Yes

• No

Edit E-Mail Receipts

Select whether or not to allow the editing of E-mail receipts:

• Yes

• No

Folder Service Settings

In Folder Settings, make the settings for handling of documents stored in folders. 

1. From the System Settings screen, select Folder Service Settings.
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2. Select the item to be set or changed, and select Change Settings.

3. Select the desired setting.
4. Select Save; you are returned to the Folder Settings screen.

Documents Retrieved By Client

Select whether or not to delete a document stored in the folder when it is retrieved by the client.

Note
This feature does note appear on some models. An optional package is necessary. For more 
information, contact the Customer Support Center.

Folder specified

Documents are saved or deleted based on the settings selected for each individual folder.

Note
For details about folder settings, refer to Delete Documents After Retrieval on page 9-159.

Force Delete

Ignore the settings for each individual folder, and when a document is retrieved from a folder, 
forcibly delete it.
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Print & Delete Confirmation Screen

Select whether or not to print and delete a document stored in the folder.

Job Flow Service Settings

In Job Flow Service Settings, make the settings for the Pool Server or Local Machine. 

1. From the System Settings screen, select Job Flow Service Settings.

2. Select the item to be set or changed, and select Change Settings.
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Pool Server

Select whether or not to enable the Pool Server:

Pool Server Login Method

Select Show login screen or Automatically log in.

Job Flow Sheet List Default

Select Local Machine or Pool Server.

Stored File Settings
In Stored File Settings, make the settings for handling of documents stored in folders. 

1. From the System Settings screen, select Stored File Settings. 

2. Select the item to be set or changed, and select Change Settings. 

3. Select the desired setting.
4. Press Save.
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Folder Document Expiration Date

In Stored Document Settings, make the settings for handling of documents stored in folders.

1. From the Stored Document Settings screen, select Folder Document Expiration Date, 
and select Change Settings. 

2. Select Off or On.
If you selected On, set the storage period, and the time of deletion using the numeric 
keypad.

Documents kept for
Set the document storage period in the range of 1 to 14 days.

Documents deleted at
Set the time for the document to be deleted after the storage period has expired; select 
from 0 to 23 hours and 00 to 59 minutes.

Note
When a storage period is set, ensure that the folder feature “Delete Documents with Expiry 
Date” is Enabled. For more information, refer to Delete Expired Documents on page 9-159.

3. Select Save; you are returned to the Stored Document Settings screen.
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Stored Document Expiration Date

In Stored Document Settings, make the settings for handling of documents stored in folders.

1. From the Stored Document Settings screen, select Stored Document Expiration Date, 
and select Change Settings. 

2. Select Off, On or Same Date as Folder Document.
If you selected On, set the storage period, and the time of deletion using the numeric 
keypad.

Documents kept for
Set the document storage period in the range of 4 to 23 hours.

Minimum Passcode Length for Stored Jobs

In Stored Document Settings, make the settings for handling of documents stored in folders.

1. From the Stored Document Settings screen, select Minimum Passcode Length for Stored 
Jobs, and select Change Settings. 

2. Set the Minimum Passcode Length for Stored Jobs up to 12 digits.
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Setup Menu

In Setup Menu, you can create folders and job flow, and create and update address book 
entries (mail scan).

1. From the System Settings screen, select Setup Menu and select the item to be created (or 
changed).

Create Folder

Register folders to store copied and scanned documents. A maximum of 500 boxes can be 
registered. For convenience purposes, you may want to make separate boxes for copied 
documents and for scanned documents. 

Note
Check the current folders in the “Folder list.” For more information, refer to the section entitled 
“Folder List” in Chapter 10 of the User Guide.

Use the following procedure for registering folders

1. From the Setup Menu screen, select Create Folder.

2. Select the box to be registered, and select Create/Delete.

Note
Select s to display the previous screen and select t to display the next screen.
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Note
By entering a three-digit number with the numeric keypad, you can go directly to a specific 
folder.

3. Select the item to be set, and select Change Settings.

4. Select the desired setting for that item.
a. If you are creating a new box, a password setting screen appears.

If you are not setting a password, select Off and Save.

a. When setting a password, select On, and enter the password.
Select Save.

5. Select Save; you are returned to the Folder Create/Delete screen.
6. Repeat Steps 1-5 for the remaining items.
7. Select Close from the Folder Create/Delete screen; you are returned to the Create Folder 

screen.

Delete Folder button

This deletes the selected folder. If there are documents in the folder, they are also deleted. 

Tip
Deleted documents cannot be recovered.
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Folder Name

Set the box name by using the keyboard and the numeric keypad; a maximum of 20 characters 
may be used.

Note
For information about entering text, refer to Entering Text on page 9-4.

Check Folder Passcode

Set the folder password. Enter up to 20 numeric digits (0 to 9). 

Note
The password setting is optional.

Delete Documents After Retrieval

Specify whether or not to enable the feature to delete documents stored in the selected folder 
at a specified time after a storage period has expired.

• Save: The document is stored.

• Delete: After the document is printed or retrieved by an external action, it is automatically 
deleted.

Delete Expired Documents

Specify whether or not to enable the feature to delete stored documents in a folder after a 
specified storage time period has expired.

• No: Does not delete documents even if a specified time period is set.

• Yes: Documents are deleted at a specified time after the storage period has expired.

Tip
The Document Expired Date option (System Settings/System Settings/Stored Document 
Settings) must be enabled and a specified date and time must be set in order for the above 
folder option to function. If the Document Expired Date option is not enabled, then an 
Enabled setting for the Delete Documents with Expiry Date is ignored and the documents are 
not deleted.

Note
For information about setting the document storage period, refer to Documents Retrieved By 
Client on page 9-152 and Folder Document Expiration Date on page 9-155.

Link Job Flow Sheet to Folder

You can associate a job flow sheet with a folder. By associating a job flow sheet with a 
previously registered folder, you can determine how documents stored in a folder are processed.

Note
For the method of registering a job flow, refer to Create Job Flow Sheets on page 9-161.

To link a job flow sheet to a registered folder, perform the following:

From the Folder Create/Delete screen, select Link Flow Sheet to Folder, and select Change 
Settings.
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• If a job flow sheet is not currently linked/associated to this folder, then the following screen 
appears:

• If a job flow sheet is already linked/associated to this folder, the following screen on 
appears.

• Cut Link: Disassociate the job flow from the folder.
• Create/Change Link: A screen for job flow association appears. You can select from the 

existing job flows or create a new job flow.

Note
For more information, refer to Create Job Flow Sheets on page 9-161.

• Auto Start: If you select the Auto Start check box, when a document is stored in the 
folder, the procedure registered in the job flow is automatically is started.

When the Delete Folder button is selected

This deletes the selected folder. If there are documents in the box, they are all deleted.

Tip
The deleted documents cannot be retrieved. When deleting a folder with more than 200 stored 
documents, delete the documents from the folder before deleting the folder. If multiple 
documents are deleted at once, it may take a while for them to be deleted (depending on size).
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Create Job Flow Sheets

The Job Flow feature executes a series of registered actions and works in conjunction with 
documents that are stored in a folder. A Job Flow is started in the following ways: 1) manually 
or automatically when a document is stored to a folder, or 2) by selecting a Job Flow to act on 
documents stored in the folder. 

To start a Job Flow, you must first link a folder with a specific Job Flow Sheet. When a job flow 
sheet is set to start automatically, documents are automatically processed by the Job Flow 
when they appear in the folder.

Note
To link a job flow created with Job Flow Sheets with a folder, start from Check Folder. For more 
details, refer to the section entitled “Configuring/Starting a Job Flow” in Chapter 5 of the User 
Guide.

Features that can be registered are listed below:

• Forwarding specification (FTP, SMB, E-mail)

• Multiple forwarding specifications, multiple processing execution

• Document deletion

Restrictions on using Job Flow

A job flow may be used by an individual, for shared users, or used only when linked with a 
particular folder. The authentication feature can be used to control access to job flow features.

Note
For information about the available job flow features and restrictions on use, refer to Create 
New Job Flow Sheet on page 9-162.

1. From the Setup Menu screen, select Job Flow Sheets.

2. Carry out the job flow operation.
• Select Keyword: Select a keyword from an already-existing list by touching the [Select 

Keyword] button, or select the [Create] button to create a new keyword.
• Sheet Filtering: you can filter the job flow display. The screen display depends on the 

user authentication feature settings.

– Select the filtering conditions; select one of the following: No Filtering, System 
Administrator, Non-System Administrator.
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– Select a Sheet Filtering Target, such as Folder, Scan Jobs, External Applications or 
Copy Jobs.

– Select Save.
• Create: The Create New Job Flow screen appears. For more information, refer to 

Create New Job Flow Sheet on page 9-162.
• Edit/Delete: The Details screen appears. For more information, refer to Details on 

page 9-167

Create New Job Flow Sheet

Use the following procedure to create a new job flow.

1. From the Job Flow Sheets screen, select Create. The Create New Job Flow Sheet screen 
opens.

2. Select the item to be changed and select Change Settings.
• Delete Settings: This deletes the setting values of all selected items.
• Change Settings: With this you can confirm or change the setting values of the 

selected items.
3. Select Change Settings.

Name

Set the name for the job flow, of up to 128 characters.

Description

Set the description of the job flow, of up to 256 characters.

Keyword
• Set a keyword of the job flow, of up to 12 characters.

• Create and/or set 15 keywords.
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Send E-mail

Specify the recipients for the e-mail. You can specify a total of up to 100 addresses. Select 
from the address book numbers or by direct input by using the keypad.

• Address Book: The recipients can be specified from address book. The specified recipient 
appears in Recipient Name/E-mail Address in the Send E-mail screen.

• Search for recipients

Note
For information about the operation, refer to the section entitled “Address Book” in Chapter 4 of 
the User Guide.

• New Recipient: Specify a new recipient. The specified recipient appears in Recipient 
Name/E-mail Address in the Mail Send screen.
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– Select the item you want to change, and select Change Settings to set.

– Subject: If desired, set a specific subject.

– Delete: This deletes all information for the selected recipients.

– Change Settings: Confirm or change the selected recipients.

Note
For information about the method for confirm/change, refer to Add Address Book Entry on page 
9-168.

• File Format: Specify the output file format.

• Resend Attempts: Select the number of e-mail resend attempts (1 - 5) and interval (30 - 
300 seconds).

Transfer via FTP (1) Transfer via FTP (2)
• Specify where to store forwarded FTP files.
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• Address Book: When the server address is registered in the address book, you can specify 
the address from the address book. The specified address appears in the FTP Transfer 
screen.

Note
For more about the address book, refer to Add Address Book Entry on page 9-168.

• Keyboard: Select one of Name, Server, Save in, User Name, or Password and press the 
Enter Details button to display an input screen.

The numbers of characters you can input are as follows.

• Name: 18 bytes maximum
• Server: 64 bytes maximum
• Save in: 128 bytes maximum
• User Name: 32 bytes maximum
• Password: 32 bytes maximum

Note
For more details, refer to Add Address Book Entry on page 9-168.

• Clear: This deletes all information for the selected addresses.

• Enter Details: Confirm or change the selected recipients.

Note
For information about the method for confirm/change, refer to Add Address Book Entry on page 
9-168.

• File Format: Specify the output file format.

• Resend Attempts: Select the number of e-mail resend attempts (1 - 5) and interval (30 - 
300 seconds).
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Transfer via SMB (1) Transfer via SMB (2)
• Specify where to store forwarded SMB files.

• Address Book: When the server address is registered in the address book, you can specify 
the address from the address book. The specified address appears in the SMB Transfer 
screen.

Note
For more about the address book, refer to Add Address Book Entry on page 9-168.

• Keyboard: Select one of Name, Server, Shared Name, Save in, User Name, or Password 
and press the button to display an input screen.

The numbers of characters you can input are as follows.

• Name: 18 bytes maximum
• Server: 64 bytes maximum
• Shared Name: 18 bytes maximum
• Save in: 128 bytes maximum
• User Name: 32 bytes maximum
• Password: 32 bytes maximum

Note
For more details, refer to Add Address Book Entry on page 9-168.

• Clear: This deletes all information for the selected addresses.

• Enter Details: You can confirm or change the selected recipients.



Setups

Xerox 4112/4127 Copier/Printer 9-167
System Administration Guide

Note
For information about the method for confirm/change, refer to Add Address Book Entry on page 
9-168.

• File Format: Specify the output file format.

• Resend Attempts: Select the number of e-mail resend attempts (1 - 5) and interval (30 - 
300 seconds).

Details

Use the following procedure to check the content of a job flow and modify/copy/delete the 
content.

1. Select a job flow, and select Edit/Delete.

2. Check the content.

3. Press the desired button.
• Delete: Deletes the selected job flow.
• Copy: This makes a copy of the selected job flow. From the copy of the job flow you 

can create a new job flow.

Note
The method of creation is the same as when creating a new job flow. For more details, refer to 
Create New Job Flow Sheet on page 9-162.

• Edit: Modify the selected job flow settings.
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Note
The method of modification is the same as when creating a new job flow. For more details, refer 
to Create New Job Flow Sheet on page 9-162.

• Full Description: Displays the description of Job Flow.

Create Job Flow Sheet Keyword

This feature is used to create up to 15 Job Flow Sheet Keywords.

1. Select Create Job Flow Sheet Keyword.

2. Select Create/Delete and create a keyword and press Save.

Add Address Book Entry

Store frequently used addresses in the address book. Select the type of address stored from e-
mail and server (FTP/SMB). When an address is registered, you can search for it with the 
Address Book in the E-mail screen. Store a total of 999 addresses, including e-mail addresses 
and server (FTP/SMB) addresses.

Note
If the optional Address Book Extension Kit is installed, you can register a maximum of 999 
locations. The address book of Scan to Folder displays email addresses, and Network Scanning 
displays server addresses.

1. From the Setup Menu screen, select Add Address Book Entry.
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2. Press the abbreviated number you want to register, and select Create/Delete.

Note

Select  to display the previous screen and select  to display the next screen.

Note
By entering a three-digit number with the numeric keypad, you can specify the abbreviated 
number directly. Select Address Type, and select Change Settings.

3. Select the address type, and select Save.

4. Select the item to be set, and select Change Settings.
5. When the settings are completed, select Save.

• Selecting Mail as the Address Type displays the following items:

• Selecting Server as the Address Type displays the following items:

Address Type

Change the address type with this option.

E-mail Address

Enter the e-mail address. There is a limit of 128 characters for an address. For information 
about entering text, refer to Entering Text on page 9-4.

Address Type Business Phone

E-mail Address Office

 Name Business Address

Given Name

Address Type Save in

 Name User Name

Transfer Protocol Password

Server Name/IP Address Port Number

Shared Name (SMB Only)
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Name

Enter the recipient. There is a limit of 18 characters. For information about entering text, refer 
to Entering Text on page 9-4.

Surname

Enter the last name of the recipient. There is a limit of 32 characters. For information about 
entering text, refer to Entering Text on page 9-4.

Given Name

Enter the first name of the recipient. There is a limit of 32 characters. For information about 
entering text, refer to Entering Text on page 9-4.

Business Phone

Enter the phone number. There is a limit of 32 characters. For information about entering text, 
refer to Entering Text on page 9-4.

Office

The attribute name set as Office is shown as the item name. Input any information as an 
auxiliary item, but only with a maximum of forty characters.

Business Address

The attribute name set as Business Address is shown as the item name. Input any information 
as an auxiliary item, but only with a maximum of sixty characters.

Transfer Protocol

Set the forwarding destination protocol. Select either FTP or SMB.

Server Name/IP address

Enter the recipient server name or IP address for transmission destination.

Shared Name (SMB Only)

Enter the shared name set for the SMB folder. Enter with the UNC format.

Tip
Do not start shared names with a backslash (/). If they start with a backslash (/), the machine 
will not identify them when processing job flows.

Save in

Enter the directory for storing documents.

• Forwarding via FTP

Example: To save the aaa directory located in the root directory when you log in into the 
bbb directory (aaa/bbb).
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• Forwarding via SMB

Example: To save the aaa directory with a specified volume (UNC format) in to the bbb 
directory (aaa\bbb).

User Name

When a login name is required to be input by the forwarding destination server, set the login 
name. For the login name, you can enter a maximum of 32 characters.

Password

When a password is required to be input by the forwarding destination server, set the 
password. For the password, you can enter a maximum of 32 characters.

Port Number

Set the forwarding destination port number. Input a number in the range 1 to 65535.

When the Delete Entry button is selected

This deletes all registered information for the selected address book entry. To delete all 
registered information for the selected address book entry, select Delete.

Tip
Deleted information cannot be recovered.

Paper Tray Attributes
Note
The Paper Tray Attributes appear in the Setup menu when enabled in Paper Tray Settings. See 
Chapter 9 Paper Tray Attributes on Setup Menu on page 9-29.

For setting the Paper Tray Attributes see Paper Tray Attributes on page 9-25.
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10Troubleshooting

SMB
This section describes the troubleshooting, notes and restrictions when using SMB.

Troubleshooting

The possible causes, check points, and remedies for problems when using SMB are as follows: 

When you cannot communicate with the printer

Cause Check point Remedy

The computer and the 
machine are using different 
protocols.

From Windows Start, Search and while 
searching for other computers, Windows 
cannot find Network Computer or the 
4112/4127Teak  copier/printer.

Configure the machine and 
each computer to use the 
same SMB operational 
protocol.

The machine and the 
computers belong to different 
networks (subnets).

From Windows Start, Search and while 
searching for other computers, Windows 
cannot find Network Computer or the 
4112/4127Teak copier/printer.

When the machine and the 
computers are on different 
networks, consult your 
network administrator.

The host name for the 
machine is already in use.

Print out the Printer Settings List to 
confirm if “Duplicate Host Name” is 
printed in the SMB status information.

Use the CentreWare Internet 
Services to change the host 
name to a unique name, or 
initialize the machine 
settings to the default 
settings.
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When you cannot print

You cannot delete documents from the Printer window.

Notes and Restrictions

The following are the notes and restrictions for using SMB:

Configuration on the Machine
• Take maximum care with the IP address settings. IP addresses are managed throughout 

the system as a whole. The configuration should be performed only after consulting with 
your network administrator.

• Subnet Mask and Gateway addresses may be necessary depending on the network 
environment. Confirm with the network administrator and set up the necessary items.

• When the port status is set to Enable, it sometimes automatically switches to Disable if the 
machine has insufficient memory. If this happens, either set an unused port to Disable, or 
adjust the assigned memory size.

• Adjust the receiving buffer SMB (Spool) size according to usage. When the receiving buffer 
SMB (Spool) size is smaller than the transmitted data, the machine may not be able to 
receive the data.

Cause Check point Remedy

The machine is processing a 
request from a different 
computer.
(Only when the machine is 
set to the Non-Spool 
mode)

Confirm the machine is processing a 
print job. (A write error dialog should be 
displayed to indicate that there is no 
room for the print queue available.)

Wait until the machine 
finishes processing the print 
job, or change the machine 
setting to Spool mode.

The number of connections 
to the machine exceeded 
the maximum connections 
allowed.

Confirm if the machine is processing 
simultaneous processing requests (print 
requests, status queries, etc.) from 
multiple computers. A write error dialog 
should be displayed to indicate that no 
more remote computers can be 
connected.

Wait for a while and retry 
printing.

Cause Check point Remedy

You are trying to delete all print 
data displayed in the Printer 
window. (Only the system 
administrator is allowed to do this 
task.)

Confirm whether you are trying to 
delete the print data from the 
Printer menu. (In Windows OS: 
Clear Print Jobs menu.)

Select the print data to be 
deleted, and delete from the 
Document menu in the Printer 
window. (Cancel Printing 
menu.)

The print data has a different 
owner.

Confirm if the name displayed as 
the Owner for the selected print 
data and the login name for the 
user to Windows are the same.

Login to Windows using the 
name of the document owner 
and delete the print data.



Troubleshooting

Xerox 4112/4127 Copier/Printer 10-3
System Administration Guide

Configuration on the Computer
• Take maximum care with the IP address settings. IP addresses are managed throughout 

the system as a whole. The configuration should be performed only after consulting with 
your network administrator.

• When performing network settings (IP address, etc.) on a host under the NIS (Network 
Information Service) management, consult with the NIS administrator.

Switching Off the Power

Check the following points when switching off the machine:

• When the SMB (Spool) is set to Memory.

All print data spooled within the machine memory, including the data which is being 
printed is erased. The print data will not be found when the machine is powered on again.

However, if the power was switched off immediately after a computer instructed a print 
job, the job may remain on the computer. In this case, the stored data on the computer will 
be printed out in order before any later instructions when the machine is powered back on.

• When the SMB (Spool) is set to Hard Disk.

All print data spooled in the machine hard disk, including the data which is being printed is 
preserved. In this case, the stored data on the machine hard disk will be printed out in order 
before any later instructions when the machine is powered back on.

• When the SMB (Spool) is set to Off.

All print data spooled in the machine receiving buffer, including the data which is being 
printed is erased. The print data will not be found when the machine is powered on again.

However, if the power was switched off immediately after a computer instructed a print 
job, the job may remain on the computer. In this case, the stored data on the computer will 
be printed out in order before any later instructions when the machine is powered back on.

While Printing
• When the SMB (Spool) is set to either Hard Disk or Memory.

If the transmitted print data size exceeded the available amount of either hard disk or 
memory, the print data will not be received.

Note
When the print data has exceeded the receivable size, some computers may immediately 
re-transmit the print data. When this occurs, the computer appears to be halted. Deal with 
this problem by canceling the print data transmission from the computer.

• When the SMB (Spool) is set to Off.

While the machine is receiving a print request from a computer, the machine cannot accept 
any print requests from other computers.

• When an IP address of a computer or a computer name is changed.

When the IP address of a computer or a computer name is changed, queries and cancel 
processes from the machine will not be performed correctly. Switch the machine off and on 
when there is no print data in the receiving buffer.
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Note
Canceling print jobs or forcing the machine to print the remaining jobs in the receiving 
buffer can be operated from the control panel on the machine. For information, refer to the 
User Guide, Chapter 2, the section entitled “Job Status.”

• When the machine is off-line.

If a computer instructs a print job while the machine is off-line, the machine will not receive 
the data and a write error dialog will be displayed on the computer. However, when using 
SMB the print data can be received from a computer while the machine is off-line.

• Deleting jobs.

For Windows NT 4.0, jobs can be deleted if Service Pack 4 or later is installed. A write error 
will be displayed if the job is deleted while it is being received. In this case, Retry displayed 
on the error dialog is of no use.

NetWare
The possible causes, check points, and remedies for problems when using NetWare are as 
follows:

When you cannot print

Cause Check point Remedy

Network equipment (hubs, for 
example) are not supporting 
automatic frame type detection.

Check the network equipment to 
see if the data link indicator of 
the port where the machine is 
connected is lit. Confirm if the 
frame types used by the file 
servers on the network are 
standardized.

Set the frame type for the 
machine to the same type as 
the connected file server.

A problem occurred on the 
network between the computer 
and the machine.

Use NWADMIN on the computer 
to confirm if the machine object 
can be browsed.*

Replace the faulty network 
cable installed between the 
computer and the machine.

Job sender (user or group name) 
is not specified in the user 
settings for the print queue.

Use NWADMIN from a computer 
to confirm that the print queue 
object User information lists the 
job sender (user or group 
name).*

Re-transmit the print data to the 
print queue whose User 
information includes the job 
sender (user or group name).

Use NWADMIN from a 
computer to register job sender 
(user or group name) to the 
User of the Print Queue 
Information.*
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Job transmission to the print 
queue is prohibited.

Use PCONSOLE to confirm if 
User can register to the queue 
is set to Yes under Current 
Queue Status of the Print 
Queue Information.

Use PCONSOLE to set the item 
to Yes.

Use NWADMIN on the computer 
to confirm if the Identifier of 
the print queue has the operator 
class option checked.*

Use NWADMIN on a computer 
to confirm if the Identifier of 
the print queue has each item 
of the operator class option 
checked.*

Job sender (user or group name) 
is not specified in the user 
setting for the print server.

Use NWADMIN from a computer 
to confirm that the User 
information for the Print Server 
lists the job sender (user or group 
name).*

Re-transmit the print data to the 
print queue whose User of the 
Print Server Information 
includes the job sender (user or 
group name).

Use NWADMIN from a 
computer to register job sender 
(user or group name) to the 
User information of the print 
server.*

The print queue where the user 
has transmitted the print data, is 
not assigned to the machine.

Use NWADMIN from a computer 
to check the print queue 
Assignment to see if the 
machine is in the printer list 
serviced by the print queue.*

Re-transmit the print data to the 
print queue which is assigned to 
the machine.*

Use NWADMIN from a 
computer to add the print 
queue to the machine.*

Print data format and the print 
environment settings on the 
computer do not match.

- If the computer is running 
Windows, ensure that it is set to 
not output Ctrl-”D.”

The number of print queues set 
for the machine exceeds the 
maximum number of supported 
queues on the machine.

Use NWADMIN from a computer 
to check the Assignment print 
queue list on the machine to see 
if the desirable print queue is 
assigned to the machine.*

Re-transmit the print data to the 
print queue which is assigned to 
the machine.*

The slave file server is not 
configured. (Bindery Service 
mode.)

Use PCONSOLE from a computer 
to confirm if the slave file server 
is registered to the Service 
NetWare Server on the print 
server indicated by the Print 
Server Information.*

Use PCONSOLE from a 
computer to register the slave 
file server and propagate the 
configuration parameters.

Printer types do not match. Use PCONSOLE from a computer 
to confirm if the printer type is 
set to parallel, port is set to LPT1, 
and location is set to automatic 
mode (local) under Print Server 
Information/Printer/Printer xxx 
Environment Configuration.*

Use PCONSOLE from a 
computer to set the printer type 
to parallel, port to LPT1, 
location to automatic mode 
(local), and propagate the 
configuration parameters.*

Cause Check point Remedy
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The slave file server 
configuration is mismatched. 
(Bindery Service mode.)

Use PCONSOLE from a computer 
to confirm if the printer type is 
set to Defined Elsewhere under 
Print Server Information/
Printer/Printer xxx 
Environment Configuration.*

If not set to Defined Elsewhere, 
change to Defined Elsewhere 
and propagate the 
configuration parameter.*

The form number on the print 
data and the form number set to 
the printer do not match.

Use NWADMIN on a computer 
to select the machine and 
confirm that the start number of 
the form in the environment 
setting matches the number in 
the print data.*

Use NWADMIN from a 
computer to match the Start 
Form number in the machine’s 
environment setting to the 
number in the print data.*

The level settings for the IPX 
checksum do not match.

Use the “set” command from the 
console screen on the file server 
confirm whether the IPX 
checksum is set to level 2.

Enter following command on 
console screen in file server and 
then set IPX checksum level 0 or 
1:
set Enable IPX Checksum=x (x = 
0 or 1)

The level settings for the NCP 
packet signature do not match.

Use the “set” command from the 
console screen on the file server 
confirm whether the NCP packet 
signature is set to level 3.

Enter the following command 
from the console screen on the 
file server to set the NCP packet 
signature to either level 0, 1, or 
2, and restart the file server: 
set NCP Packet Signature 
Option=x (x = 0, 1, or 2)

The default device name is 
incorrect.

Print out the Printer Settings 
List or Startup Page to confirm 
6 figures (3 bytes) of low ranks 
of an Ether address.

Set the device name using the 
correct Ethernet address.

Set the device name different 
from the default name.

The directory tree name is not 
configured.

Print out the Printer Settings 
List to confirm if the tree name 
is specified.

Set the tree name.

The context is not set. Print out the Printer Settings 
List to confirm if the context is 
specified.

Set the context.

Connected to a different printer 
object.

Use NWADMIN from a computer 
to confirm if the correct object is 
assigned using the current 
information of the print server.*

Use the CentreWare Utilities 
CD-ROM from a computer to 
correctly set the file-server-
name/tree/context/operation-
mode.

Use the CentreWare Internet Services 
from a computer to correctly set 
the file-server-name/tree/context/
operation-mode.

The NetWare port on the 
machine is not set to “Enable.”

Print out the Printer Settings 
List to confirm if the NetWare 
port is enabled.

Enable the NetWare port.

The file server is down. Search for the file server using 
the Network Computer.

Start the file server.

Cause Check point Remedy
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*:Refer to NetWare Online Documentation for configuration and operations.

When “Switch the machine off” is displayed

When the print output is not as you expected

When no notification is received

The possible causes, check points, and remedies when no notification is received on the 
computer which submitted a print job are as follows:

There is another device on the 
network with an identical device 
name.

Switch off the machine and use 
NWADMIN from a computer to 
confirm that the status of the 
printer object is “Standby.”

Use the “CentreWare Utilities” 
CD-ROM from a computer to set 
a different device name.

The NetWare port is not 
functioning.

Print out Printer Settings List to 
confirm if the network number is 
left to “0000000” (NetWare 
server down) if using IPX/SPX. If 
using TCP/IP, confirm if the IP 
address is left to “0.0.0.0” (static 
address unspecified, or the 
DHCP server is down).

For the case of IPX/SPX, start 
the NetWare server. For the case 
of TCP/IP, either set a static IP 
address or start the DHCP 
server.

Cause Check point Remedy

A NetWare problem occurred. Not applicable Restart the machine.
Switch the machine on after the 
display completely disappears.

Cause Check point Remedy

The print language of the print 
data and the print language 
configured on the machine are 
different.

Confirm the print language 
on the machine.

Match the print language of the 
print data and the print language 
configured on the machine.

Cause Check point Remedy
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When the printing problems are not notified

When the completion of the job is not notified

TCP/IP
This section describes the troubleshooting, notes, and restrictions when using TCP/IP.

Troubleshooting
The possible causes, check points, and remedies for problems when using TCP/IP (LPD) are 
as follows:

When using Windows 2000, Windows XP, or Windows Server 2003.
When you cannot print

Cause Check point Remedy

The user is not listed on the 
print server notification 
recipients.

Use PCONSOLE from a computer 
to confirm if the user who 
transmitted the job, or any 
groups which the user is a 
member of is listed under Print 
Server Information > Printer > 
Printer xxx Environment 
Settings > Notification.

Add the user or a group where 
the user is a member of to 
Notification.

Cause Check point Remedy

The Notify option is not 
specified when the computer 
transmitted the print data.

Confirm if the Notify option is 
specified when transmitting the 
print data.

Specify the Notify option when 
transmitting the print data.

Netware command CASTOFF 
has been issued on the 
computer.

Not applicable Issue the NetWare command 
CASTON on the computer.

Cause Check point Remedy

The IP address is incorrect Request your network 
administrator to check the IP 
address on the machine.

Set a correct IP address on the 
machine.

The volume of the print data of 
an instruction from a computer 
exceeded the maximum 
receivable volume when the LPD 
spool is set to memory spool.

Confirm amount of the LPD 
spool memory and then 
compare it with the required 
amount for the data being 
printed.

If the print data is one file and still 
exceeds the memory amount, 
divide the file to make one 
instruction smaller than the 
memory.

If the print data is multiple files 
and exceeds the memory amount, 
decrease the number of files to 
print at once.
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When the print output is not as you expected

Notes and Restrictions

The following are the notes and restrictions for using TCP/IP (LPD).

Configuration on the Machine
• Take maximum care with the IP address settings. IP addresses are managed throughout 

the system as a whole. The configuration should be performed only after consulting with 
your network administrator.

• Subnet Mask and Gateway addresses may be necessary depending on the network 
environment. Confirm with the network administrator and set up the necessary items.

• When the port status is set to Enable, it sometimes automatically switches to Disable if the 
machine has insufficient memory. If this happens, either set an unused port to Disable, or 
adjust the assigned memory size.

• Adjust the receiving buffer lpd (Spool) size according to usage. When the receiving buffer 
lpd (Spool) size is smaller than the transmitted data, the machine may not be able to 
receive the data.

An unrecoverable error occurred 
during the printing process.

Confirm if any error messages 
are displayed on the control 
panel.

Restart the machine.
Switch on the machine after the 
display completely disappears.

The machine is not set to the 
transport protocol which 
matches the protocol on the 
computer.

Confirm the transport protocol 
selected on the machine.

Select the transport protocol which 
matches the transport protocol 
used by the computer.

The data format the machine is 
trying to process does not 
match the data format of the 
print data transmitted from a 
computer.

Not applicable Ctrl-”D” will cancel the output.

Cause Check point Remedy

Selected print language on the 
machine does not match the 
print language of the print data.

Confirm the selected print 
language on the machine and 
the print language of the print 
data.

Select the print language on the 
machine to match the print data.

The computer is not using the 
print driver supplied with the 
machine (using a print driver 
from another company).

Confirm if the print driver on 
the computer is the one 
supplied with the machine.

Select the print driver supplied 
with the machine on the 
computer. If it does not appear 
on the selection list, install the 
print driver supplied with the 
machine and select it. The 
operation is not guaranteed if 
another print driver is used.

Cause Check point Remedy
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Configuration on the Computer
• Take maximum care with the IP address settings. IP addresses are managed throughout 

the system as a whole. The configuration should be performed only after consulting with 
your network administrator.

• When performing network settings (IP address, and so forth) on a host under the NIS 
(Network Information Service) management, consult with the NIS administrator.

Switching Off the Power

Check the following points when switching off the machine:

• When the lpd (Spool) is set to Memory.

All print data spooled within the machine memory, including the data which is being 
printed is erased. The print data will not be found when the machine is powered on again.

However, if the power was switched off immediately after a computer instructed a print 
job, the job may remain on the computer. In this case, the stored data on the computer will 
be printed out in order before any later instructions when the machine is powered back on.

• When the lpd (Spool) is set to Hard Disk.

All print data spooled in the machine hard disk, including the data which is being printed is 
preserved. In this case, the stored data on the machine hard disk will be printed out in order 
before any later instructions when the machine is powered back on.

• When the lpd (Spool) is set to Off.

All print data spooled in the machine receiving buffer, including the data which is being 
printed is erased. The print data will not be found when the machine is powered on again.

However, if the power was switched off immediately after a computer instructed a print 
job, the job may remain on the computer. In this case, the stored data on the computer will 
be printed out in order before any later instructions when the machine is powered back on.

While Printing
• When the lpt (Spool) is set to either Hard Disk or Memory.

If the transmitted print data size exceeded the available amount of either hard disk or 
memory, the print data will not be received.

Note
When the print data has exceeded the receivable size, some computers may immediately 
re-transmit the print data. When this occurs, the computer appears to be halted. Deal with 
this problem by canceling the print data transmission from the computer.

• When the lpd (Spool) is set to Off.

While the machine is receiving a print request from a computer, the machine cannot accept 
any print requests from other computers.

• When the IP address of a computer or a computer name is changed.

When the IP address of a computer or a computer name is changed, queries and chancel 
processes from the machine will not be performed correctly. Switch the machine off and on 
when there is no print data in the receiving buffer.
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Note
Canceling print jobs or forcing the machine to print the remaining jobs in the receiving 
buffer can be operated from the control panel on the machine. For information, refer to the 
User Guide, Chapter 2, the section entitled “Job Status.” 

CentreWare Internet Services

Troubleshooting

This section describes the causes and recommended remedies for errors that may occur while 
using CentreWare Internet Services.

Symptom Remedy

CentreWare Internet
 Connecting with Services is 
impossible.

Is the machine working properly?
Check if the machine is powered on.

Is CentreWare Internet Service activated?
Print out the Printer Settings List to confirm.

Is the Internet address correctly entered?
Confirm the Internet address again. If the problem persists, enter 
an IP address to make a connection.

Is a proxy server being used?
Depending on the proxy server, connections may not be possible. 
Set the browser not to “Use proxy server” or set that particular 
address not to use a proxy server.

The “Please wait” message is 
displayed throughout.

Wait for a while as instructed.
If the status does not change, click the Refresh button.
If this does not have any effect, confirm the machine is working 
properly.

The Refresh button is not 
working.

Are you using a specified browser?
Refer to Network setting items for CentreWare Internet 
Services on page 3-3 to confirm if your browser is supported.

Selecting the menu on the left 
frame does not update the right 
frame contents.

The screen display is distorted. Change the window size for the browser.

The latest information is not 
displayed.

Click the Refresh button.

The Apply New Settings button 
does not reflect the new settings.

Are all entered values correct?
If a value outside of the permitted range is entered, the update will 
automatically be made within the range.

Clicking the Apply New Settings 
button causes the browser to 
display “The server has returned 
an invalid or unrecognizable 
response” or “No data” message.

Has a correct password been supplied?
The entries for Password and Confirm Password do not match. Enter 
the correct password.

Is it during operation or after operation by the control panel on the 
machine? When the automatic reset function is configured, any 
setting by CentreWare Internet Services is not applied until setting 
time passes. Wait for a while.

BBCS characters cannot be 
entered.

The items indicated with “*” cannot accept any BBCS character 
entries.
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Scanner Features

Notes and Restrictions

The following are the notes and restrictions for using the scanner features.

Note
Refer to the Readme contained in the CentreWare Utilities 
CD-ROM for the notes and restrictions on network scan driver and Folder Viewer 2.

When retrieving documents from folder
• When Delete/Save Documents is set to Save, the same document can be accessed by 

multiple clients.

• When Delete/Save Documents is set to Delete, only one client can access any given 
document.The document which is being saved or imported by a client cannot be seen by 
other clients.

In both cases, documents can be added to a folder while it is accessed.

• When documents are retrieved from CentreWare Internet Services, the documents will not 
be deleted regardless of the setting of Delete Documents After Retrieval.

Display

When a multi-colored document is scanned, the image cannot be displayed in the correct colors 
if the display mode is set to fewer colors. Use a display mode which supports more colors than 
the image contains.

Using network scan driver and Folder Viewer 2 simultaneously

You cannot use both the network scan driver and Folder Viewer 2 on a single computer to make 
a connection to the machine.

A maximum of three computers using either the network scan driver or Folder Viewer 2 may 
retrieve documents simultaneously from one machine.

When printing documents saved in the folder

If printing a saved document by selecting Folder from the touch screen on the machine, scan 
documents cannot be printed.

When using TIFF files

The TIFF files created by Folder Viewer 2 are compressed either into the MMR, MH, JBIG, or 
JPEG format. When opening TIFF files, use the appropriate application software which supports 
the format.

Cannot delete jobs. Wait for a while and click the Refresh button.

Symptom Remedy
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Note
Folder Viewer 2 cannot create a TIFF file compressed by JBIG format.

Restriction on scanning capacity

The maximum scanning capacity for one page is 297 x 432 mm. For standard sizes, A3 or 11 x 
17 inches.

Number of sheets for scanning (for Folder)

A maximum of 999 pages can be scanned in at once for folders. The number of pages may 
differ depending on the document size and resolution.

E-Mail Features

Troubleshooting

This section describes causes and recommended remedies for errors that may occur while using 
the mail notice service, mail print and scanner (mail transmission).

Symptom Remedy

Cannot receive e-mail (mail 
print)

Is the e-mail address for the machine configured?

Is the Receive E-Mail set to Enable?

Are IP addresses for the SMTP server and POP3 server (if POP3 is 
selected for the incoming mail protocol) configured correctly?

Are the POP3 user name and password entered correctly?

Is the Domain Filter imposed?
Confirm if your own domain is included in the permitted domain using 
CentreWare Internet Services.

Are the SMTP server and/or POP server operating properly?
Check with your network administrator.

Cannot transmit e-mail (mail 
print and scanner (mail 
transmission))

Is the e-mail address for the machine configured?

Is the Mail Notice Service set to Enable? (In the case of mail notice.)

Is the Send E-Mail set to Enable?

Is the IP address for the SMTP server configured correctly?

Are the notification items for transmission set correctly? (In the case of 
mail notice.)
Confirm the settings on the property screen using CentreWare Internet 
Services.

Is the destination address entered correctly?

Is the SMTP server operating properly?
Check with your network administrator.
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11Options

Enabling Options with Software Keys
Options such as Disk Overwrite, Secure Watermark, Thumbnail Preview, and Job Based 
Accounting require the purchase and subsequent enabling with a supplied 12 character key 
before they will work. 

Software keys are usually included with the kit documentation as a sticker on the manual, or 
they may be already installed on the device as per the purchase agreement. 

Upon receipt of the software key, use the following procedure to enable the associated Option.

1. Press the Log In/Out button on the Control Panel to enter the System Administration 
Mode.

2. On the keypad enter 11111 or the current password. Select Enter when finished.
3. Select the Machine Status button on the Control Panel.
4. Select Tools tab.
5. Select Common Service Settings.
6. Select Maintenance. 

Note
You may have to use the scrolling arrow to see this selection.

7. Select Software Options and enter the key, using the on-screen keyboard, in the box 
provided.

8. Select Save, then select Reboot.
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Xerox Extensible Interface Platform 
(XEIP)

Overview

Xerox Extensible Interface Platform (XEIP) enables independent software vendors and partners 
to develop customized programs to access directly from the Xerox device. Users can enter their 
authentication login at the device and access a set of features and options designed specifically 
for their business needs. For example: 

• A hospital could customize the device to help better manage patient forms. 
• By touching an icon on the display, a health-care worker could access the hospital's 

Web-based document management system and browse a list of patient forms.

Users can quickly scan and capture paper documents, preview thumbnails, and add them to 
frequently used document storage locations. For example:

• A tutor can scan notes directly to a specific course repository for students to access. 
• A student can scan assessment papers to their course folder for their tutor to mark.

Xerox Extensible Interface Platform (XEIP) utilizes web-based Xerox Partner solutions including 
Omtool™, and Equitrac™ to enable users to access document repositories at the device display 
screen. Additional resources may be required on the device depending on the solution. For 
further information, contact your Xerox Sales Representative.

Installation

The XEIP installation is a two-phase process by which Phase 1 is described below, and Phase 2 is 
to be completed via the installation documentation provided by the web-based Xerox Partner 
solutions software vendor.

XEIP Setup
1. At your workstation, open your Web browser.
2. Enter the IP address of the machine in the Address or Location field.
3. Press Enter.

EIP Applications

To enable the machine for EIP applications:

1. Click the Properties tab.
2. Click the Services folder, the Custom Services folder, then the Custom Services link.
3. In the Custom Services area, in the Enabled box, click Enabled.
4. Click Apply.
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Digital Certificate

To enable a digital certificate (if needed):

1. Click the Properties tab.
2. Click the Security folder, then the Machine Digital Certificate Management link.
3. If prompted to login, type or enter your System Administrator user name and password:

• user name (default): 11111
• password (default): x-admin

4. Click the Create New Self Signed Certificate button. The Machine Digital Certificate 
Management page refreshes and displays the Self -Signed Certificate area.

5. In the Self -Signed Certificate area, click Apply.

SSL

To enable SSL:

1. Click the Properties tab.
2. Click the Security folder, then the SSL/TLS Settings link.
3. If prompted, type or enter your System Administrator user name and password.

• user name (default): 11111
• password (default): x-admin

4. In the SSL/TLS Settings area, on the HTTP - SSL/TLS Communication line, click Enabled.
5. Click Apply.

Note
If changes are made to the SSL settings you may need to:

• Reboot the system.
• Close and reopen the client browser.

Ports

To enable the ports:

1. Click the Properties tab.
2. Click the Connectivity folder, then Port Settings.
3. On the SNMP line, click Enabled.
4. On the SMB line, click Enabled.
5. On the FTP Client line, click Enabled.
6. On the SOAP line, click Enabled.
7. Click Apply. 

Note
If changes were made to the SSL settings you may need to reboot the system.
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IPv4 Default Enablement

To ensure that IPv4 is enabled by default:

1. Click the Properties tab.
2. Click the Connectivity folder, then the Protocols folder.
3. In the Protocols folder, click TCP/IP.
4. In the IP Mode area, on the IP Mode line, click or verify IPv4.
5. If you clicked IPv4, click Apply. EIP applications can now register to the device.

Note
You may need to map buttons to Custom Services at the local User Interface in order to see 
the new applications.

The installation of the Xerox Extensible Interface Platform (XEIP) solution now is completed.

KeyPoint
During this time, the desired web-based Xerox Partner solution can be registered. The 
registration process varies from solution to solution. 

KeyPoint
The installation process for the desired solution should be located in that solution's 
documentation. 

Reference the solution partner's documentation for installation completion. 

Upon successful installation of the Solution partner's software, the application will show up in 
the User Interface (UI) screen of the printing device
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MeterAssistant
MeterAssistant allows the System Administrator to set up, view, and access the automatic 
billing meter information by eliminating the manual steps involved in collecting and reporting 
meter reads. 

Once enabled, MeterAssistant provides the device's billing meters to Xerox Billing over the 
Internet with minimal human interaction. 

Note
All communications between your Xerox 4112/4127 machine and Xerox Billing is 
conducted through Secure Socket Layer (SSL) protocols and 128-bit encryption to keep 
information locked from all unauthorized viewers. By enabling the MeterAssistant feature 
on your Xerox 4112/4127 device, you are simply allowing your device to automatically 
submit billing meter information on a periodic basis to Xerox Billing as agreed upon in the 
“Terms and Conditions.” Xerox is NOT accessing your private data, or probing your device. 
Only information pertaining to your system's billing meters is actively transferred; no job 
data or other private information is transmitted.

Qualified users can implement the MeterAssistant feature based on the following criteria:

• If your machine has an Integrated Controller ONLY, then all you need to do is sign up for 
this application.

• If you have a third-party controller such as EFI Fiery or Xerox FreeFlow Print Services, you 
MUST have:

• Two drops/ports for two separate internet connections
• Two IP addresses (one for the machine and one for the controller); MeterAssistant uses 

the machine's IP address to obtain billing meter information

Note
Existing customers of the Xerox 4112/4127 Family can perform the eligibility test as listed 
below to see if their equipment is eligible. Customer who recently purchased the Xerox 
4112/4127 can bypass this process.

Use the Machine Eligibility Test at http://www.xerox.com/account-management/meter-
reading-test/enus.html to determine if you can take advantage of MeterAssistant. 

Note
This feature may currently be available only in the U.S.A. 

Note
Ensure that you have an internet connection to your machine.

Make sure that you have an account on www.xerox.com. Add all devices in inventory that you 
wish to register for Automatic Meter Readings to your account. For more information on setting 
up and activating your equipment for meter reads, go to www.xerox.com/meterreads.

Note
TCP/IP and HTTP protocols must be enabled on the device so that the device web browser 
can be accessed (for Device Direct registration, described in this procedure).

http://www.xerox.com/account-management/meter-reading-test/enus.html
http://www.xerox.com/account-management/meter-reading-test/enus.html
http://www.xerox.com
http://www.xerox.com/meterreads
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Setting up MeterAssistant through CentreWare Internet Services

From your computer, perform the following steps:

1. Open your Web Browser and enter the TCP/IP address of the machine in the Address or 
Location field and press Enter.

2. Click the Properties tab.
3. Click the symbol to the left of the Security folder.

4. From the list, select the link for Machine Digital Certificate Management, and login using 
your username and password (default username is: 11111, and password is: x-admin).

5. Select the option for Create New Self Signed Certificate, and press Apply.
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You will receive a message that states: “Settings Have Been Changed”

6. Scroll down the list and locate the SSL/TLS Settings link, and accept the message to 
proceed.

7. Select the check boxes for the following items:
a. Enable HTTP - SSL/TSL Communications
b. Set the HTTP - SSL/TSL Communications Port Number to 443
c. Enable the Verify Remote Server Certificate and press the Apply button
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The machine will request to reboot.

a. Select YES and wait for machine status: Your request was successfully processed
8. Click the symbol to the left of General Setup.
9. Click the symbol to the left of Smart eSolutions.
10. Click Registration.

11. Under the Setup option, select Step 1 - Enable Proxy Server to begin the registration 
process. 
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Note
If your network does not require a Proxy Server, you can go to Step 17. You will, however, 
need to have DNS settings enabled (see TCP/IP Protocol Configuration in this guide). 

12. Place a check mark in the Use Proxy Server box. 

13. In the Addresses to Bypass Proxy Server box, enter in up to 1024 characters of IP addresses, 
fully qualified host names, or wildcard host names (such as *.eng), separated by semicolons. 
Functioning like the local address exception list in a typical web browser, these addresses 
will be permitted to bypass the Proxy Server. 
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14. For the HTTP or HTTPS Server Names, provide a name of up to 255 characters in length for 
one or both of these Proxy Servers. A fully qualified domain name or IP address can be 
used. Note: Make sure that DNS is enabled as stated in the TCP/IP Protocol Configuration 
topic in the NOS Selection section of this guide.

15. Leave the Port Number set to 8080 (the Internet Assigned Network Authority [IANA] 
recognized proxy port) unless you are using a different port number.

16. Click Apply and supply the administrator User Name and Password, if prompted. The 
default is 11111 and x-admin. You should a message stating: Settings Have Been Changed

17. If necessary to see the list of Registration hot links again, click your browser Back button, or 
click on the Registration link.
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18. Continue the registration process by selecting Step 2 - Register with Xerox Communication 
Server link. Selecting this link will allow you to register this device with the Xerox 
Communication Server (Edge Host), which enables the automatic billing meter reading 
service. After registration, the device will poll the Edge Host routinely, and send meter 
readings only in response to requests from the Edge Host.

19. Place a check mark in the Server Communication box. Also set the Transmission Time to a 
desired time frame.

Note
The Transmission Time programming is set based on a 24 hour schedule. This will allow you 
to schedule Xerox Communication Server transmission (polling time) to a desired setting. 
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20. Click Apply and supply the administrator User Name and Password, if prompted. A 
“Settings have been changed” message will appear.

Note
If applicable, continue with steps 21 - 26 for E-mail Notification.

21. If applicable, use your browser Back button again, then click on Setup E-mail Notification 
to send billing meter (or supplies data) read notifications to the locally designated 
Administrator. 

22. Enter the e-mail address of the designated Administrator in the box(es) supplied. 
23. Place a check mark in the boxes associated with the type of notifications you wish to have 

e-mailed. 
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24. Click Apply and supply the administrator User Name and Password, if prompted. The 
default is 11111 and x-admin. 

25. Click on the MeterAssistant link at any time to see the status of your communications.

Note
The machine status will show a listing of being “Disabled” until the remote device checks 
for MeterAssistant information to be sent to it.

26. This completes the MeterAssistant configuration.
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12Addendum

This addendum is a supplemental addition to Chapter 8. It contains additional detailed 
information of various machine setups.

System Settings Menu List
The following table shows a list of the items that can be set. Note that the items appearing 
depend on the configuration of the machine. Refer to System settings procedure on page 9-1.

System Settings

Common Settings

Machine Clock/Timers Date•Time
NTP Time Synchronization•Connection Interval
Auto Clear•Auto Job Release
Auto Print•Auto Power Saver
Time Zone•Daylight Savings

Audio Tones Control Panel Select Tone•Control Panel Alert Tone
Base Tone•Machine Ready Tone
Copy Job Complete Tone•Non-Copy Job Complete Tone
Fault Tone•Auto Clear Alert Tone
Alert Tone•Out of Paper Warning Tone
Low Toner Alert Tone•Stored Programming Tone

Screen Defaults Custom Buttons 1 to 3•All Services
All Services - Additional Features•Job Type on Job Status screen

Paper Tray Settings Custom Paper Name•Paper Tray Attributes on Setup Menu
Customize Paper Supply Screen•Paper Tray Attributes During
Loading
Paper Tray Priority•Paper Type Priority
Tray 5 (Bypass) -•Auto Tray Switching
Paper Size Defaults

Image Quality Photo & Text Recognition•Image Enhancement

Reports Job History Report•2 Sided Report

Maintenance/Diagnostics Initialize Hard Disk•Delete All Data
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Copy Mode Settings

Watermark Date Format•Text Effect
Text Size•Background Pattern
Printing Density•Text/Background Contrast
Force Watermark -•Force Watermark - Client
Copy Job Print
Force Watermark -
Folder Print

Other Settings Auto Job Promotion•Offset Stacking (Finisher Tray)
Default Print Paper Size•Paper Size Settings
Millimeters/Inches•Keyboard Input Restriction
Operation of Up/Down Buttons•Overwrite Hard Disk (optional)
Data Encryption (optional)•Service Representative
Restricted Operation (not supported)
Software Download•Document Feeder Tray Elevation
Estimated Time for Single or
All Jobs

Preset Buttons Paper Supply - Button 2•Paper Supply - Button 3
Paper Supply - Button 4•Paper Supply - Button 5
Reduce/Enlarge - Button 3•Reduce/Enlarge - Button 4
Reduce/Enlarge - Button 5•Stapling Button 4
Stapling Button 5•Punching Button 4
Punching Button 5•Front Cover Tray-Button 3
Front Cover Tray-Button 4•Back Cover Tray-Button 3
Back Cover Tray-Button 4

Copy Defaults Paper Supply•Reduce/Enlarge
Original Type•Lighten/Darken
Sharpness•Auto Exposure
2 Sided•Mixed Size Originals
Edge Erase - Top Edge•Edge Erase - Bottom Edge
Edge Erase - Left Edge•Edge Erase- Right Edge
Center Erase•Image Shift - Side 1
Image Shift - Side 2•Image Rotation - Rotation Direction
Image Rotation•Original Orientation
Copy Output•Output Orientation
Sample Set•Stamp Position (Side 1)
Stamp Position (Side 2)•Stamp Size
Date Position (Side 1)•Date Position (Side 2)
Date Size•Page Number Style
Page Number Position (Side 1)•Page Number Position (Side 2)
Page Number Size•Tab Margin Shift
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Copy Control Memory Full Procedure•Maximum Stored Pages
2 Sided Original Scan Options•Auto Paper Off
Fine-tune 100•Pseudo-Photo Gradation Mode
Original Type - Lightweight•Output Orientation-Reverse Order
Originals
Output Orientation-Auto•Stamp Density
(Single sheet)
Stamp Position-Top Left•Stamp Position-Top Center
Stamp Position-Top Right•Stamp Position-Left Center
Stamp Position-Center•Stamp Position- Right Center
Stamp Position- Bottom Left•Stamp Position- Bottom Center
Stamp Position- Bottom Right•Date Position-Top Left
Date Position-Top Center•Date Position-Top Right
Date Position- Bottom Left•Date Position-Bottom Center
Date Position-Bottom Right•Page No. Position-Top Left
Page No. Position-Top Center•Page No. Position-Top Right
Page No. Position-Bottom Left•Page No. Position-Bottom Center
Page No. Position-Bottom Right•Quantity Display

Original Size Defaults Not applicable

Reduce/Enlarge Presets Not applicable
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Network Settings

Port Settings LPD•NetWare
SMB•IPP
EtherTalk•Salutation
Port9100•SNMP
FTP client•Receive E-mail
Send E-mail•Mail Notification Service
UPnP Discovery•Internet Service (HTTP)
SOAP

Protocol Settings Ethernet settings•TCP/IP - Get IP Address
TCP/IP - IP Address•TCP/IP - Subnet Mask
TCP/IP - Gateway Address•TCP/IP - IP Filter

Machine E-mail Address/Host 
Name

E-mail Address•Host name
Domain name

POP3 Server Settings POP3 Server - Setup•POP3 Server - IP Address
POP3 Server - Server Name•POP3 Server - Port Number
POP3 Server - Check Interval•POP3 Server - Login Name
POP3 Server - Password•POP Password Encryption

SMTP Server Settings SMTP Server - Setup•SMTP Server - IP Address
SMTP Server - Server Name•SMTP Server - Port Number
E-mail Send Authentication•SMTP AUTH - Login Name
SMTP AUTH - Password

Domain Filter Domain Filtering•to 51. Domains 1 to 50

Remote Authentication Server 
Settings

Authentication System
Remote Authentication Server 1-5
Server - Server Setup
Server - IP Address
Server - Server Name
Server - Port Name
Server - Realm Name

PKI Settings (Public Key 
Infrastructure)

HTTP - SSL/TLS settings

Other Settings E-mail receive protocol
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Print Mode Settings

Scan Mode Settings
Note
The optional color scanner kit will allow scanning in color or black and white. Scans from 
Scan Service cannot be printed unless retrieved at the client and resubmitted as a print job. 

Allocate Memory PostScript Memory•ESC/P Form Memory
HP-GL/2 Auto Layout Memory•Receiving Buffer - LPD Spool
Receiving Buffer - NetWare•Receiving Buffer - SMB Spool
Receiving Buffer - IPP Spool•Receiving Buffer - EtherTalk
Receiving Buffer - Port 9100

Other Settings Print Area•Substitute Tray
Paper Type Mismatch•Unregistered Forms
Print ID•Banner Sheet
Banner Sheet Tray•PostScript Paper Supply
PostScript Font Absence•PostScript Font Substitution

Basic Scanning Tab Feature in 2nd Column•Reduce/Enlarge - Button 2
Reduce/Enlarge - Button 3

Scan Defaults Output Color •Original Type
File Format•Lighten/Darken
Contrast•Sharpness
Auto Exposure•Background Suppression 
Color Space •Original Orientation
Scan Resolution•Mixed Size Originals
Edge Erase•Edge Erase - Top & Bottom Edges
Edge Erase - Left & Right Edges•Center Erase / Binding Erase
Image Compression 

Scan-to-FTP/SMB Defaults Not applicable

Scan Size Defaults Not applicable

Output Size Defaults Not applicable

Reduce/Enlarge Presets Not applicable

Other Settings Scan Service•Memory Full Procedure
Maximum Stored Pages•2 Sided Original Scan Options
Color Saturation •Auto Exposure Level 
Background Suppression Level • Color Space
TIFF Format•Image Transfer Screen
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E-mail Settings

Folder Settings

Stored Document Settings

E-mail Defaults Not applicable

Address Search (Directory 
Service)

Directory Service (LDAP)•Primary Server
Primary Server Port Number•Secondary Server
Secondary Server Port Number•Login Name
Password•Search Root Entry DN
Scope of Search from Root Entry•Object Class of Search Target
Server Application•Attribute Type of Recipient Name
Attribute Type of Last Name•Attribute Type of First Name
Attribute Type of E-mail Address•Attribute Type of Custom Items 1 to 3
Attribute Name of Custom Items•Maximum Search Results
1 to 3
Search Time-Out

Other Settings Maximum E-mail Size•Maximum Address Entries
Incoming E-mail Print Options•Auto Print Error Mail
Response to Read Status (MDN)•Read Status (MDN)
Auto Print Delivery Confirmation•Page size for Split Send
Mail

File Operation Default Screen Not applicable

Documents Retrieved By 
Client

Not applicable

Document Expiry Time Not applicable

Delete Charge Print 
Documents

Not applicable

Delete Secure Print 
Documents

Not applicable

Delete Sample Print 
Documents

Not applicable
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Setup Menu

System Administrator Settings

Login Setup/Auditron Administration

Folder Folder Name•Password
Check Password•Delete Documents After Retrieval
Delete Documents with•Link Job Flow Sheet to Folder
Expiry Date

Job Flow Sheets Name•Description
Send E-mail•Transfer via FTP (1), Transfer via FTP (2)
Transfer via SMB (1), Transfer•Content Check
via SMB (2)

Content Check Not applicable

Address Book Address Type•E-mail Address
Recipient Name•Last Name
First Name•Custom Item 1
Custom Item 2•Custom Item 3
Transfer Protocol•Server Name/IP address
Shared Name (SMB Only)•Save in
Login Name•Password
Port Number

System Administrator 
Login ID

Not applicable

System Administrator 
Password

Not applicable

Maximum Login 
Attempts

Not applicable

Create/Check User 
Accounts

UserID•User Name
Password•E-mail Address
Account Limit•Reset Total Impressions
Reset User Account

Reset User Accounts All User Accounts•All Account Limits
Total Impressions•Print Meters

System Administrator 
Copy Meter

Not applicable

User Details Setup UserID Characters•Hide User ID
Account ID Characters•Hide Account ID (***)
Failed Access Log•Checking Authentication information
Store User Details

Charge Print Settings PJL Receive Command Control•PJL Output Command Control
Receive Control

Password Entry from 
Control Panel

Not applicable
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Entering Text
During operations, a screen sometimes appears for the entry of text. This section describes how 
to enter text using the screen keyboard.

The following characters can be entered: numbers, letters, and symbols.

Paper Size Settings Table

To select the default paper sizes for standard size originals and for automatic paper detection, 
refer to Chapter 9 Paper Size Settings on page 9-80.

Login Setup/Auditron 
Mode

Local Machine Access•Network Access
Auditron Mode
•Remote Access
Guest User
Guest Password
Auditron Mode•Folder Access

Item Description

Entering letters and numerals Select Alphanumeric.
If you select Shift, capital letters appear. To return to 
lowercase, select Shift again.

Entering symbols Select Symbol.

Entering a space Select Space

Deleting characters Select Backspace. This deletes characters one at a time.

Deleting all characters Select Clear All. All characters are deleted.

Entering a single character Select any Single Character (number, letter, or symbol).
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The following are the sizes that can be detected automatically when the document is placed on 
the document glass or in the document feeder.

Paper size group A/B series(8 × 13") A/B series

Size

O
rientation/

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1 and 2

Tray 3 and 4

Tray 5 (Bypass)

O
ptional H

igh capacity
(Trays 6 and 7)

D
ocum

ent glass

D
ocum

ent feeder

Tray 1 and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity

(Trays 6 and 7)

A6 Yes No No No No No Yes No No No No No

A5 Yes Yes No Yes Yes No Yes Yes No Yes Yes No

A5 Yes No No No No No Yes Yes No No No No

A4 Yes Yes No Yes No No Yes Yes No Yes Yes No

A4 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

A3 Yes Yes No Yes Yes No Yes Yes No Yes Yes No

B6 Yes No No No No No Yes No No No No No

B6 No No No No No No Yes No No No No No

B5 No No No Yes Yes No Yes Yes No Yes Yes No

B5 No Yes No Yes Yes Yes Yes Yes No Yes Yes Yes

B4 No Yes No Yes Yes No Yes Yes No Yes Yes No

5.5 × 8.5 No No No No No No No No No No No No

5.5 × 8.5 No Yes No No No No No No No No No No

7.25 × 
10.5

No No No No No No No No No No No No

7.25 × 
10.5

Yes Yes No No No No No No No No No No

8 × 10 No No No No No No No No No No No No

8 × 10 No No No No No No No No No No No No

8.46 × 
12.4

No No No No No No No No No No No No

8.5 × 11 No Yes No Yes No No No Yes No Yes No No

8.5 × 11 Yes Yes No Yes No Yes No Yes No Yes No Yes

8.5 × 13 Yes Yes No Yes Yes No No No No Yes No No

8.5 × 14 No No No Yes Yes No No No No Yes No No

11 × 15 No No No No No No No No No No No No

11 × 17 Yes Yes No Yes No No No Yes No Yes No No

Cover A4 No No No No No No No No No No No No

9 × 11 No No No No No No No No No No No No

12 × 18 No No No No No No No No No No No No
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SRA3 No No No Yes No No No No No Yes No No

12.6 × 
19.2

No No No Yes No No No No No Yes No No

13 × 18 No No No No No No No No No No No No

13 × 19 No No No No No No No No No No No No

16 K No No No No No No No No No No No No

16 K No No No Yes No No No Yes No Yes No No

8 K No No No No No No No Yes No No No No

Postcard No No No No No No No No No No No No

Return 
postcard

No No No No No No No No No No No No

4 × 6 No No No No No No No No No No No No

No.3 
standard 
envelops

No No No No No No No No No No No No

Index 
paper

No No No Yes No No No No No Yes No No

Paper 
size 
group

A/B series(8 K/ 16 K) A/B series(8×13"/8×14") Inch series
Size/O

rientation

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity tray 6 and 7 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 

A6 Yes No No No No No Yes No No No No No No No No No No No

A5 Yes Yes No Yes Yes No Yes Yes No Yes Yes No No No No No No No

A5 Yes Yes No No No No Yes No No No No No No No No No No No

A4 Yes Yes No Yes Yes No Yes Yes No Yes No No No Yes No Yes No No

Paper size group A/B series(8 × 13") A/B series

Size

O
rientation/

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1 and 2

Tray 3 and 4

Tray 5 (Bypass)

O
ptional H

igh capacity
(Trays 6 and 7)

D
ocum

ent glass

D
ocum

ent feeder

Tray 1 and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity

(Trays 6 and 7)
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A4 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes No Yes

A3 Yes Yes No Yes Yes No Yes Yes No Yes Yes No Yes Yes No Yes No No

B6 Yes No No No No No Yes No No No No No No No No No No No

B6 Yes No No No No No Yes No No No No No No No No No No No

B5 Yes Yes No Yes Yes No Yes No No Yes Yes No No No No Yes Yes No

B5 Yes Yes No No Yes Yes Yes Yes No Yes Yes Yes No No No No No No

B4 Yes Yes No Yes Yes No Yes Yes No Yes Yes No No No No Yes No No

5.5 
× 
8.5

No No No No No No No No No No No No Yes No No Yes Yes No

5.5 
× 
8.5

No No No No No No Yes Yes No No No No Yes Yes No No No No

7.25 
× 
10.5

No No No No No No No No No No No No No No No No No No

7.25 
× 
10.5

No No No No No No No Yes No No No No Yes Yes No Yes No Yes

8 × 
10

No No No No No No No No No No No No No No No Yes No No

8 × 
10

No No No No No No No No No No No No No No No No No No

8.46 
× 
12.4

No No No No No No No No No No No No No No No No No No

8.5 
× 11

No Yes No Yes No No Yes Yes No Yes No No Yes Yes No Yes Yes No

8.5 
× 11

Yes Yes No Yes No Yes Yes Yes No Yes No Yes Yes Yes Ye
s

Yes Yes Yes

8.5 
× 13

No No No Yes No No Yes Yes No Yes Yes No No No No Yes No No

8.5 
× 14

No No No Yes No No No No No Yes Yes No Yes Yes No Yes Yes No

Paper 
size 
group

A/B series(8 K/ 16 K) A/B series(8×13"/8×14") Inch series

Size/O
rientation

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity tray 6 and 7 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 
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11 × 
15

No No No No No No No No No No No No No No No No No No

11 × 
17

Yes Yes No Yes No No Yes Yes No Yes No No Yes Yes No Yes Yes No

Cov
er 
A4

No No No No No No No No No No No No No No No No No No

9 × 
11

No No No No No No No No No No No No No No No No No No

12 × 
18

No No No No No No No No No No No No No No No No No No

SRA
3

No No No No No No No No No Yes No No No No No No No No

12.6 
× 
19.2

No No No Yes No No No No No Yes No No No No No No No No

13 × 
18

No No No Yes No No No No No No No No No No No Yes No No

13 × 
19

No No No No No No No No No No No No No No No Yes No No

16 K Yes No No No No No No No No No No No No No No No No No

16 K Yes Yes No Yes No No No No No Yes No No No No No No No No

18 K Yes Yes No Yes No No No No No No No No No No No No No No

Post
card

No No No No No No No No No No No No No No No No No No

Retu
rn 
post
card

No No No No No No No No No No No No No No No No No No

4 × 
6

No No No No No No No No No No No No Yes No No No No No

Paper 
size 
group

A/B series(8 K/ 16 K) A/B series(8×13"/8×14") Inch series

Size/O
rientation

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity tray 6 and 7 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 
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No.
3 
stan
dard 
enve
lops

No No No No No No No No No No No No No No No No No No

Phot
o2L
(5 × 
7)

No No No No No No No No No No No No Yes No No No No No

Inde
x 
pap
er
(A4)

No No No Yes No No No No No Yes No No No No No No No No

inde
x 
pap
er 
(8.5 
× 
11)

No No No No No No No No No No No No No No No Yes No No

Paper 
size 
group

A/B series(8 K/ 16 K) A/B series(8×13"/8×14") Inch series

Size/O
rientation

Loading position

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity tray 6 and 7 

D
ocum

ent glass

D
ocum

ent feeder

Tray 1and 2

Tray 3 and 4

Tray 5 (Bypass)

H
igh capacity (Trays 6 and 7) 
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Index

Numerics
100Base-TX, 2-3
10Base-T, 2-3
2 Side Report (system settings), 9-38
2 Sided Original Scan Options (system 

settings), 9-114

A
Account Limit (system settings), 8-6
Active Mode, 3-7
Additional Port Number, 3-14
Address book, 1-8
Address Book (system settings), 9-168
address book registration (see Address 

Book), 9-168
Address Type (system settings), 9-169
Administration Mode, 3-14
Alert Tone (system settings), 9-15
All Services - Supplementary Features, 9-20
All Services (system settings), 9-19
All Services _ Supplementary Features 

(System Settings), 9-20
Allocate Memory (system settings), 9-132
Audio Tones (system settings), 9-13
Authentication information, 1-8
Auto Clear (system settings), 9-9
Auto Clear Alert Tone (system settings), 9-15
Auto Exposure (system settings), 9-140
Auto Exposure Level (system settings), 9-147
Auto Job Promotion (System Settings), 9-79
Auto Job Release (system settings), 9-10
Auto Paper Off (system settings), 9-114
Auto Power Saver (system settings), 9-12
Auto Print (system settings), 9-11
Auto Print Delivery Confirmation Mail, 3-26
Auto Print Error, 3-26
Auto Tray Switching (system settings), 9-34
Automatic Master Mode, 3-6
Automatic Reply to Send Status Mail, 3-26

B
Background Supression (system settings), 9-

140
Background Supression Level (system 

settings), 9-147

Banner Sheet (system settings), 9-136
Banner Sheet Tray (system settings), 9-136
Base Tone (system settings), 9-15
BOOTP, 1-11, 3-10
Border Erase - Left & Right (system 

settings), 9-141
Border Erase - Top & Bottom Edges (system 

settings), 9-141
Border Erase (system settings), 9-141
Browser, 7-3
Browser Settings, 7-4

C
Confirming the printer status, 1-8
Center Erase (default setting)

Binding Erase (system settings), 9-141
CentreWare Internet Services, 1-5, 1-7, 7-2
CentreWare Scan Service, 5-9
CentreWare Utilities, 1-7
Certificate, 3-21
Charge Print Settings (system settings), 8-33
Check password, 5-3
Color Saturation (system settings), 9-147
Color Space (system settings), 9-140, 9-147
Common Settings (system settings), 9-5
Community Name, 3-13
Configuring the E-mail Environment, 1-8
Configuring the SNMP port, 5-9
Confirming the printer status, 1-8
Connection Interval, 9-8
Connection Interval (system settings), 9-8
Connection Time-Out, 3-11, 3-16
Context Name, 3-8
Control Panel, 1-7
Control Panel Alert Tone (system 

settings), 9-14
Control Panel Select Tone (system 

settings), 9-14
Copy Control (system settings), 9-113
Copy Job Comoplete Tone (system 

settings), 9-15
Copy Mode Settings (system settings), 9-87
Copy Paper Attributes (system settings), 9-28
Create/Check User Accounts (system 

settings), 8-2
Custom Paper Name (system settings), 9-24

D
Data Encryption (system settings), 9-81
Date (system settings), 9-7
Date Format (system settings), 9-72
Daylight Savings (system settings), 9-13
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Default Print Paper Size, 9-80
Delete document after retrieval, 5-3, 5-5, 5-7
Delete Documents After Retrieval (system 

settings), 9-159
Delete documents with expiry date, 5-6, 5-8
Delete Documents with Expiry Date (system 

settings), 9-159
DHCP, 1-11, 3-10
DHCP/Autonet, 1-11, 3-10
Display Paper Screen During Loading (system 

settings), 9-29
DNS, 3-10
Document Expiry Time (system 

settings), 9-155
Document Feeder Tray Elevation (system 

settings), 9-85
Document Retrieved By Client(system 

settings), 9-152, 9-153
Domain name, 4-5
Domain Settings (system settings), 9-121

E
Edge Erase - Bottom (system settings), 9-102
Edge Erase - Left (system settings), 9-102
Edge Erase - Top (system settings), 9-101
Edge Erase- Right (system settings), 9-102
E-mail, 1-6, 3-23, 3-29, 3-34
E-mail Address (system settings), 9-169
E-mail Print, 7-5
Enabling the port, 1-8
Encrypting, 3-20, 3-21
Encryption Password, 3-6
entering text, 9-4, 12-8
Estimated Time for Single or All Jobs (system 

settings), 9-86
Ether Talk, 2-6
Ethernet, 3-4
Ethernet II, 2-3
EtherTalk, 1-4, 2-6, 2-7, 3-5
Exiting the Power Saver Mode, 1-15

F
Fault Tone (system settings), 9-15
File, 9-139
File Format (system settings), 9-139
File format (system settings), 9-139
Fileserver Name, 3-8
First Name (system settings), 9-170
Force Set Numbering - Client Print (system 

settings), 9-73
Force Set Numbering - Copy Job (system 

settings), 9-73

Force Set Numbering - Mailbox Print (system 
settings), 9-74

FTP, 5-10
FTP client port, 5-9, 5-11

G
Gateway Address, 1-11, 3-9
Get IP Address, 3-9

H
Host Name, 3-6, 3-9, 4-5
HP-GL/2 Auto Layout Memory (system 

settings), 9-132
HTTP, 5-9, 5-11, 5-13
HTTP Port, 3-19
HTTPS, 3-21

I
IEEE802.3, 2-3
Image enhancement (system settings), 9-37
, 9-35
Image Rotation (system settings), 9-102
Image Transfer Screen (system 

settings), 9-147
Incoming E-mail Print Options (system 

settings), 9-149
Initialize Hard Disk (system settings), 9-39
Internet printing, 2-5
IP Address, 3-9
IPP, 2-5, 3-14

J
Job completion notice, 4-1
Job flow scan, 5-2
Job Flow Sheets (system settings), 9-161
Job History Report (system settings), 9-37
Job template scan, 5-2, 5-8
Job Type on Job Status screen (system 

settings), 9-21, 9-22

K
Keyboard Input Restrictions (system 

settings), 9-80

L
Last Name (system settings), 9-170
Lighten/Darken (system settings), 9-98, 

9-140
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Link a job flow sheet to a mailbox, 5-4, 5-6, 
5-8

Link Job Flow Sheet to Mailbox (system 
settings), 9-159

Low power mode, 1-12
Low Toner Alert Tone (system settings), 9-15
LPD, 2-1, 3-10
LPD Port, 3-16
LPD port, 2-2, 3-2, 4-4

M
Machine Clock/Timers (system settings), 9-6
Machine E-mail Address/Host Name (system 

settings), 9-120
Machine Ready Tone (system settings), 9-15
Macintosh, 1-4
Mail address, 4-5
Mail exchange restriction, 3-27
Mail notice, 4-1
Mail Notice Service, 3-23
Mail print, 4-1
Mail Scan, 4-1
Mailbox name, 5-3
Maintenance (system settings), 9-38
Maximum Address Entries (system 

settings), 9-148
Maximum E-mail Size (system settings),

9-148
Maximum Session, 3-6
Maximum Session Number, 3-19
Maximum Stored Pages (system settings),

9-113, 9-147
Memory Full Procedure (system settings),

9-113, 9-147
Microsoft Networks, 2-4
Millimetres/Inches (system settings), 9-80
Mixed Size Original (system settings), 9-101, 

9-140

N
Network environment, 1-3
network environment, 1-4
network printer, 1-3
Network Scanner Driver, 7-1
Network Scanner Utility 2, 7-1
Non-Copy Job Complete Tone (system 

settings), 9-15
NTP Time Synchronization (system 

settings), 9-8, 9-9
Number of Searches, 3-8

O
Offset Stacking (Finisher Tray) (system 

settings), 9-79
Operation of Up/Down Buttons (system 

settings), 9-80
Original Orientation (system settings), 9-102, 

9-140
Original Type - Lightweight Originals (system 

settings), 9-115
Original Type (system settings), 9-97, 9-139
Out of Paper Warning Tone (system 

settings), 9-15
Output Orientation-Auto (Single sheet) 

(system settings), 9-115
Output Orientation-Reverse Order (system 

settings), 9-115
Output Size Defaults (system settings), 9-144
Overwrite Hard Disk, 8-37, 9-81, 9-83

P
Page Number Style (system settings), 9-109, 

9-110
Paper Size Settings, 9-80, 12-8
Paper Supply (system settings), 9-95
Paper Tray Attributes (system settings), 9-23, 

9-25
Paper Tray Priority (system settings), 9-30
Paper Type Mismatch (system settings),

9-135
Paper Type Priority (system settings), 9-31
Password (system settings), 9-159, 9-171
Photo & Text Recognition (system 

settings), 9-36
PKI Settings (system settings), 9-126
Poling Interval, 3-8
POP Receiving Authentication, 3-27
POP User Name, 3-27
POP User Password, 3-27
POP3, 4-5
POP3 Port Number, 3-27
POP3 Server Address, 3-27
POP3 Server Check Interval, 3-27
POP3 Server Settings (system settings), 9-121
Port Number, 3-19, 7-4
Port Number (system settings), 9-171
Port Settings (system settings), 9-120
Port9100, 2-1, 2-2, 3-2, 3-15
PostScript Font Absence (system settings),

9-136
PostScript Memory (system settings), 9-132
PostScript Paper Supply (system settings),

9-136
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Power On / Off, 1-8
Power Saver Mode, 1-12
Preset Buttons (system settings), 9-87
Print, 1-3
Print Area (system settings), 9-134
Print ID (system settings), 9-135
Print Mail Headers and Contents, 3-26
Printer Mode Settings (system settings),

9-131
Printer Name, 3-5
Printer Settings List, 2-2
Printing Paper Size Defaults (system 

settings), 9-80
Protocol Settings (system settings), 9-120
Proxy Server, 7-4
Proxy Server and Port Numbers, 7-4
Pseudo-Photo Gradation Mode (System 

Settings), 9-114
Public Key, 3-21

R
RARP, 1-11, 3-10
Read Status (MDN) (system settings), 9-149
Receive Control (system settings), 8-34
Receive Domain restriction, 3-27, 4-7
Receive E-Mail, 3-23
Receive Protcol, 4-5
Receiving Buffer - EtherTalk (system 

settings), 9-133
Receiving Buffer - IPP Spool (system 

settings), 9-133
Receiving Buffer - LPD Spool (system 

settings), 9-133
Receiving Buffer - NetWare (system 

settings), 9-133
Receiving Buffer - Port 9100 (system 

settings), 9-133
Receiving Buffer - SMB Spool (system 

settings), 9-133
Receiving Protocol, 3-26
Reduce/Enlarge (system settings), 9-96, 9-97, 

9-98, 9-99, 9-100
Reduce/EnlargePresets (system settings),

9-145
Registering a Mailbox, 1-8, 5-3
Reports (system settings), 9-37
Reset User Account (system settings), 8-8
Response to Read Status(MDN) (system 

settings), 9-149

S
Sample Set (System Settings), 9-105

Save in (system settings), 9-170
Scan, 1-5
Scan Defaults (system settings), 9-138
Scan Mode Settings (system settings), 9-138
Scan Size Defaults (system settings), 9-143
Scanner (mail transmission), 5-1, 5-2
Scanner (save to a computer), 5-2
Scanner (save to a mailbox), 5-1
Scan-to-FTP/SMB Defaults (system 

settings), 9-142
Server Name/IP address (system settings),

9-170
Services and features, 1-3
Set Numbering (system settings), 9-72, 9-74
Setting an IP address, 1-8
Setting personal authentication 

information, 1-8
Setup Menu (system settings), 9-157
Shared Name (SMB Only) (system 

settings), 9-170
Sharpness (system settings), 9-99, 9-140
Sleep mode, 1-12
SLP - Active Discovery, 3-8
SMB, 2-4, 3-6, 5-10
SMB port, 2-4, 2-6, 2-7, 5-9, 5-11, 5-12
SMTP, 4-5
SMTP Authentication Password, 3-28
SMTP authentication user, 3-28
SMTP Server Address, 3-28
SMTP Server Settings (system settings),

9-121
SNMP, 3-11
SNMP port, 5-13
Software Download (system settings), 9-85
Stamp Position (Side 1) (system settings),

9-108
Starting CentreWare Internet Services, 7-5
Stored Document Settings (System 

Settings), 9-154
Stored Programming Tone (system 

settings), 9-16
Subnet Mask, 1-11, 3-9
Substitute Tray (system settings), 9-135
Supported frame types, 2-3
Supported interfaces, 2-3
System Administrator Copy Meter (system 

settings), 8-12
System Administrator Password (system 

settings), 8-22
System Administrator Settings (system 

settings), 8-21, 8-23
System Manager Name, 3-13
system settings menu list, 9-4, 12-1
System settings procedure, 9-1
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T
Tab Copying - Shift Value (system 

settings), 9-112
TBCP Filter, 3-6, 3-11, 3-14, 3-15
TCP/IP, 2-1, 3-9
Text Effect (Background Pattern for Set 

Numbering), 9-73
Text Effect (system settings), 9-73
TIFF Format (system settings), 9-147
Time (system settings), 9-7
Time Zone (system settings), 9-12
Time-Out, 3-14, 3-19
Transfer Protocol (system settings), 9-170
Transport Protocol - Frame Type, 3-8
Tray 5 (Bypass) Paper Size Defaults (system 

settings), 9-32
Tree Name, 3-8

U
Unicode Support, 3-6
UNIX, 1-4
Unregistered Forms (system settings), 9-135
Use DNS, 3-14
User Details Setup (system settings), 8-30
Using the Ethernet Interface, 1-15

W
Web browser, 3-1
Windows 2000, 1-4
Windows Server 2003, 1-4
Windows XP, 1-4
Workgroup Name, 3-6

Z
Zone Name, 3-5
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